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1 INTRODUCTION

1.1 About RAYGUIDE
RAYGUIDE is a software package for laser material processing. The powerful and flexible user
interface makes designing and importing text, barcode and graphic elements simple,
enabling the execution of sophisticated and extensive laser processing projects.

RAYGUIDE features two user interfaces:

■ The graphical user interface (GUI). It makes it possible for users to manage complex laser
processing jobs directly and without programming knowledge.

■ The RAYGUIDE software development kit (SDK), a programmable interface based on the
Microsoft .NET environment. This makes it possible to integrate the entire functionality of
RAYGUIDE into a customized system application completely in line with customer needs.

1.2 Compatibility
The RAYGUIDE software application is compatible with the RAYLASE SP-ICE-3 scan controller.

Please note that the software can even operate without the scan controller connected. The
integrated emulation of the controller makes it possible to work "offline", set up parameters
and edit designs to define laser processing tasks.
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1.3 Features
■ Full-scale integration of the SP-ICE-3 control card. An emulated control card is also

available.

■ Support of multiple SP-ICE-3 control cards.

■ Support of many laser types, using precise parameter sets.

■ Support of lasers with Brightline technology.

■ Support of deflection units with up to 5 axes.

■ Plug-and-play configuration of digital deflection units.

■ Support of different user roles with specific permissions.

■ User interface (GUI) with maximum flexibility that permits, for example, a customized
layout of the panels.

■ Choice of 7 different languages for the software interface

■ Import of a variety of graphic formats: DXF, PLT, SVG, DWG, GBR, CGM, JPG, BMP, GIF.

■ Import and layer-by-layer processing of solids for deep engraving.

■ Efficient layout editing tools for vector graphics, including unlimited undo / redo.

■ Large barcode and text-style libraries, with serialization of barcodes and text.

■ Sophisticated pen concept for maximum flexibility and assignment of process parameters.

■ Parameter finders for quick determination of optimum application parameters.

■ Definition of multi-slope power ramps plus ramp visualization.

■ Support of MOTF processes, including various trigger and automated path sorting options.

■ Support of combined workspaces when working with multiple control cards.

■ Predefinition of laser processing jobs for control cards stand-alone mode.

■ Special plug-ins for solar wafers or electrode geometry of battery foils.

■ Remote interface for remote control of the RAYGUIDE GUI via PLC.

■ Support of customer-specific plug-ins.
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1.4 Scope of delivery
The following components are included in the scope of delivery:

■ RAYGUIDE software installation file. Required to install all program and library files
needed for the RAYGUIDE API and / or GUI.

■ RAYGUIDE manual as PDF file

■ License agreement as PDF file

■ Example codes for the programmable interface

■ RAYGUIDE SDK, manual for the programmable interface

■ Sample correction files for getting familiar with the RAYGUIDE device configuration

■ Optional: Hardware dongle as license carrier

1.5 Laser Safety
The user is responsible for safe operation and for protecting the area around the device from
hazards caused by laser radiation. OEM customers must ensure compliance with all local and
national regulations.

WARNING
Avoid unsafe laser operation

Always switch on the PC before switching on the laser system. This prevents the laser from
behaving in an uncontrolled and unforeseen manner when the PC is switched on. Check
your application carefully before using the laser system. Damaged software can block the
entire system and lead to uncontrolled operation of the laser or deflection unit.

Safety instructions for these components can be found in the manuals for the laser system
and deflection unit.
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1.6 About this Manual
This manual describes the entire functionality and performance features of the RAYGUIDE
software when used with the graphical user interface (GUI).

There is a separate manual for the RAYGUIDE software development kit (SDK).

Conventions
■ Emphasized phrases are printed in bold.

■ Important notes and remarks are introduced with NOTE:, RULE:, etc.

■ Folder and file names are printed in italics.

■ The names of windows, dialogs and tabs are given as normal text: On the Settings tab.

■ Menu options are shown in bold and italics: Select File > Save as….
■ The names of dialog options (function buttons, checkboxes) are specified in italics: Select

Fixed, if you ...

■ Buttons are bold and in italics and shown in brackets: Click on [Apply].

■ Buttons labeled with graphic icons are described by words.

Example:  is a [Zoom] button.

■ References to other pages in the manual are indicated by italics: See page 22, Setup.

■ Links to web addresses are underlined: Visit RAYLASE.
■ Important technical terms are explained in the glossary, see page 402, Glossary.

1.6.1 Version reference
The following table references the manual version of the corresponding software product
version.

Manual version RAYGUIDE version

V2.11 v.2.21

https://www.raylase.de/de
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1.7 Legal Information

Copyright

RAYLASE reserves the right to make changes to the product described in this manual and to
the contents of this manual at any time without notice.

All rights reserved.

Duplication of this manual or extracts from it – in particular by photocopying, scanning or
photographing – and any other form of reproduction is only permitted with the prior written
consent of RAYLASE.

License agreement

The text of the license agreement is delivered as a PDF file together with the software.

Warranty

The rights of the customer in case of material or legal defects of the product are listed in the
General Terms and Conditions of RAYLASE. These can be viewed at: https://www.raylase.de/
en/terms-and-conditions.html.

No implied warranty or guarantee is given as to fitness for a particular purpose. RAYLASE is
not responsible for any damage caused by using the application. Custom assemblies or other
assemblies manufactured by RAYLASE may be subject to different warranty terms. Further
information can be found in the respective manuals.

https://www.raylase.de/en/terms-and-conditions.html
https://www.raylase.de/en/terms-and-conditions.html
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1.8 Addresses

Manufacturer

RAYLASE GmbH

Argelsrieder Feld 2+4

D-82234 Wessling

www.raylase.de

Phone: +49 8153 9999 699

Fax: +49 8153 9999 296

E-mail: info@raylase.de

Customer Service

RAYLASE customer service will be happy to help you at any time if you have any problems
with the software or this manual.

Availability: Monday to Friday, 9:00 a.m. to 5:00 p.m.

UTC+1 (April to October: UTC+2)

Phone: +49 8153 9999 297

E-mail: support@raylase.de
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2 INSTALLATION AND STARTUP
Requirements

To be able to successfully install the RAYGUIDE software on a computer, the following
requirements must be met:

■ Supported operating systems (32 or 64 bit in each case):

– Microsoft Windows 10 (also Windows 10 Enterprise LTSC)

– Microsoft Windows 11.

NOTE: Linux operating systems are not supported

■ Minimum hardware requirements:

– Microsoft .NET Framework Version 4.8 or higher

– 8 GB RAM

– 300 MB of free disk space

Control card

A control card is required for operation of a complete laser system.

NOTES:
■ Installation and setup of the control card are described in a separate user manual.

■ To install, execute and configure the RAYGUIDE software, it is not mandatory to have a
control card installed.

Installation process

For the installation of all RAYLASE software products (therefore also the RAYGUIDE
application), RAYLASE provides the so-called RAYBOARD PRODUCT INSTALLER (RBPI) free of
charge as a central tool on its website.

Using the “Select the targeted software configuration” menu item, select the latest version of
RAYGUIDE.

Fig. 2.1: S-AAA
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You can use the direct link to the change log to get an overview of the latest changes to the
previous version. The RBPI then downloads the RAYGUIDE installation file and displays the
installation options.

The following installation options are available for RAYGUIDE:

Fig. 2.2: RG-AES

1. Select whether you would like to install the GUI and / or the SDK components of
RAYGUIDE.

2. Select the RAYLASE plug-ins (see page 364, RAYLASE plug-ins) that you want to have
installed.

After selecting the installation options, you need to consent to the license agreement; then
the RAYGUIDE application will be installed.

Fig. 2.3: S-AAB

The installation process creates the following folders by default:

■ For the program:

C:\Program Files\RAYLASE\RAYGUIDE\

■ To store configuration files, log files, and other resources:

C:\ ProgramData\RAYLASE\RAYGUIDE\

■ User-specific data is stored in this folder:

C:\users\Benutzername\AppData\Local\RAYLASE\RAYGUIDE\

■ The software environment for license management is also installed.
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The installation process places an icon on the computer desktop for directly launching the
RAYGUIDE application:

Fig. 2.4: S-AAC

Starting software

For example, use the RAYGUIDE desktop icon to start the software.

Fig. 2.5: S-AAC

NOTE: When RAYGUIDE is started for the first time, the main GUI is displayed but no
devices are configured and are therefore not available for use. For details on device
configuration, see page 45, Device Configuration and Calibration.

When the RAYGUIDE application software is started, the first license check also takes place. If
no valid license is found, RAYGUIDE starts in demo mode.
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3 LICENSES AND UPDATES
Licenses

There are licenses available for two product variants:

■ The RAYGUIDE SDK license allows the full use of API functions to develop customized laser
processing applications, which are typically integrated into a laser processing machine
HMI. It comprises only a basic version of the software's Graphical User Interface (GUI), the
so-called "demo" version. It can be used to configure and calibrate the system, but cannot
run or save actual jobs.

■ The RAYGUIDE license allows full use of the GUI and its functions. It includes the use of the
RAYGUIDE SDK. This license is also required if you want to embed all or parts of the
RAYGUIDE GUI in your HMI.

The license is distributed in two ways:

■ A hardware dongle (hardware license key), to be inserted into a USB port of the computer
running the software. This variant allows you to install the software on more than one
computer and use the same dongle on each of them in turn. When the software is
installed or started with the dongle attached, the license is found and activated
automatically.

■ A software key (activation license key), which is valid only for a specific computer. To use a
software key, a "fingerprint" of the designated computer has to be generated. In the
menu, select RAYGUIDE Help > License > Generate license request…, and send the
generated file to RAYLASE (license@raylase.de). RAYLASE will return an activation file
which can be imported by selecting Help > License > Activate license.

To view the license and version information for the installed software, in the RAYGUIDE
menu, select the Help > About option.
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Example:

Fig. 3.1: RG-AAH

Feature updates

Each license or each license product comes with a predefined runtime for feature updates at
the time of purchase. As a rule, this is 2 years. After expiration of the runtime, it is possible
that new features will not automatically be usable by installing updates. Then it is up to you
to purchase a runtime extension.

The update of the feature update runtime is done via license file import.

RAYLASE reserves the right to decide which features are only usable with current feature
update runtime.

The import of new releases / updates by means of the RAYBOARD PRODUCT INSTALLER is
possible independently of this at any time.



3 LICENSES AND UPDATES

© 2025 RAYLASE GmbH 19MN_RAYGUIDE [V2.11]

Expansion with additional license products

If you want to add additional license products to your existing license, please get in touch
with your sales contact. We only need the serial number of your license. You can then import
the license extension file (*.WibuCmRaU) via Help > License > Activate license.

Troubleshooting

The import of new software versions for the purpose of troubleshooting is possible at any
time and does not require a license update. Also use the RAYBOARD PRODUCT INSTALLER for
this purpose to update your RAYGUIDE version and get associated bug fixes.

Credits

Link to an overview table with all foreign libraries used in RAYGUIDE and their licensing.
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4 INTRODUCTION TO THE USER
INTERFACE

4.1 Overview

4.1.1 User interface
When the software is started, the RAYGUIDE user interface (GUI) is displayed in the standard
panel layout:

1
2

3

4

Fig. 4.1: RG-AAI

Menu

1  The main menu provides access to all important functions. For details, see page 23,
Menu.

Toolbar

2  The buttons in the toolbar offer shortcuts to program functions. For details, see page 24,
Toolbar.
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Viewport

3  The viewport is the area where the geometric layout of the graphic objects is displayed,
created, and modified. For details, see page 32, Viewport.

Status bar

4  The status bar displays the current user role (left) and status information (right).

Panels

Program functions are available on a variety of panels. They can be presented and moved to
various places of the GUI. For details, see page 38, Panels.

Dialogs

Most configuration, layout and processing parameters are entered in pop-up dialogs.

Online help

All dialogs and panels have a “?” in the headline. Click on the "?" to open the online help on
the desired section in your default browser.

Related presets

Main toolbar and status bar visibility can be turned on/off. Select System > Preferences
from the menu to open the Settings dialog. Go to the System (all users) tab and to the
Visibility sub-tab, Bars section.

Setting Explanation

Toolbar Turns the main toolbar on / off.

Status bar Turns the status bar on / off.

Table. 4.1: RG-001

The size of toolbar buttons can be specified.

Select System > Preferences from the menu to open the Settings dialog. Go to the System
(all users) tab and to the user interface sub-tab.

Setting Explanation

Toolbar icon size [pixel] Size of object toolbar icons in pixels

Table. 4.2: RG-002

4.1.2 Simplified user interface
Users who find the standard user interface too complex can change the overall view and the
pen dialog to a simplified view.
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Fig. 4.2: RG-AFL

For the procedure, see page 29, View Options.
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4.2 Menu
The main menu at the top of the GUI offers some essential functions.

Fig. 4.3: RG-AAJ

Some standard functions of the software require no further explanation.

■ The File menu refers to common job file tasks. RAYGUIDE job files will be saved with the
file extension *.rg. The menu also offers the option of importing layout objects and
exporting jobs to other file formats such as DXF.

NOTE: Bitmap elements are not included in the export, while text elements are exported
as vector graphics.

■ The [Edit] menu contains common operations that can be applied to the selected objects.
This menu also contains the "Click to modify" object transformations. For details, see page
24, Toolbar.

■ The View menu is described in page 29, View Options.

■ The Job menu refers to working with jobs.

■ The Objects menu can be used to insert objects into the job, just like the Object panel (see
page 130, Graphic job design). In addition, available templates are listed for each object
type (see page 261, Templates).

■ The Tools menu provides access to the “Distance measurement”, “Split object” and
“Parameter finder” tools (see page 286, Pen parameter finder and page 325, MOTF
parameter finder).

■ The System menu provides access to the Devices and their configuration dialogs, as well
as the Laser diagnostic and RAYGUIDE Settings dialogs to define the available settings.
With the export or import option available here, you can save or read in all important
configurations (both the RAYGUIDE application and the device configuration, see page
113, Saving / Restoring system settings).

■ It also gives you access to the library pen set and its pen configurations. The stand-alone
control card mode dialog is also started from this menu item.

■ The Help menu displays brief information about the software (for instance software
version with link to the change history) and provides access to license management. You
can also launch an email with all relevant information automatically attached and send it
to your support contact. For more information, see page 396, Error messages.

Applicable keyboard shortcuts are shown behind most menu options.
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4.3 Toolbar
The toolbar (below the main menu) offers the following functions:

Tool Explanation

Jobs

Adds a blank job document.

Opens / Saves a job document.

[Cut], Copy, [Paste]

Cuts, copies and pastes selected items.

Undo, Redo

As long as the job document has not been closed, every step of your work can
be undone. To do so, repeatedly click the undo button (arrow to left). To restore
a step that was undone, click on the redo button (arrow to right).

For complex operations (e.g. when objects with a large number of vector objects
are deleted or modified), a larger amount of memory is required to undo the
operation. That is why the software may prompt you with the following query.

This gives you the choice of whether or not you want the operation to be
reversible. By setting the checkbox on the lower edge of the dialog, your
selection will be saved for future events.

The saved selection can be found again via Preferences > User (current user)
> UI (seepage 110, UI).

Lock / Unlock workspace.

This option locks all (current and new) layout objects in the viewport against
mouse operation. Applies to all open jobs.
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Tool Explanation

Extras

Tool to measure distances.

Click once on the start point of the distance to be measured, and then pull the
mouse to the second point of distance or right click once for the start point and
a second time for the end point of the distance.

Keep [Shift] pressed to measure horizontal / vertical only.

Keep [Ctrl] pressed to stay in measurement mode, e. g. for subsequent
measures. The cursor icon indicates the measurement mode by switching from
“arrow” to “crosshairs”.

After each measurement, the distance is:

■ Temporarily shown in the status bar

■ Noted in the notifications panel:

To measure an exact distance from one thumb to another thumb, please refer to
the context menu of the thumb. For details, see page 236, More Object-related
Operations in the Context Menu.

Splits the selected objects.

Any selected object can be split into two parts.

First, select the object for which the tool should be available. Click in the
viewport to define the first point of the split-line that is visible now. Click again
to define the second point of the split-line. (Press [Shift] to get a horizontal /
vertical line.) The object will be split now.

NOTE: All objects that are content based (e.g. text, codes) produce vector-based
parts after splitting.

NOTE: Fillings of split objects lose their fill attribute, and are created as part of
the object geometry in a new layer of their own.

NOTE: Containers as a whole cannot be split with this tool. However, multiple
objects can be selected.
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Tool Explanation

Pen parameter finder, see page 286, Pen parameter finder.

MOTF parameter finder, see page 325, MOTF parameter finder.

Zoom

The zoom functions apply to the viewport.

Zooms out and in. Alternatively, you can use the scroll wheel of the mouse.

Fits the entire workspace into the viewport.

Fits the area defined by the cursor into the viewport.

Fits the selected graphic object or the selected sub-object (layer, path) into the
viewport.

Zooms to fit all graphic objects into the viewport. If there is no graphic object,
the workspace is fitted into the viewport.

You can also use the scroll wheel of the mouse to zoom in / out. If you keep the mouse wheel pressed, you
can move the view area in the viewport with mouse movement.

Display options

Toggle buttons to enable / disable the use of the main display options. For details, see page 29, View
Options.

Display grid

Display guidelines

Display jumps

Display vector tips

Display sharp corners
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Tool Explanation

Stroke width

 
Globally increases or decreases the line width of all graphics in the viewport. The
value corresponds to the number of pixels (relative to the screen resolution).
Note that this is just display-related. It does not affect the spot size of the laser
beam on the material and therefore has no impact on the process result.

Use the slider or enter a value in the input field.

Use the [Reset] button to reset to default.

Slice navigator 1

Use the navigator to select the index of the slice from the solid that can be seen
in the viewport.

NOTE: When using a solid file with a negative form, the slice may be empty as
soon as you navigate under the negative form.

Example:

Opacity

The sliders can be used to adjust the opacity of the background images.

1 This toolbar is hidden by default. It can be activated via View >  Toolbar.
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Tool Explanation

Click-to-fit 1

NOTE: With all three variants, after the Click-to-fit action the resulting transformation is displayed in the
Notifications panel.

Shifting and rotating (transformation 1)

Adapts the position of the selected objects by manually picking two source
points and then picking two target points.

The object selection is not scaled.

Shift, rotate and scale with the same factor for X/Y (transformation 2)

Adapts the position and size of the selected objects by manually picking
two source points and then picking two target points.

The scale factors are the same for both dimensions (X/Y).

Shift, rotate and scale with different factors for X/Y (transformation 3)

Adapts the position and size of the selected objects by manually picking
three source points and then picking three target points.

The scale factors are independent of each other for both dimensions (X/Y).

Table. 4.3: RG-003

The tool bar is subdivided into groups that can be shown and hidden independently. See
page 29, View Options.

Tooltips (quick info)

In many cases, a short explanatory text appears when you move the cursor over a GUI
element, such as a button or a field:

Fig. 4.4: RG-AAK
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4.4 View Options
Select View from the menu to activate supporting information to be displayed in the
viewport. Viewing jumps, vector directions and identifying certain vector angles will help you
to investigate the process order of layout elements or their current shortcomings.

NOTE: The display options are only visible when not in edit mode.

Setting Explanation

Grid Switches the display of viewport grid lines on or off. The grid spacing
automatically adjusts to the zoom level.

Guidelines Select this menu item to show / hide the guidelines.

Jump vectors Switches the display of the jump vectors on or off. The display shows all jumps
within and between all current layout objects.

A limit for the display can be defined in System > Preferences > System (all
users) > UI.

Vector tips Switches the display of vector sequences / directions of all current layout objects
on or off. A circle also marks the starting point of the object.

A limit for the display can be defined in System > Preferences > System (all
users) > UI.

Sharp corners Switches the highlighting of specific vector transitions in all layout objects on
and off.

Useful, for example, when the skywriting feature is active to see which vector
transitions are effected, depending on its “change of heading angle”.
Unintentional u-turns of consecutive vectors can also be highlighted.

The angle limit to define a “sharp corner” must be set in System > Preferences
> System (all users) > UI.

GUI Appearance Select here whether the entire GUI (panels, object bar, toolbar) should appear in
the standard view or in a predefined, simplified view.

NOTES:
■ The software has to be restarted one time to change the type of view.

■ If you want to display other GUI elements in addition to the simplified view
and save this status as your customized mode and reuse it, see page 113,
Saving / Restoring system settings.
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Setting Explanation

Panels Switches the display of the various panels on or off.

All panels that belong to plug-ins or have been implemented by users are
summarized under the Plugins category.

Panel layout Offers a sub-menu to store / load panel arrangements per user.

You also find options to [Reset] panel layouts to the default arrangement.

Toolbar Switches the display of various groups in the toolbar on and off.

Objects Switches the display of the icons for automation objects, containers and
marking objects in the Objects panel on or off.

Zoom Provides a sub-menu for using the various zoom functions.

Table. 4.4: RG-004



4 INTRODUCTION TO THE USER INTERFACE

© 2025 RAYLASE GmbH 31MN_RAYGUIDE [V2.11]

Related presets

Select System > Preferences to adapt some preset variables related to view options.

Setting Explanation

System (all users) > UI

Sharp corner limit [°] If sharp corners in the layout are a critical issue, you may set a minimum change
of heading angle (in degrees) here. Corners where the vector changes direction
with at least this angle will be highlighted in the layout if the corresponding
view option is set.

Path start / sharp corner
radius [pixels]

Radius (in pixel) of the circle that highlights path starts and sharp corners

User (current user) > UI

Jump vectors in pen color Displays the jumps in the color of the pen that also defines the jump parameters
– if the display option “show jumps” is activated.

Table. 4.5: RG-005
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4.5 Viewport
The viewport is the central area of the RAYGUIDE user interface where the job layout is
defined and edited.

Fig. 4.5: RG-AAL

As an example you see two overlapping scan fields.

■ The crosshairs mark the origin of the so-called “workspace” to which all vector coordinates
and the offset of the object transformation refer.

■ The maximum workspace is framed by rulers.

■ To view the area of a defined workspace, activate the display of grid lines. The grid lines
show up only in the workspace.

■ When multiple scan fields are used, they are displayed by dashed frames.

■ The current cursor position in the corresponding coordinate plane is displayed at the
bottom left.

■ At the bottom right, the view of the coordinate plane (XY or XZ or YZ or 3D) can be
selected, provided that a correction file with a 3D volume is being used.



4 INTRODUCTION TO THE USER INTERFACE

© 2025 RAYLASE GmbH 33MN_RAYGUIDE [V2.11]

Example: XZ view of a 3D model for deep engraving with cross-section display

Fig. 4.6: RG-AEM
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Example: 3D vector graphic in all of the four possible view options

XY view (default)

Fig. 4.7: RG-AGP

XZ view

Fig. 4.8: RG-AGQ
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YZ view

Fig. 4.9: RG-AGR

3D view

Fig. 4.10: RG-AGS

Note on 3D view:

■ Frame (cuboid): Working volume (provided by the 3D correction file).
■ Grid: The zero layer.
■ Gray shading: Solid (STL file; represents the 3D surface).
■ Black: Original 2D contour of the vector graphic.
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The display can be rotated freely in space using the mouse cursor. You can zoom in and out
using the mouse wheel.

The [Cube] button opens a submenu where you can directly select the room view:

■ Top: View from above ■ Front: View from the front
■ Left: View from the left ■ Right: View from the right
■ Back: View from the rear ■ Bottom: View from below
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4.5.1 Guidelines
The guidelines are aids to align the arrangement of layout objects using horizontal and / or
vertical lines.

To add a guideline to the viewport, drag it from the ruler area into the viewport while
holding down the left mouse button. Then release the mouse button to place the line at the
desired position.

The guidelines act like magnets and can be used to attach either the thumbs of graphic
objects or the corner points of the object frame.

Fig. 4.11: RG-ADH

■ Use the right-click context menu for the Modify or [Delete] options.

■ Use the Modify option to enter a specific axis position for the guideline.

NOTE: The guidelines belong to a single job and are not saved.

NOTE: To temporarily disable the “magnetic behavior” of guidelines, press the [Alt Gr] key.
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4.6 Panels
Program functions are available on a variety of panels.

In the standard panel layout, some panels are stacked. That means the screenshot below does
not show all panels.

Use the tabs at the bottom of the panels to toggle between alternative panel contents.

Available panels

1

2

3

4

56

Fig. 4.12: RG-AAM

Panel contents are explained in detail in the respective chapters of this manual. Follow the
links.

1  Jobs: Overview of the job main settings and the job tree (see page 130, Graphic job
design)

or Vector list: List of graphic commands (see page 130, Graphic job design)

2  Objects (see page 130, Graphic job design)

3  Execution (see page 336, Running a Job)

4  Transformation (see page 201, Object Transformation) or Process adjustment (see
page 359, Process adjustment)

5  Process monitor (see page 345, Process Monitor)

6  Pens (see page 263, Process Parameters (Pens)) or Templates (see page 261, Templates)

7  Notifications: Table which traces the latest RAYGUIDE status information.
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In addition, a custom user-defined panel can be activated. This panel hosts controls which
could be added by customer-specific plug-ins (see page 394, Customer plug-ins).

Rearranging panels

The panel layout can be rearranged according to your current work objectives and personal
settings.

■ Select View > Panels in the main menu to show or hide the visibility of certain panels.

■ Now drag the panel towards a new position with the mouse:

Point to the title bar of a panel, press the left mouse button and keep it pressed. 
Now drag the panel towards a new position. A positioning tool appears on the screen.

Fig. 4.13: RG-AAN
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■ To dock the panel beside another panel, drag the mouse point to one of the arrows and
release it there.

The circle in the center of the positioning tool makes the panel (overlaid) dock on another
panel.

If two panels are on top of each other, grab the panel by its tab to detach it from the
other panel.

■ Use the button with the pin icon on the panel title bar to minimize the panel to a sidebar
(pin bar). Click the tabs of the pin bar to maximize a panel at the previous position.

■ Use the [x] button on the panel title bar to close the panel.

■ Select View > Panel layout > Reset to return to the standard panel layout.

Saving panel layout
■ Navigate to View > Panel layout: You can save the actual panel layout or open already

saved panel layouts per user. That means one user can be allowed to define multiple panel
layouts per task, for example, one panel layout for job design tasks and another for job
execution tasks.

Fig. 4.14: RG-AAO
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4.7 Buttons, Icons, Shortcuts

Text Buttons

Throughout the GUI and its dialogs, text buttons are used for common functions:

Button Meaning

Activates the setting changes and closes the dialog.

Activates the setting changes without closing the dialog.

Discards the setting changes and closes the dialog.

Other buttons are labeled appropriately.

Table. 4.6: 006

Icon/symbol Buttons

Throughout the GUI and its dialogs, icon buttons are used to access functions. Frequently
used icons are:

Button / buttons Referenced as Function

 
[Add] Adds a new item, e.g. a job, a pen set, depending on

context.

  
[Delete] Deletes or closes the active / selected element(s).

 [Edit] Edits selected items.

[Save] Saves to templates.

[Reset] Sets the settings / parameters back to the default
values.

[Refresh] Refreshes the displayed information.

[Import] Imports a file.

[Export] Exports data into a file.

[Clear all] In process monitor: Clears all jobs from the table.
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Button / buttons Referenced as Function

[Abort] In process monitor: Aborts job execution.

[Clear] In process monitor: Clears one job from the table.

[Expand] Shows dialog parts in the dialog.

[Collapse] Hides parts of the dialog in the dialog.

[Expand all] Expands list of items.

[Collapse all] Collapses list of items.

 
[Previous] / [Next] Goes to previous / next item.

[Reverse order] Reverses order.

[Lock / Unlock] In pen panel: It makes all values of selected pens
local.

 
[Reset pen] In pen panel: Restores the default values for selected

pens.

[Cut] Deletes selected item to the clipboard.

[Copy selected] Copies selected items to the clipboard.

[Transfers the pen set] Transfers the current pen set to the library by either
creating a new library pen set or overwriting an
existing one.

[Paste] Pastes selected items from the clipboard.

[Create] Creates selected item.

[Apply filling] Applies a filling template to a selected object.

[Apply filling without
removing]

Applies a filling template to a selected object
without removing an existing filling.

[Copy settings] Copies settings to adjacent dialog section.

[Execute] Starts processing of selected jobs / objects.
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Button / buttons Referenced as Function

[Stop] Stops processing.

[Search] Searches the network for control cards.

[Connect] /
[Disconnect]

Connects to or disconnects from the control cards (IP
address).

Table. 4.7: RG-007

Toggle buttons

Some icon buttons serve as toggle switches. Clicking them activates/deactivates the function. In
some cases the icon turns red when activated.

[Auto connect at
startup]

Automatically connect to the control card when the
program starts.

[Pointer] Activates the pilot laser.

[Arm/Disarm] Arms and disarms the laser. An armed laser is ready
for operation.

[Preview] Starts / stops a preview.

[Show pen] In pen panel: Activates / deactivates the color
highlighting of elements in the tree structure that
use the selected pens.

Transformation buttons

Buttons used for object transformation on the Process adjustment panel are described separately, see page
359, Process adjustment.

Table. 4.8: RG-008
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Keyboard Shortcuts

Some functions can be accessed using function keys on the keyboard:

Key Function

[F1] Help

[F2] Rename

[F3] System settings

[Ctrl]+[F3] Device configuration

[Ctrl]+[N] New job

[Ctrl]+[S] Save job

[Ctrl]+[L] Laser diagnostics

[F4] Zoom to workspace

[Ctrl]+[F4] Close job

[Alt]+[F4] Exit application

[F5] Object properties

[F6] Pen set configuration

[F8] Start preview

[F10] Enable marking with keyboard shortcuts

[F11] Job settings

[Ctrl]+[F11] Job presets

[Ctrl]+[F12] Stand-alone mode dialog

Table. 4.9: RG-009
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5 DEVICE CONFIGURATION AND
CALIBRATION
Before you use RAYGUIDE to define and execute laser processing jobs or other tasks, the
system devices must be configured. Four types of devices are available:

■ Control cards

■ Lasers

■ Deflection units and

■ System / Serial computer controls

Recommended workflow

The hardware devices must be configured according to their interfaces, properties and optical
setup. Carry out all the steps listed below in any order you want.

Add the device to the Configured Devices area in the device configuration window.
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Step 1 In the menu, select System > Devices > Configure…, or press [F3].

After initial installation of RAYGUIDE, the right side of the dialog box is empty:

Fig. 5.1: RG-ADT
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Configuration window with sample content:

Fig. 5.2: RG-AAP

To add devices such as a control card or a laser, use the mouse to drag the device out of the
Supported Devices window area into the Configured Devices area. You can add a
supported device type to the Configured Devices area multiple times.

NOTE: We recommend adding at least one control card.

Step 2 Configure the device. Double-click on the device entry to open its configuration dialog box.

The various settings and options in the configuration dialogs are described in the following
sections of this manual.
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Step 3 The control card must know which devices it should communicate with. That is why you have
to assign a laser and a deflection unit to the control card as follows:

■ Navigate to the control card configuration dialog and select the appropriate device from
the drop-down list for lasers and deflection units. The configuration dialog box of the
control card lists all devices that are currently in the Configured devices area.

■ Use the [Edit] button to configure the device (if not already done).

Result: Once the devices have been linked to a control card, the short name of the card is displayed
after the device entry in the device configuration overview.

Color coding: For the color coding of the traffic light display, see page 131, Job Panel.

The check mark behind the control card indicates that this control card and the devices linked
to it are defined as primary devices. If several control cards are used, you can change the
definition of the primary devices by moving the check mark.
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5.1 Scan Controller Configuration
Open the control card configuration dialog. There are three options here:

■ In the Configure devices menu, double-click on the entry of the control card (right-hand
side), or use the context menu of the control card and select Properties.

■ In the menu, select System > Devices > Scan controllers > (Device name).
■ Double-click on the card entry in the job overview.

The configuration window of the control card has five tabs: Setup, General, I/O, MOTF,
Serial.

5.1.1 Setup
Important configuration settings of the control card.

Fig. 5.3: RG-AAQ
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Setting Explanation

Card Name and IP address of the control card.

Click on the [Search] button to search for available control cards.
The control cards available in the network are listed together with their serial
numbers and IP addresses.

Identify the SP-ICE-3 control card based on its serial number and select it. In
most cases, each control card is listed once with its IP4 address and once with its
IP6 address.

NOTE: Which IP address family is selected for the control card does not affect
the connection speed of the control card.

Alternatively, you can click on the [Edit] button to add a control card by
directly entering your IP address.

Click on the [Connect] / [Disconnect] button to connect or disconnect a
control card. An active connection to the control card is indicated by a green
“traffic light”.

If you are setting up a system with several control cards, repeat this step for
each control card and its individual configuration dialog.

[Auto connect at startup] toggle switch specifying whether the control card
should be automatically connected when starting RAYGUIDE. If you disconnect
from the card and do not want the system to automatically reconnect to the
card the next time you start the program, you must deactivate this button. The
button is activated by default.

Click on [Webinterface] to access the web interface of the control card. For
instance, this interface can be used to update the firmware of the control card.
You can find more information in the manual of the SP-ICE-3.

Laser Select a suitable laser to be controlled by the control card.

Click on the [Edit] button to open the laser dialog.

Click on the [Add] button to add another laser device to the list of configured
devices.
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Setting Explanation

Head Protocol Select a suitable protocol for the deflection unit. This protocol defines the
command resolution and the number of controllable axes.

■ XY2:

– Log with a resolution of 16 bits

– Can control up to 3 axes

– Requires an additional XY2-100 adapter card on the SP-ICE-3

– Only “Single head” mode

– Supports feedback channel

■ SL2:

– Log with a resolution of 20 bits

– Can control 2 axes per protocol port/cable. Two SL2-100 connections (and
two cables) are required for a deflection unit with 3 or 4 axes

– “Dual head” mode possible

– Supports feedback channel

■ RL3

– Log with a resolution of 20 bits

– Can control 6 axes per control port / cable (a deflection unit with up to 6
axes can be run on a single data connection)

– “Dual head” mode possible

– Supports feedback channel

NOTE: The subtype of the protocol is defined by the correction file selected in
the deflection unit dialog box.

Scan head 1 Select the type for the first deflection unit.

Click on the [Edit] button to open the dialog for the deflection unit.

Click on the [Add] button to add another deflection unit to the list of
configured devices.

Scan head 2 Select the type for the second deflection unit. This only applies if you have
selected a protocol that contains “Dual head”.

Click on the [Edit] button to open the dialog for the deflection unit.

Click on the [Add] button to add another deflection unit to the list of
configured devices.
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Setting Explanation

Enable logging Activates the SP-ICE-3 API log. The log file records all SP-ICE-3 API commands
sent to this control card. This is decisive for error analysis. See page 396, Error
Handling and Log Files.

Click on [Reset] to reset the log file.

Log path Path to the log file.

Click on [...] to select a path, or click on [Go to] to open the corresponding
folder.

Short label A name for this control card that is easy to remember. Naming the control card
according to its function or assignment in the system is recommended so that it
can be easily identified later.

Table. 5.1: RG-010
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5.1.2 General
Basic information about the scan controller.

Fig. 5.4: RG-AAR
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Setting Explanation

Card Info Display of the major control card information such as its serial number and
firmware version.

Detected adapter boards Displays the IO ports and connected adapter cards (if detected).

NOTE: For details on the adapter cards, see the manual of the SP-ICE-3 control
card.

System Time Display of the control cards operating system time

Stand-Alone Indicates the operating status of the control cards and whether a list is being
executed.

The [Preferences] button takes you directly to the dialog of the stand-alone
configuration.

Deflection Unit
Monitoring

NOTE: If monitoring is activated and the number of consecutive errors exceeds a
defined limit, the control card terminates any active execution. When operating
in stand-alone mode, this will call up the so-called “error list”.

The cause for the termination can also be communicated to external devices
using the "Error handling" option. See page 348, Automated Error Handling.

NOTE: If monitoring is activated, the status is also checked separately before the
execution of each job. If it is faulty, job execution is not started and the
following validation message appears:

Enabled Activates the control card to monitor the status of the connected deflection unit
by querying its head status word.

Legacy deflection unit Select this option to also be able to use the monitoring for deflection units that
do not support the so-called "Enhanced Protocol". For instance, this includes
deflection units of the MS-II or SS-IIE series.

Period Time interval, in which the card is querying the status word.

NOTE: We suggest not to set the period too short (recommendation not below
500 ms), as this stresses the data exchange unnecessarily.

Min. consecutive errors Number of consecutive errors that is tolerated before all active executions are
terminated.

Table. 5.2: RG-076
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5.1.3 I/O Port Configuration
Used to configure the I/O ports SP-ICE-3 of the control card.

Fig. 5.5: RG-AAS

Setting Explanation

Port mapping

Click on [Add mapping] to start the configuration or to add a new port configuration.

Checkbox Check the box to select the port for further actions (e.g. delete).

ID Use the ID to give the port a name under which it can be selected later in
the GUI.

CAUTION: Existing references to this port, for example in automation
objects, are cleared when the ID is changed.
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Setting Explanation

Data direction Select In if the port receives signals from another device, or Out if the port
provides signals for other devices.

NOTE: Some I/O ports of the SP-ICE-3 control card can be split into an input
and an output section.

Physical port name Select an available port. A description of the available ports together with
their physical arrangement as well as names can be found in the manual
for the SP-ICE-3 control card.

Bit range Use the mouse to set the range of bits to be used. Click at the first and the
last bit. The range of available bits / pins is determined by the selected
port. Non-selected bits are ignored.

Color code:

■ Green: Marks the selected bit range. To resolve the range, click on the
outermost marked box.

■ Gray: This bit has already been assigned elsewhere.

■ Red: This bit was assigned twice!

Polarity Use the polarity to define whether a logic "1" is applied at 0 V=Low or
5 V=High.

[Delete] Click on the [Delete] button to delete the corresponding port
configuration.

Special functions In / Out

In
■ Start mark

■ Abort mark

■ Part sensor

■ Laser alarm

■ Laser Sync

Use the drop-down list and set the port and its signal index
For the signal to be queried for incoming signals 
For the signal to be set for outgoing signals.

NOTE: The SP-ICE-3 control card provides two dedicated pins on the Laser
In (X907) port for the input of the start / stop signal, which then do not
require any configuration.

Define the signal polarity in the second drop-down list.

NOTE: If you set the I/O pins for the Start mark, Abort mark, Part sensor,
Laser alarm, Laser Sync inputs to “High Active” but do not connect
anything (= floating state), you create a permanent logical “TRUE” state of
the respective signal due to the input resistance. For more information,
please refer to the manual for SP-ICE-3.

Out
■ Arm Laser

■ Pilot

■ Mark in progress

■ Marking active
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Setting Explanation

Port level

Port A / Port B Select the value of the port level to be 0 V, 3,3 V or 5 V.

General

Short label Enter a name to identify which ports are associated with which control
card.

Table. 5.3: RG-012

"Execution in progress" signal vs. "Mark in progress" signal:

Both signals are generated by the RAYGUIDE application. The "Execution in progress" signal
is set while an execution is waiting for a trigger signal or a belt distance, for example. In
contrast, the “Mark in progress” signal is not set during a wait condition, meaning it is only
active when layout objects are actually being processed / marked.

NOTE: The MIP signal is active independently of whether the laser is armed or not. That
means the signal is also active during a preview, for example.

Binning

Using signal patterns from external devices, for example a PLC, can be used to control
whether a job (stand-alone mode only) or an object should be processed.

For details on binning, refer to page 350, Setting up the stand-alone card operation and page
181, Common Properties of Marking Objects.

Port masking

It is possible to configure the same physical port multiple times, each with a different bit
selection.

Use case:

You want to control the execution of different job objects by "port masking". Let’s assume
you have two objects within one job and the following three variants:

■ Only object 1 should be processed

■ Only object 2 should be processed

■ Both objects should bet processed

You need to define the same binning port twice, where, for example, the first port checks
only bit 0 and the second port checks only bit 1.

The control will now be as follows:

■ Only bit 0 = active

■ Only bit 1 = active

■ Bits 1 and 2 = active
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5.1.4 MOTF
Use this tab to configure the necessary settings if your application requires “Mark-On-The-
Fly”.

For details, see page 314, MOTF Jobs.

5.1.5 Serial Port Configuration
Configures the scan controller card's serial port for communication purposes. Set according to
commonly used general serial communication settings.

Fig. 5.6: RG-AAT
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5.2 Laser Controller Configuration
Open the configuration dialog box for laser control. There are three options here:

■ In the Device configuration menu, double-click the laser source entry (right side) or select
the Properties item in the context menu.

■ In the configuration dialog of the control card, click on the [Edit] button next to the
selected laser device.

■ In the menu, select System > Devices > Laser > (Device name).

NOTE: Some laser types offer special control options and therefore special pen parameters.

Laser Specific parameters

Trumpf TruPulse nano / SPI G4 Waveform, simmer voltage

IPG YLPS AMB Second laser power

IPG YLPN APD Optical pulse width

JPT MOPA Optical pulse width

nLight AFX Beam profile index

nLight SFX Second laser power

Coherent Highlight ARM Second laser power, automatic IO configuration of the control card

Table. 5.4: RG-082
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The configuration dialog for lasers shown below includes all conceivable (generic) settings.

Fig. 5.7: RG-AAU
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Setting Explanation

Power control

Hot power target Defines the signal type through which the (primary) laser source receives
power data (DAC0, DAC1 / Digital1bit, Digital2bit, Digital8bit,
Digital16bit / LmWidth, LmFrequency).

Depending on the “available” laser selected, there is already a default
setting. For instance, select DAC for analog-controlled lasers or LmWidth
for standard CO2 lasers.

Secondary power target Define the power signal type for a possible second analog power setting
here.

Only Dac0 or Dac1 are available for selection.

Features

Visible pointer Defines whether the corresponding laser is equipped with a pilot laser so
that the preview function can be offered.

Laser modulation

Gate Signal polarity The polarity of the gate signal can be set to low- or high-active according
to the interface description of the laser.

LM signal polarity The polarity of the laser modulation signal can be set to low- or high-
active according to the interface description of the laser.

On the laser side, this signal is often referred to as “trigger”, PWM (pulse
width modulation) or PRR (pulse repetition rate).

Enable gate modulates LM Only required if the dotted line function is used with lasers that do not use
a switching signal input (e.g. CO2 lasers).

Enable laser synchronization For lasers that have an internal pulse sequence to adjust the vector
position to the laser timing

Enable equally spaced pulses Causes the frequency to be modulated in relation to the actual marking
speed. This achieves equidistant laser pulses, even with changes in speed
caused by acceleration / deceleration of the deflection mirrors.

NOTE: This function is based on the value of the drag delay of the
deflection unit. That means this value must be specified correctly.

Gate setup [µs] Time period in which the gate signal precedes the actual start of marking.

That means positive lead times extend the period for which the gate signal
is set.

That means negative lead times shorten the period for which the gate
signal is set.
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Setting Explanation

Gate hold [µs] Time period in which the gate signal lags behind the actual end of
marking.

That means positive lag times extend the period for which the gate signal
is set.

That means negative lag times shorten the period for which the gate
signal is set.

Laser trigger delay [µs] Time in which the optical pulse is generated after the trigger edge has
been received by the laser.
The value must be provided by the laser manufacturer.

Power settings

Power scale [%] Global power scale in [%]

Example:

If an analog-controlled laser requires the power range to be regulated
over a voltage range of 0 V to 5 V, you can scale the output power to 50%.

CAUTION: If scaling is to be used in combination with a power calibration
file, this scaling is not entered in this input field. Instead, it must be
entered directly into the calibration file.

To do so, use the SPICE3PowerCalibrator.exe software application, which is
part of the software tools of the control card.

Nominal laser power [W] Specification of the maximum laser power in [watt], which corresponds to
100%.

CAUTION: It may be the case that this specification was previously made
under System > Preferences > User (current user) > User interface >
Units . The value can be adopted automatically in this case. For instance,
the following message would appear:

2nd channel [W] 2 Specify the maximum laser power in [watt] for the possible second laser
channel, which corresponds to 100%.

Power validation

Unit Select the unit for validating the laser power of the pens used.

NOTE: The selection of the unit does not determine the unit in which the
power is specified in the pens, see page 110, UI.

Validate total power Define whether the combined power from primary and secondary power
should be validated. This ensures that the total power does not exceed the
specification of the deflection unit.

2 NOTE: Certain settings for the laser are only possible or necessary if a second power channel is used.
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Setting Explanation

Min. power

Max. power

Fields for defining the laser power limits that can be used to validate the
pen values. For instance, some lasers can be slightly unstable if they
operate in a power range that is too low.

Enable power calibration

Enable power calibration / 
2nd channel 2

Define whether you want to apply power calibration (also optional for the
second power channel).

Calibration file Use Windows Explorer to navigate to the desired laser calibration file and
load it.

You also have the option of selecting a calibration file for the second
power channel.

NOTE: The calibration file is generated using the
SPICE3PowerCalibrator.exe software application, which is part of the
software tools of the control card.

Power correction

Enable position dependent / 
2nd channel 2

Define whether you want to apply a field position-dependent power
correction in order to influence the laser power depending on the current
scan field position (also optional for the second power channel).

Correction file Use Windows Explorer to navigate to the desired laser calibration file
(*.pc3) and load it.

NOTE: The power correction file is created using the MULTI POINT EDITOR
application. If you use the second power channel, it can contain correction
data for both channels.
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Setting Explanation

Signal timing

Operating mode Select whether the laser should only work in pulsed or continuous line
mode or whether it should be possible to select the mode in the pen.

NOTE: Depending on your choice, the limits for the pulse frequencies can
be defined below. The pens offer respective fields for the pulse frequency
and selection of the operating mode.

Min. frequency [kHz] Minimum frequency at which the laser can operate

Max. frequency [kHz] Maximum frequency at which the laser can operate

Pulse width definition Fixed: The pulse width of the laser modulation signal is set to a fixed value.
The value can be entered in the next field. Please refer to the relevant
laser manual for the expected standard pulse width.

Relative: The ratio of pulse width to pulse duration is variable because it
depends on the frequency and laser power [in percent] defined by the
pen. Usually used by CO2 lasers with the “LMWidth” power signal type.

Manual: Select this option if the pulse width has to be set individually for
each pen.

NOTE: The pulse width value influences the control pulse, but not
necessarily the optical pulse.

Pulse width [µs] Fixed value for the pulse width of the provided LM signal

Max. duty cycle [%] Defines the maximum ratio of pulse duration to pulse period that the laser
accepts.

Power change setup [µs] Time required by the laser to change the output power. The value is
provided by the manufacturer of the laser or calculated with application
tests.

Latch power delay [µs] Time at which the signal for setting the power value is set according to the
power command.

Latch power width [µs] Pulse width of the signal for setting the power value

On delay [µm] Specification of a delay time when switching on that is added individually
per laser source to the switch-on delay specified in the pen.

NOTE: May be necessary when using several lasers because even the same
laser models from the same manufacturer have slightly different reaction
behavior.

Off delay [µm] Specification of a delay time when switching off that is added individually
per laser source to the switch-off delay specified in the pen.
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Setting Explanation

Simmer

Simmer power target Define the power signal type for the simmer voltage here.

NOTES:
■ Dac1 is used here as standard.

■ This specification primarily has to be made for TruPulse nano / SPI G4
laser types.

Only while marking Activate if the simmer voltage should only be set during marking.

Activation delay [µs] Time during which the simmer voltage must be set before marking.

Tickle

Enable tickle Enables the use of the tickle signal. Please refer to the laser manual for
more information on whether your laser requires this signal.

Frequency Frequency of the laser tickle signal as per the laser manual

Pulse width [µs] Pulse width of the laser tickle signal as per the laser manual

First pulse suppression

Polarity The polarity of the FPS signal of the laser can be set to low- or high-active
according to the interface description of the laser.

Setup time [ms] Defines the period of time with which the FPS pulse must precede the first
optical pulse.

Pulse width [µs] Defines the pulse width of the FPS signal as per the description of the laser
interface.
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Setting Explanation

I/O configuration

Auto configure When activated, the pins on port X907 of the control card are
automatically set:

Coherent Highlight ARM laser

The freely configurable pins are configured for the Laser alarm, Pointer
and Arm signals.

Lasers that support the Laser Sync signal

The pin for Laser triggered is set automatically if the "Enable laser
synchronization”option is selected at the same time.

The polarity for the input signal is “High” by default. Use the laser manual
to check whether this signal polarity applies to your laser model.

NOTE: If you want to use this auto configuration, the corresponding inputs
must be wired.
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Setting Explanation

General

Short label Assign a name with which the laser is listed in the GUI, e.g. manufacturer,
type.

Table. 5.5: RG-013
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5.2.1 Advanced configuration of lasers with serial
interface
Some lasers can exchange additional data or receive commands, usually through an
additional serial interface.

Depending on the laser, you can either use the serial PC interfaces (after prior configuration,
see page 88, Configuring the PC / computer serial interface) or the serial interface of the SP-
ICE-3 control card (port X802).

CAUTION: The functions that communicate via the serial port of the PC are only effective in
On host or Quick job execution mode.

This applies, for example, to setting the laser power and pen frequency of the InnoLas Nanio
Air laser.

Another laser that only uses serial communication via a PC port is the IPG YLPN APD laser.
Serial communication is optional here to query the available optical pulse width values:

The laser configuration contains the option for enabling the interface for serial
communication and selecting the serial port.

Fig. 5.8: RG-AEF

The traffic light indicates the laser operating status:

Red: Laser is not responding (for instance because it is not connected or not switched on)

Yellow: Laser still warming up

Green: Laser is ready for operation

You can view the exchanged commands in the event log in a second tab. These are also
written in the RAYGUIDE log.
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5.2.1.1 IPG laser type YLPN APD
The values for the pulse width of the optical laser pulses can be set with this laser type
(depending on the laser, these are set up individually in advance by IPG).

The APD mode is transmitted from the control card and adapter board to the laser through
the IO connection. That means an additional connection via the serial interface is
optional.

CAUTION: RAYGUIDE only supports the fast APD mode. Please check with the laser
manufacturer to determine if your laser has this mode.

CAUTION: To allow the laser to execute the signal sequence for switching the adjustable
pulse duration via the IO interface of the IPG compatible adapter of the SP-ICE-3 control card,
jumper W3 of the adapter board must connect contacts 2 and 3. This applies no matter which
IPG interface type is used. For details, see SP-ICE-3 manual, chapter 4.3.4.

The pulse width values for the indices can be queried and read in via the serial interface. This
allows the values to be displayed in the pens.

NOTE: With IPG lasers, the so-called optical pulse width does not correspond to the pulse
width of the laser modulation signal.

NOTE: The values of the optical pulse width for the respective APD mode are saved in the
Device.json file, but can be queried again manually using the [Refresh] button if the laser
source has been replaced.

5.2.1.2 InnoLas laser type Nanio Air / Blizz
With this laser type, information on the operating status of the laser can be queried by the
serial interface, for instance to avoid starting a job while the laser is still in its warm-up phase.

The status of the laser is queried automatically whenever a job has to be executed.

If the laser is not in an operational state, a corresponding device validation message appears
in the GUI:

Fig. 5.9: AEE
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5.2.1.3 Lumentum Picoblade 3
This laser type communicates exclusively via the serial port of the SP-ICE-3 control card.

Serial commands are used to arm or disarm the laser. This communication path can also be
used to acknowledge error messages.
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5.2.2 Additional laser-specific options

5.2.2.1 nLight AFX / SFX laser

Fig. 5.10: RG-AFN

nLight-specific

Initialize on start If activated, RAYGUIDE automatically switches the nLight laser to the standby or
emission state when the application starts.

If not activated, the nLight laser is only set to the emission state when the laser
is manually armed.

Disarm to Off state If activated, the nLight laser switches to the Off state during disarming.

If not activated, the nLight laser switches to the Ready state.

NOTES:
■ For the nLight laser, the interlock may only be opened in the Off state;

otherwise, an error message will be output and the laser will be forced to
switch into the Off state.

■ Independently of this, a preview with the pointer is possible both in the
Ready state and in the Off state.

Device status Off / Ready / Emission / Error

Indicates one of four possible states of the laser source. For further details on
the status, please see the notes in the manual of the laser source.

The different statuses are also shown in the job panel, see page 131, Job Panel.

Status water flow Yes / No

Indicates whether the laser source is water-cooled.

Can be used to manually reset the error status of the laser source.

NOTE: Only enabled if the laser source has an active error.

Table. 5.6: RG-083
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5.3 Deflection Unit Configuration
Open the deflection unit configuration dialog window for laser control. There are three
options here:

■ In the Device configuration menu, double-click on the entry for the deflection unit (right
side) or select the Properties option in the context menu.

■ In the configuration dialog of the control card, click on the [Edit] button next to the
corresponding device.

■ In the menu, select System > Devices > Deflection units > (Device).

The configuration window for the deflection unit consists of three tabs: General,
Calibration, Deflection unit status.

NOTE: If you are using a deflection unit with different correction files and / or field sizes, it is
advisable to make your work easier by “cloning” the existing deflection unit, therefore
creating a second deflection unit to which you can assign a different correction file and also a
different calibration.

CAUTION: If you use several deflection units with the same optical setup and therefore also
with the same correction file, duplicating the original correction file and adding a suffix to
the file name for each deflection unit is strongly recommended so as not to confuse the
correction files.
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5.3.1 General

Fig. 5.11: RG-AAV
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Setting Explanation

Model / Article Number The data is automatically read from the deflection unit. The deflection unit
must be physically connected to make it possible to read this data from the
deflection unit. The correct protocol must also have already been set in the
General tab of the control card configuration dialog.

Correction file A correction file must be selected.

RAYLASE provides suitable correction files for the optical setup of the
customer.

Correction files should be saved in the following folder and also loaded from
there: C:\ProgramData\RAYLASE\CorrectionFiles\

The correction file must have the FC3 or GCD format.

To ensure that the correction file is immediately updated on the control
card, click on the [Apply] button after selecting the correction file – this is
especially important if you intend to continue with field calibration right
away.

[…] opens the folder where the correction files are stored in order to select
a correction file.

[Go to] opens the folder where the correction files are stored, but without
further action.

[+] adds another row to select an additional correction file as an option that
can be loaded and used on the same control card. A maximum of 4
correction files can be loaded for one (single) deflection unit.

CAUTION: The additional correction file can only be loaded if:

■ It corresponds to the same optical setup as the first correction file

■ The file name is not absolutely identical

■ The number of four correction files is limited to correction files that
support a maximum of three optical axes.

NOTE: For how the assignment is made to determine when which correction
file is used, see page 119, Setup, page 260, Setting the correction file index
and page 307, Job Properties.

Correction file info Information is displayed such as the working distance, input beam size,
number of optical axes, which additional axes are available, number of field
dimensions. Depending on the correction file, additional information may be
displayed.

Use the expander to display the information.
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Setting Explanation

Orientation Defines the directions of the XY coordinate system of the RAYGUIDE GUI
relative to the current alignment of the deflection nit. The directions of the
layout in the RAYGUIDE viewport should correctly reflect the workspace of
the deflection unit. Can be adjusted to 0°, 90°, 180°, 270°. If you have any
doubts, run a marking test to determine the correct setting.

According to RAYLASE conventions, an orientation of 0 degrees means that
the +X-axis points in the direction where the laser enters the deflection unit.
For units in which the laser enters from above (e.g. AS FIBER), the standard
+X-axis points towards the front of the device.

Invert Axis Check boxes for the X- and Y-axes to invert the individual coordinate axes.

Set transfer delay Activate this option if you have not already defined a transfer delay for the
control card.

The transfer delay is made up of a value depending on the protocol and the
interpolation time of the deflection unit.

The interpolation time is either read out automatically by the deflection unit
or can be entered manually. The [Refresh] button can be used to repeat the
query of the interpolation time at any time.

NOTES:
■ The transfer delay will affect the timing between the laser and deflection

position.

■ The option exists from RAYGUIDE version v.1.17.

Speed limit [m/s] Defines an optional speed limit for the deflection unit. Default setting is
100 m/s. This setting does not override the speed set in the pens, but can be
used for job validation. See page 336, Running a Job.

Max. current [A] Defines an optional upper limit for current consumption of the
galvanometer drives of the deflection unit. Default setting is 6A.

The value is used exclusively for job validation of the wobble parameters in
the pens used (see page 107, General).

Max. magnification 3 Displays the maximum value for the spot magnification factor (according to
the loaded correction file).

Spot size [mm] 3 Specification of the “diameter” of the laser spot on the material at
magnification factor 1. This value is used in the pens to convert the spot size
from relative to absolute size.

(See page 110, UI)

3 These fields are only available if the loaded correction file supports spot magnification.
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Setting Explanation

Tuning

The data in the section below can be read either from an internal database or from the connected
deflection unit.

Click on the [Refresh data] button to update the tuning list and the associated dynamic data, for instance if
another deflection unit has been connected.

NOTE: In order to automatically obtain the data, the article number of the axis displayed at the top of the
window is required. If an older deflection unit that does not support the extended protocol is connected,
the values must be entered manually.

The dynamic data for the X- and Y-axes is always identical and is therefore listed together.

Storage The memory location number (counting always starts at zero) is the fine
adjustment internal ID.

Name The name assigned to the tuning can be overwritten. That means that you
can enter a suitable name for each tuning that best describes the associated
dynamic behavior in your application. This name is also displayed to select
the desired tuning in the “Send Enhanced Command” automation object.

Tracking error [µs] The value is either read from an internal database as per the part number
specified for the axes or, if the head is equipped with DICON2.5 electronics,
it is read from the deflection unit.

NOTE: If necessary, the value can be corrected or entered manually (for
instance if the deflection unit cannot provide information such as the article
number of the axes). Use the right mouse button > Reset to Default to reset
the settings to the original values.

Information on the value:

Time interval required by the respective optical axis to follow a new position
command.

The value depends on the inertia of the optical axis (resulting from the
substrate material and diameter) and the so-called tuning. If in doubt, the
values can be found in the data sheet or in the manual for the deflection
unit.
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Setting Explanation

Acceleration time [µs] The value is linked to the tracking delay value by default.

NOTE: If necessary, the value can be corrected or entered manually (for
instance if the deflection unit cannot provide information such as the article
number of the axes). Use the right mouse button > Reset to Default to reset
the settings to the original values.

Information on the value:

Time [microseconds] the respective optical axis needs to reach the desired
speed specified in the pen.

This value is only used when marking bitmaps.

Default | Active Select which of the available tunings should be set.

■ Standard = tuning that is loaded when the deflection unit is started up.

■ Active = tuning that is active unless the “Send Enhanced Command”
automation object is used to manually set another tuning.

Short label A name for this deflection unit that is easy to remember. You can enter the
field size as part of the name, for example.

Table. 5.7: RG-014
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5.3.2 Deflection Unit Calibration

5.3.2.1 Overview
The field calibration must be performed to ensure that the marked geometry matches the
precision requirements. You can also use it to adapt the position of the scan field to the
machine geometry.

Suggested workflow:

Before starting to calibrate the deflection unit

■ Ensure that the laser has already been configured and assigned to the card in order to
perform a laser processing job.

■ Assign the deflection unit to the control card in the control card dialog.

■ Assign the correction file in the deflection unit dialog.

The file name of the correction file associated with the calibration (execution and preview) is
displayed via the two areas for "Execution" and "Preview".

If more than one correction file was loaded onto the control card, the correction file
belonging to the calibration can be picked out of a drop-down list here.

The Calibration dialog is divided into the following sections:

■ Execution: Calibration of the scan field while the actual laser source is working and
executing jobs.

■ Preview: Calibration of the visible pilot laser. This calibration data is therefore applied
during a preview.
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Fig. 5.12: RG-AAW

In the “Execution” section, the geometric correction is defined for the executions of laser
processing jobs with the processing laser.



5 DEVICE CONFIGURATION AND CALIBRATION

© 2025 RAYLASE GmbH 80MN_RAYGUIDE [V2.11]

Setting Explanation

Fine focal adjustment (Scanner domain)

This option is only available if the correction file controls the pre-focusing optics, e.g. for deflection units of
the AXIALSCAN type.

Depending on the choice of domain, the offset for the focusing optics can be specified either in the Lens
offset or in the Focus range. This setting is used to adjust the focus position throughout the entire system.

Other additional optical axes, such as those used by the RAYSPECTOR can be adjusted directly in focus
position here.

Axis length [mm] Length of the movement range of the Z-axis [mm] (read-only field as
provided by the correction file)

Offset [mm] Offset value in [mm], which applies directly to the Z-lens position. Only
positive values are allowed, unless the correction file has a preset offset
included. A positive offset will shift the focus downwards.

Disable axis The user can decide to disable each available Z-axis if necessary.

[Focus finder] This button opens a dialog to define and execute a special marking
pattern. This marking pattern can be used to determine the current focus
position and calculate the z-axis offset from this position.

For details, see page 83,  Focus finder.

Field transformation (Field domain)

NOTE: Transformation values for offset and rotation as well as scaling above 100% reduce the available
workspace according to the correction file.

NOTE: These transformations are applied to the vectors to be marked and do not edit the correction file.

Gain [%] Can be defined separately for X- and Y-axes.

Reduces or increases the length of the vectors mapped by the deflection
unit until they are true to size with the defined geometry.

Mark an orthogonal square and measure its edge lengths. The ratio of the
measured value to the target length results in the scale factor per axis,
which you enter in [%]. Repeat the marking to verify the result by
measuring again.

Offset [mm] Moves the projected coordinate system relative to another coordinate
system (e.g. to align it with a machine coordinate system or another scan
field).

Editable for X- and Y-axes.
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Setting Explanation

Rotation [°] Rotates the projected coordinate system relative to another coordinate
system (e.g. to align it with a machine coordinate system or another scan
field).

Correction file

Multi-point calibration always applied to the selected correction file.

[Multi Point Calibration] Opens the MULTI POINT EDITOR (MPE).

The MPE makes it possible to correct any field distortions. The in case of a
deflection unit with 3 or 4 axes, it also allows for correction of the focus
dependent on the field position. It applies to the correction file selected on
the General tab.

You can use pens for marking as defined in the default library pen set.

After calibration, you work with an edited duplicate of the original
correction file, as the MPE application automatically replaces the file and
saves the original file.

Detailed information on functions and operation of the MPE can be found
in the separate manual for the MULTI POINT EDITOR that is attached to
the PDF.

[Embed calibration] This button transfers the field calibration values and axis offset values
directly into the correction file and resets the transformation values
accordingly.

Table. 5.8: RG-015

In the Preview section, the geometric correction of the preview is set up. This may be
necessary as the pilot laser emits at a different wavelength than the actual laser and, due to a
different diffraction, is projected differently on the workpiece.

For details, see page 332, Preview.
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Setting Explanation

Fine focal adjustment (Scanner domain)

The same principles apply as in the Laser section.

Pilot-laser specific: You can deactivate the Z-axis operation during the preview to reduce stress on the Z-axis
galvanometer motor. Check the option “disable z-axis” and the lens will pause in the default position while
the preview is running – likely causing a larger pilot laser spot.

Field transformation (Field domain)

The same principles apply as in the Laser section. See the table above for details.

To start calibration of the pilot laser, the values from the Execution section can be transferred into the
Preview section with the arrow button.

Pattern

To define a calibration test pattern.

Size [mm] and Pen Choose a size for a square to mark and a pen from the default pen set as process
parameters. By default, the square is positioned in the field center.

Mark and Trace First, mark the square using [Mark].

Then, trace the shape of the square with the pilot laser using [Trace].

Adjust Use [Gain], [Shift] and [Rotate] to superimpose the preview shape on the
marked square.

Delta fields Define the delta of the scale, shift, and rotate effects when the adjust buttons
are clicked.

Specify the delta values in the corresponding units for gain / offset / rotation.

Table. 5.9: RG-016
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5.3.2.2 Focus finder
The focus finder has two tasks that help you to globally set the focus for your pre-focusing
deflection unit.

1. A pattern is defined and marked which contains parallel lines in different focus positions.

To make it easier to identify the current focus position or focus deviation, a power ramp is
also used to get the following example image after marking:

Example:

Fig. 5.13: RG-AFO

2. By entering the ordinal number of the line with the best focus, the required offset of the
z-lens is calculated automatically (decimal numbers are also permitted).
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Setting Explanation

Pattern

Position X / Y / Z [mm] Specify the position in the scan field at which the pattern is positioned.

Z Range [mm] Specify the range in [mm] of focus stroke in which you expect the focus.

The lines are then arranged by half the range in the focus above and in the
other half in the focus below Z=0.

Line count Specify how many lines with different focus positions the pattern should
contain.

Line length Enter the length of the parallel lines in [mm].

Line separation [mm] Enter the distance between the parallel lines in [mm].

Pen

Select a pen from the standard pen set.

Laser Additional information derived from the pen to set the marking result of the
pattern.

For details on the parameters, see page 271, Pen Properties.

The ramp should be defined here so that it reduces the power at the start and
increases it again at the end of the line:

Mark timings

Ramping

Execute

[Activate pilot laser] Use the toggle button to activate / deactivate the pilot laser.

[Arm Laser] Use the toggle button to arm or disarm the laser.

[Execute] Use the button to mark the pattern.

Calculate z axis offset

Line number in focus Enter the number of the line of the pattern here that has the optimal focus.

If you have the impression that two neighboring lines are equally in focus, you
can also enter a decimal point value.

[Apply] Click on the button to calculate the offset.

The calculated value is applied as the offset for the z-axis in the Calibration tab.

Offset [mm] Display of the resulting z-axis offset.
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5.3.3 Extended monitoring of the deflection unit
In this tab, you can define the properties for extended monitoring of the deflection unit,
which, in contrast to monitoring of the deflection unit of the control card (see page 53,
General) is executed directly by the RAYGUIDE application. The RAYGUIDE applications then
also assumes the resulting actions in the event of an error.

USER NOTE: This type of monitoring of the deflection unit by RAYGUIDE is only
recommended when other types of operating data should be monitored in addition to the
status. If only the status should be monitored, monitoring by the control card is preferable
(see page 53, General).

NOTE: The actions in the event of an error are to be defined in the preferences, see page 94,
General. Monitoring only takes place if at least one action is defined.

Fig. 5.14: RG-AFP
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Settings

Period [ms] Defines the query interval.

Timeout [ms] Select a time to trigger an error message if the query takes longer than this
time.

Status

Enabled If activated, the status word of the deflection unit is checked.

This check is initiated if the deflection unit is not ready for use or is in an error
state.

Min. consecutive errors Number of consecutive errors that are tolerated before the status is declared
faulty.

RMS current

This option can only be used with deflection units whose firmware has at least rev. 6972 or higher so that
this value can be read out by the deflection unit.

Enabled If activated, the RMS current of the deflection unit is queried and checked
against the maximum.

Min. consecutive errors Number of consecutive value overshoots that are tolerated before the status is
declared faulty.

Max [A] Specification of the maximum permissible RMS current

NOTE: For the limit values for the RMS current, please refer to the manual for
your deflection unit or contact support@raylase.de.

Max [°]

This option can only be used for deflection units of the SS-IVHL series because only these deflection units
are equipped with temperature sensors on the galvanometer holders.

Enabled If activated, the temperature value measured by sensors on the holder of the
galvanometer scanner is queried and checked against the maximum.

Min. consecutive errors Number of consecutive value overshoots that are tolerated before the status is
declared faulty.

Aux temperature
(galvanometer scanner
bracket)

Specification of the maximum permitted temperature
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5.3.4 Deflection Unit Status Information
If you use a digital deflection unit (e.g. SUPERSCAN IV) and a fitting protocol has been
selected, this tab will display status information of the deflection unit.

Use the "Automatic refresh" option if the displayed values are to be continuously refreshed.
Several virtual status LEDs indicate the current device status. For the interpretation of the
LEDs, see the deflection unit manual.

Status information can be useful in case you have trouble with the deflection unit
performance or wish to check the active tuning.

The current mirror position can be read here, too.

Fig. 5.15: RG-ADM
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5.4 Configuring the PC / computer serial interface
Open the dialog for the serial interfaces. There are two ways to do so:

■ In Device configuration menu, double-click on an entry for the serial interfaces or select
the Properties item in the context menu.

■ Select System > Devices > Serial controllers > (device name) from the menu.

You can now set up a serial RS232 port at the computer for communication purposes.

Fig. 5.16: RG-AAX

Setting Explanation

Ports Click on [Add port] to define a new serial port. A new dialog opens. Multiple
ports can be defined. The columns represent common settings for a serial port
communication.

General

Short label A name for this PC serial port that is easy to remember.

Table. 5.10: RG-017
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5.5 Configuration Backup and Replication

Saving / Restoring the device configuration

The settings of the device configuration are automatically saved in configuration files. The
settings are preserved in case of a software update.

Nevertheless, saving the current configuration as a backup file (JSON  format) is
recommended.

In the device configuration window

■ Click on the [Export] button to create / save a configuration backup file.

■ Click on the [Import] button to import / apply a configuration backup file.

System replication

A configuration backup file is also helpful if you move to another computer or if you want to
replicate your complete system. Replication means having one or more laser processing
systems (control card, laser, deflection unit, computer with RAYGUIDE) that are similar to the
original one. Using the configuration backup saves the time for configuring another system
from scratch. However, a new system typically needs to connect to its own control card using
a unique IP address. This is a manual process, even if a configuration backup is used:

1. Search for the control card (IP address).

2. Select the control card.

3. Connect to the control card.
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Cloning devices

In the Configuration menu, an already configured device can be duplicated by cloning. This is
useful

■ If you use multiple control cards and want to use the same or similar hardware (lasers and
deflection units) with them. In this case it is necessary to add additional instances of the
hardware to the managed devices.

■ If you use the same deflection unit with different optical setups, for example, different F-
Theta lenses (with different field sizes). Instead of switching the correction file each time
you change the lens, it is more convenient to have a deflection unit configuration for each,
especially as each setup requires its own calibration.

To clone a device, point at it in the Configured devices list and select [Clone] from its context
menu.

When the clone is created, it can be reconfigured if necessary.

You can also clone the control card configuration, but you must connect the cloned control
card configuration to a different physical control card.

Correction files

Any employed correction file is not saved with the configuration, as any changes to it can
only be valid for a specific system and are not suited for replication.

For a new system, you must always start with an original correction file.
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5.6 Laser Diagnostics
The laser diagnostics tool can only be used to control the laser in order to measure its power
output, for instance to generate a laser calibration file.

In the menu, select System > Devices > Laser diagnostics… to open the laser diagnostic
file:

Fig. 5.17: RG-AAY

WARNING
Laser operation

Observe all relevant precautionary measures for safe laser operation.

Safety instructions can be found in the laser system and deflection unit manuals (scan head).
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Proceed as follows to perform measurement:

1. Select the control card with the connected laser. Make sure that the laser is switched on.

2. Enter 2- or 3-dimensional coordinates as the target for the laser beam. Make sure that
there is a suitable target object in the corresponding position, for instance a laser power
measuring probe.

3. Enter all relevant laser parameters for the measurement. The available laser parameters
may vary depending on the laser type and visibility settings for pens. Also see page 271,
Pen Properties.

4. Arm the laser if you have not already done so.

Click on the [Arm / Disarm] button.

An armed laser is indicated by a red fire symbol on the button.

5. Click on the [Laser on / off] button to start laser emission. The laser now emits until the
button is pushed again.

6. Close the dialog by clicking on [OK] or [Abort]. OK saves the settings until the function is
used again.
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6 PREFERENCES
The RAYGUIDE software can be configured with respect to user interface properties, process
behavior, permissions, etc.

Some settings need to be set only once when you set up the system after the initial
installation. Others can be edited while you are working with the corresponding functions.

View options can be used to set various options for the display of the user interface.

Settings made under System affect all users. You can use permissions to block selected users
from changing system-wide settings (e.g., everyone except the administrator).

Settings made under Current user can be set separately for each user. A logged-in user can
define their own settings.
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6.1 System Preferences

6.1.1 General
Select System > Preferences from the menu or press [F3] to open the Preferences dialog.
Go to the System tab (all users) and then to the sub-tab General to select some basic options.

Fig. 6.1: RG-AAZ
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Setting Explanation

Initialization

Arm laser on startup Sets the laser to ready-for-operation at software start up. Once checked, it
is no longer required to manually arm the laser prior to the job execution
(unless you disarm manually).

User management variant Specify which user management you want to use to set up the
authorizations:

■ Operating system:

Users have to be created as users in the operating system in order to be
assigned a role.

■ Local:

The administrator creates users in directly in a RAYGUIDE user list and
assigns them to a role there. This allows the authorization role to be
changed without logging out of the operating system.

NOTES:
■ Local users have to log in with user name and password each time the

RAYGUIDE application starts.

■ The default user with the administrator role is called “#rayguide#”.

■ The selection list contains all previously created users. The last user that
logged in is selected by default.

■ The initial password for all (newly) created users is “raylase” until the
user changes it to an customized password. The password can also be
left blank.

Additional specifications are made under System > Permissions > Users /
Groups.

CAUTION: After changing the user administration variant, the RAYGUIDE
application must be restarted.
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Setting Explanation

Reset process transformation,

Reset power scale,

Reset speed scale

Select when to reset all process transformations and scale settings for the
laser power value and / or speeds made on the Process adjustment
panel:

■ For Startup

■ For Execution

■ Never

Job execution

Auto disarm laser Select an event for which the laser is to be automatically disarmed:

■ Never

■ Abort

If job execution is terminated by clicking on the corresponding buttons
or with an abort signal to the control card, the laser is also disarmed at
the same time.

■ Error

If an error is reported, the laser is disarmed at the same time.

■ Abort or Error

Selection for both cases

Zero power after execution If this option is set, the power value is set to 0% after execution of each
job.

Otherwise, the power value at the output of the control card stays at the
last commanded power value.
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Setting Explanation

Extended monitoring deflection unit

Error Action Select at least one action in response to an error (for definition see page
85, Extended monitoring of the deflection unit). Multi-selection is possible.

■ Message:

A message appears in the Notifications panel (see chapter 11.3)

If the remote interface (see section 8.3) is used, an event message is also
sent to the remote client.

■ Warning:

The RAYGUIDE application shows a warning message:

■ Abort:

Any job execution that may be in progress is aborted.

NOTE: The extended monitoring of the deflection unit does not work in
stand-alone mode of the control card.
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Setting Explanation

Logging

These settings refer to the RAYGUIDE protocol (not to the log file of the control card).

Levels Set the checkmark for the log data to be recorded.

By default, all but Trace is checked. Trace data is very detailed and creates
huge log files. The Trace option should only be selected if this data is
requested by RAYLASE support.

File name Name of the log file.

Click on [Go to] to open the respective folder.

Notification logging

All messages from the Notifications panel are logged here (status messages, measurement results).

File name Name of the log file

Click on [Go to] to open the respective folder.

Table. 6.1: RG-018
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6.1.2 UI
Select System > Preferences from the menu or press [F3] to open the Preferences dialog.
Go to the System (all users) tab and to the UI sub-tab.

Fig. 6.2: RG-ABB

Setting Explanation

UI

Performance

Vector tip limit Defines the maximum number of vector tips that can be displayed so as not to
overload the graphic display.

Jump vector limit Defines the maximum number of jump vectors that can be displayed so as not to
overload the graphic display.

Display

Sharp corner limit [°] See page 29, View Options.

Path start / sharp corner
radius [pixels]

See page 29, View Options.

Toolbar icon size [pixel] Size of the toolbar buttons in pixels. This function is helpful if the user interface
is operated on a touch monitor.

Table. 6.2: RG-020
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6.1.3 Process Adjustment
You define limits for the two sliders here in the Process adjustment panel, see page 359,
Process adjustment.

Select System > Preferences from the menu or press [F3] to open the Settings dialog. Go to
the System (all users) > Process adjustment tab.

Specify the upper and lower threshold value for global scaling of the laser power and the
process speeds (mark as jump).

The upper and lower threshold value for the scanning scan speed is also defined in this tab.
For more details on the preview, see page 332, Preview.
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6.1.4 Visibility
You may display or hide parts of the user interface or its dialogs, depending on your
requirements.

Select System > Preferences from the menu or press [F3] to open the Settings dialog. Go to
the System (all users) tab and to the Visibility sub-tab.

Fig. 6.3: RG-ABC
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Make your selection in the following categories:

■ Bars: Enables / Disables the display of the toolbar and the status bar.

The status bar is the gray bar at the bottom of the user interface. It shows current status
information such as permission roles, cursor position, etc.

■ Markable objects properties: Enables / Disables the display of certain tabs or areas in the
properties dialog of (markable) objects.

– Pen tabEnables / Disables the tab for editing pens in the object dialog

– BoundingBox: Enables / Disables the display for the dimensions of the bounding box on
the first tab in the object dialog.

– Transformation: Enables / Disables the display for object transformation on the first tab
in the object dialog.

■ Pen-related settings can be used to adapt the pen dialog according to your needs. For a
description, see page 271, Pen Properties.

■ Job overview information to be displayed: For a description, see page 116, About Jobs.

6.1.5 Permissions
Using permissions, different user roles can be defined, each of which has specific permissions
to use the RAYGUIDE functions.

There are two options available for managing users, see page 94, General.

NOTES:
■ After initial software installation, no users are set up. That means that anyone who starts

the software will have all permissions. It is advisable to set permissions as soon as possible.

■ All created users are available to both variants of the user administration. When assigning
user names, please note whether users should be able to act in both variants or not.

CAUTION: As soon as a user has been created in the Local user administration variant, a
user is automatically created for the Operating system variant. 
That is why it is advisable to also create an operating system user with the administrator role
under local user administration. Otherwise, there will no longer be a user with administrator
rights when switching from the local to the operating system variant.

Select System > Preferences from the menu or press [F3] to open the Settings dialog.
Change to the System (all users) tab and then to the Permissions sub-tab.

Assigning users and / or user groups to roles

Go to the Users / Groups tab.
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6.1.5.1 Variant: User management via operating system

Fig. 6.4: RG-ABD

Setting Explanation

Add a new entry (line) above / below to create a new user.

The user name is entered directly into the first column. The “U/G” column
indicates whether it is a user (U = User) or a user group (G = Group).

NOTE: At least one user with administrator rights must be created.

Deletes the user entry.

Moves the line up / down.
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Setting Explanation

Button for adding a user / user group from the network administration. To
add a Windows-defined user group, the object type has to be switched
from U (User) to G (Group).

■ A Windows dialog opens in which you have to enter the login name of
the user. Several names can be entered (separated by a semicolon).

■ Click on [Check name]. If the user or the user group is found, confirm
with [OK].

NOTE: If the designated RAYGUIDE user is not available, the user has to be
created at Windows level first. For details on the PC user management, ask
your IT administrator.

Button for adding all users / user group from the network administration.

[Add role] Button for adding a new column for another role.

Table. 6.3: RG-094

6.1.5.2 Variant: User management local

Fig. 6.5: RG-AFE
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NOTES:
■ The administrator user is not listed here.

■ Only users who have been assigned a role are saved.

■ User names cannot be changed directly. To do this, the user must be deleted and then
recreated.

Setting Explanation

Add a new entry (line) above / below to create a new user.

The user name is entered directly into the first column.

Deletes the user entry.

Moves the line up / down.

Resets the password for the selected user to the initial password (“raylase”).

[Add role] Button for adding a new column for another role.

List of all created local users and their role assignment (multiple assignment possible)

Auto logout

Enabled

& Idle time [minutes]

If activated, inactive users with the Administrator role are automatically logged
off after the idle time in [minutes] has expired.

Table. 6.4: RG-093

To change the local user, go to System > Logout. The login dialog for logging in as a
different user appears.
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6.1.5.3 Assigning roles and permissions
Go to the Operations tab.

Fig. 6.6: RG-ABE

In the table you can assign various functions to the roles by setting checkmarks. The
administrator always has all the permissions. New roles can also be added here.

NOTES:
■ The role of the currently active user is displayed in the status bar at the bottom left of the

RAYGUIDE main window.

■ The administrator role is not listed here. This role allows all operations by default,
meaning you cannot withdraw any operations from this role.
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6.2 User Preferences
All preferences in the User section are stored per PC user and are not locked by any user
permission setting.

6.2.1 General
Select System > Preferences from the menu or press [F3] to open the Preferences dialog.
Go to the User (current user) tab and to the General sub-tab.

Fig. 6.7: RG-ABF
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Setting Explanation

General

Language Select from the list of available GUI languages. Currently available languages:
English, German, Chinese, French, Spanish, Italian, Japanese.

Default job Activate the option and select a job file that is loaded by default when the
RAYGUIDE application is started.

Deactivate this option if you want an empty job to be displayed when you start
RAYGUIDE.

Job template Activate the option and select a job file if you want a predefined job content
when starting a new job.

Deactivate the option if you want to have a blank job when you create a new
job.

Use case: Use case: Each job must start with a "Wait condition" and end with a
"Set I/O output" object.

Restore session Activate this option if all currently open and saved jobs should be automatically
reloaded when the RAYGUIDE application is restarted.

Show job description
when loading job

Activate this option if you want the content of the job description to be
displayed when the job is loaded.

This allows you to indicate any points that are relevant to job execution.

Job validation

Check the box if you want jobs to be validated with respect to the following aspects before execution (all
validations are enabled by default):

General
■ Whether the layout fits into the workspace / scan field

NOTES:

– In case on a MOTF job, validation is performed only for the configured

– If a tiler container is used, it is also checked whether the layout fits into the tile pattern.

– Job validation also will consider field calibration and process transformation, however, it does not
consider vector extension by skywriting or any wobble geometry.

■ Whether the job contains marking objects with open paths or whether all paths are closed.

■ Whether MOTF settings of the job are problematic. For instance, it is contradictory if the value for the
minimum segment width is greater than the maximum width of the MOTF split.
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Setting Explanation

Pen parameters
■ Whether the laser-related pen values exceed a limit (e.g. the power range as defined in the laser dialog).

■ Whether the scan head-related pen values exceed a limit (e.g. the speed limit as defined in the
deflection unit dialog).

■ Whether the pen settings with regard to ramping, in particular the accumulated ramp length, will
exceed the length of the respective path.

■ Whether the pen settings with respect to the wobble parameters would exceed the maximum current
consumption of the galvanometer motor (see page 73, General).

NOTE: To use wobble validation, your deflection unit must have firmware from rev7130 or later. You
can view the firmware version via the configuration dialog of the deflection unit (see page 87,
Deflection Unit Status Information).

NOTE: Job validation is not available in stand-alone mode.

For more information, see page 336, Running a Job.

Preview objects

Ignore binning Setting to display all objects in a preview, regardless of possible binning
conditions.

Logger

These settings refer to the RAYGUIDE protocol (not to the log file of the control card).

Levels The system default settings, i.e., the system settings, are used by default. The
current user can also use other protocol levels as needed.

NOTE: The Trace protocol level should only be set when requested by RAYLASE
support as otherwise a large number of unnecessary files will be created.

File name Name of the log file

Click on [Go to] to open the respective folder.

Table. 6.5: RG-021
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6.2.2 UI
Select System > Preferences from the menu or press [F3] to open the Preferences dialog.
Go to the User (current user) tab and to the UI sub-tab.

Fig. 6.8: ABG

Setting Explanation

General

Show actual coordinates Check if you want to show the coordinates of a graphic element including its
transformations in its properties dialog.

Center selected command Check if you want to show the graphic element you have selected in the job tree
in the center of the viewport.

Check one of the following settings:

■ Never

■ Always

■ If not in Viewport: Only if the selected graphic element is not already visible
in the current image section of the viewport.

Hide other objects while
editing

Check if you only want to see the actively edited object in the viewport (which is
particularly useful when multiple graphic objects are superimposed onto each
other).

Hide other layers while
editing

Check if you only want to see the layer actively selected in the job tree in the
viewport (which is particularly useful when multiple layers are superimposed
onto each other).
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Setting Explanation

Keyboard nudge [mm] Sets how many selected objects or graphic elements are moved with one
keyboard stroke (arrow keys) in [mm].

Jump vectors in pen color When the display option “show jumps” is activated:

Displays the jumps in the color of the pen which also defines the jump
parameters.

Magnetic range [pixels] Defines the area in pixels around a thumb, control point, or guide line in which
they act magnetically on other points of the inset or bounding box.

Complex undo redo
operation

For complex undo / redo operations (e.g. when objects with a large number of
vector objects are deleted or modified), a larger amount of memory is required
to undo the operation.

This function defines how complex undo / redo operations are handled.

Units

If you change the units, you must restart the software to apply the change to all forms and dialogs.

Speed Select the global speed unit:

■ [m/s]

■ [mm/s]

Power Select the global unit for the laser power: [%] or [watts].

The translation from [%] to [watts] is now defined in the laser configuration
(see page 59, Laser Controller Configuration).

Magnification Select the global unit for spot magnification:

■ Relative (factor) or

■ Absolute (diameter in [mm]).

The conversion factor for this is defined in the configuration of the deflection
unit (see page 73, General)

Table. 6.6: RG-022
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6.2.3 Process Adjustment
Define the preset deltas that edit the process transformation (offset, rotation, scale) when
using the buttons.

Select System > Preferences from the menu or press [F3] to open the Preferences dialog.
Go to the User (current user) tab and to the Process adjustment sub-tab.

For a description, see page 359, Process adjustment.

6.2.4 Vector optimizations
Various settings can be made in advance before using functions for automated vector
optimization.

Select System > Preferences from the menu or press [F3] to open the Settings dialog. Go to
the Current user tab and then to the Vector optimization sub-tab.

For detailed information on the application cases, see page 207, Automated vector
optimization.
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6.3 Saving / Restoring system settings
To save all settings and configurations for system recovery or system duplication made in
RAYGUIDE, you have the following option:

System > Import / Export settings

6.3.1 Exporting settings
In the [Export] sub-menu, you can select which settings should be included in the backup.

The export file has this name by default: "RAYGUIDEBackup_Timestamps"

Fig. 6.9: RG-AFI
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Setting Explanation

System

Preferences, pens and
error handling

Contains all settings that were made according to page 94, General to page 101,
Visibility.

All system pen sets and the settings for automatic error handling are also
included (see page 348, Automated Error Handling).

Templates Contains all templates generated for objects and fillings, see page 261,
Templates.

Permissions Contains the created users and their rights.

Device settings Contains all configured devices, see page 45, Device Configuration and
Calibration.

NOTE: However, the correction files are not included.

Correction files Contains all correction files for the configured deflection units, laser correction
files for the configured lasers and files for laser power calibration.

Job presets Contains all created job presets, see page 119, Job Presets.

Stand-alone settings Contains all configurations that have been set up for stand-alone mode, but
without the linked job files.

User (current user)

Preferences and pens Contains all settings that were made according to page 94, General to page 101,
Visibility.

All user pen sets are also included.

UI Layout Contains the current arrangement of panels and settings for the visibility of the
job element buttons and toolbars.

Default import settings Contains the current settings for importing vector graphics and the last import
directories used.

Table. 6.7: RG-095
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6.3.2 Importing settings
The settings from the backup are displayed during import.

Fig. 6.10: RG-AFJ

CAUTION: The settings from the imported backup file may overwrite all current settings that
were made in the various places in RAYGUIDE.

NOTE: Please note that after importing the device configuration, the control cards must be
re-connected after import. The link to correction files must also be recreated.
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7 LASER PROCESS JOBS

7.1 About Jobs
A job is a combination of graphic elements, process parameters, job parameters and job
execution settings.

To generate a new job, you can click on File > New in the menu or the [Add] button in the
main toolbar. Alternatively, you can also use the key combination [Ctrl]+[n].

The number of open jobs is not limited. A * on the job tab indicates that the job has been
modified since it was opened or created.

The figure shows an example with two open jobs:

Example:

Fig. 7.1: ABH

The Job panel is divided in 2 sections:



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 117MN_RAYGUIDE [V2.11]

On top, important job settings and the control cards linked to the job are shown. You may
collapse / expand the job overview. You may also enable / disable the display of the single job
information per preset.

Select System > Preferences from the menu or press [F3] to open the Settings dialog. Go to
the System (all users) tab and to the Visibility sub-tab Job.

The lower section provides the so-called job tree.

All job elements are listed in the order in which they get processed. For details, see page 130,
Job Content Creation.
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7.1.1 Save and Open Jobs
To save a created job, click on [Save] or the File > [Save] or Save as… item in the main
menu. The job file type is *.rg.

NOTE: We strictly advise against processing job files in any application other than RAYGUIDE.

To open an existing job, click on [Open file] or on File > Open in the main menu to navigate
to the desired job file. Alternatively, use “recent documents” to select one of the last used
jobs from the provided list.

To open multiple jobs simultaneously, select all job files in the Explorer and drag them into
the open RAYGUIDE GUI using the mouse.

When opening a job that was created on another RAYGUIDE system, that job refers to a
different control card and possibly to other hardware devices. Therefore, RAYGUIDE prompts
you to reference the missing devices to available devices in the current RAYGUIDE system.
Suitable devices are listed in the respective drop-down lists.

Fig. 7.2: RG-ADC

NOTE: If any of the requested devices or ports do not get assigned a new reference, the job
cannot be properly processed.
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7.1.2 Job Presets
In this menu option, you define and save the default settings for jobs, such as configuration
of the workspace, frequently used MOTF settings and automated job optimizations.

In the menu, select Job > Presets, or press [Ctrl]+[F11] to open the Job presets dialog box.

As a user, you can define several configurations as default settings:

■ Click on [Add] and enter the name for the new default setting.

■ Click on [Edit name] to change the name of an existing default setting.

■ Click on [Delete] to delete an existing default setting.

■ Click on [Duplicate] to create a copy of an existing default setting. The duplicate is given
a corresponding suffix.

■ Select Default  (set check mark) if you would like each new job to use this default setting
definition.

7.1.2.1 Setup
The workspace configuration is defined in this tab.

Application cases
■ If you are using several control cards and therefore also several scan fields.

■ If you want to limit the usable workspace relative to the available scan field.

■ If you want to enlarge the workspace beyond the scan field for MOTF applications.
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Appearance in the viewport

The defined workspace itself can be made clearly visible by activating the grid line display.
Brighter areas also indicate areas that can in principle be reached by the deflection units,
especially if the selected multiple field mode is taken into account.

Fig. 7.3: RG-ABA
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Setting Explanation

Deflection units

Multi field mode If more than one control card is connected, the controlled deflection units and
their scan fields can interact in a variety of ways.

Individual fields: The different scan fields do not overlap. Use this option if you
want to execute the same job on multiple deflection units in parallel.
Select all SP-ICE-3 control cards to be used for this scenario.

NOTE: The field offset is not applicable in this mode and is ignored by the
software.

Unified field: All scan fields are used together to cover a combined workspace
where layout objects can be positioned.

NOTES:
■ If a graphic object fits completely within the intersection area of the scan

fields, it is automatically processed by the control card listed first. This
automatic behaviour can be changed in the dialog for the object settings. For
this purpose, select the Manual option and then the desired control card.

■ If a layout object extends over several scan fields, it must be split so that each
deflection unit can process its accessible part. RAYGUIDE splits the layout
object according to the rules listed below and taking into account the
Boundary overlap value.

Depending on the boundary overlap, two cases can be distinguished:

1. Boundary overlap = 0 [mm]

2. Boundary overlap ≠ 0 [mm]
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Setting Explanation

Case a) Boundary overlap= 0 [mm]

If the value of the boundary overlap = 0 [mm], all paths are split where
necessary so that as few separation points as possible are created.

Example:

Complete layout

Tiled part for left field Tiled part for right field
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Setting Explanation

Case b): Boundary overlap ≠ 0 [mm]

If the value of the boundary overlap ≠ 0, the required paths are split in the
middle of the field intersection area, and half of the boundary overlap value
extends the vectors for each scanner to the other side of the field. In this way,
the paths from both sides have a defined intersecting area, which prevents the
line ends from being connected at points.

Example:

field intersection area

field #1

RAYGUIDE split line

boundery overlap

field #2

Overlap
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Setting Explanation

Intersection field: Use this option if only the area in which all scan fields overlap
is to be used to define the available workspace in which the layout objects are
to be positioned.

NOTE: To divide the processing load among all the control cards involved, you
must manually assign each graphic object to one of the control cards. Therefore
open the object settings dialog, select Manual and select the respective control
card. All objects that are set to Auto are always processed by the control card
listed first.

Home position Select if the deflection unit should "jump" to a specific position at the end of all
job elements.

The choices are:

■ None

■ Defined position: Specify the coordinates in the list per control card.

■ Start position of the job: Position where the first marking path starts.

BoundingBox Shows the dimensions of the shared field areas or, for 3D correction files, the
shared volume.

Boundery overlap In "Unified field" multiple field mode, on the one hand, defines where paths
are split, and on the other hand, how far they are marked as overlapping on
both sides in [mm].

Correction file index Define the index of the correction file that is to be active when the execution of
the job begins.

NOTE: The option is only usable if at least one deflection unit has been assigned
two correction files in the configuration. See page 73, General.

List control cards The table shows the connected control cards. Check the ones to be used in this
configuration.

Use the offset to define how the individual scan fields are actually positioned to
each other. When using correction files with a z-range, the offset of the zero
layer is displayed in the column for the z-values. The figure next to it shows you
the result.

If necessary, enter the desired coordinates for the end position per control card.
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Setting Explanation

Workspace

Defines the size and position of the workspace in relation to the scan field. Typically, the workspace size
matches the deflection unit's field size. However, there may be special cases, such as the following:

Use case 1: A smaller workspace size will limit the area of operation. This can be necessary, for example,
because machine parts reach into the scan field area that are not hit by the laser beam. However, this may
result in a warning when the layout exceeds the defined workspace.

Use case 2: Visualize a part of the virtual field for MOTF applications so the user can position the layout
objects accordingly. In this case, the workspace size may well exceed the size of the scan field.

Use matching size Set the tab to force that the workspace size matches the scan field size.

Uncheck the tab if you want to edit the workspace and / or offset it.

Size Desired workspace size in X-Y-Z dimensions in [mm].

Field offset Define an offset to manually arrange the workspace in relation to the scan fields
or click [Align] to use one of the predefined layouts.

Properties

Background Option for inserting an image as a background picture in the workspace.

Valid formats are: JPG, JPEG, BMP, PNG, GIF, EXIF.

Select:

■ Embed if the image is to be saved as part of the job.

■ Link if you only want to link the image file to the job locally.

NOTE: The image is scaled to the size of the workspace in both dimensions.

NOTE: The opacity of the background image can be set using the opacity slider,
which is part of the toolbar. See page 24, Toolbar.

Number of executions Specify the job repetitions for jobs with this preset.

Repeat Activate the option if jobs with this preset are to be executed in an endless loop.

Table. 7.1: RG-019
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7.1.2.2 MOTF

Setting Explanation

Enable Mark-On-The-Fly For explanations and settings for Mark-On-the-Fly (MOTF), see page 314, MOTF
Jobs.

Start trigger

Distance

Repeat trigger

Execution pitch [mm]

Table. 7.2: RG-072

7.1.2.3 Optimizations
On the following tab, you can define a selection of optimizations that are performed by
RAYGUIDE in the background and before actual execution on the control card.

Fig. 7.4: RG-AFA
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Setting Explanation

General

Merge vector graphics Merges all vector graphics to one graphic object.

When merging, the following rules must be observed: If objects vary in their
main settings (such as sequences or binning), they are not merged. If
automation objects are placed in the job tree between vector objects, the
collection of the objects to be merged is terminated.

RECOMMENDATION: Use this option if your job encompasses multiple objects
that are not sorted in the process order and the job with the MOTF condition is
to be executed since the “Sort by direction” option sorts the paths per individual
object and layer.

Join layers Activate this option if, for example, you want to ensure that concatenated paths
are merged in advance.

RECOMMENDATION: Use this option if your job encompasses objects with
multiple layers and the job with the MOTF condition is to be executed since the
“Sort by direction” option sorts the paths per individual object and layer.
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Setting Explanation

Workload balance This option is relevant for jobs that use a workspace consisting of several scan
fields.

With this option, all paths (contour paths such as paths of fillings) are
automatically assigned to the control cards so that all participating control cards
and their deflection units are utilized as equally as possible. This can lead to
significant savings in process time.

The extent of this saving depends on the number and processing time of the
paths that could in principle be traveled by more than one deflection unit (i.e.
paths that lie completely in the overlap area).

Example:

Mark-On-The-Fly

Segmentation mode See page 322, MOTF Optimizations.

Max. Width [mm]

Time [s]
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Setting Explanation

Sort

Minimize jump distance Activate this option to ensure that concatenated paths are merged and jumps
are re-sorted to avoid superfluous jumps.

By direction See page 322, MOTF Optimizations.

Replace all commands by drill holes

If this option is activated, contour lines are automatically replaced with drill holes when the job is executed.

The following fields are then available for required specifications.

Spacing [mm] For details, see page 232, Related settings

Force corners

Drill mode

Pulse / Time

Table. 7.3: RG-073
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7.2 Job Content Creation

7.2.1 Graphic job design
A graphic design, defined for a laser process is always part of a specific job.

All created or imported layouts elements are displayed in the viewport by contour lines.
Bitmaps are displayed as gray scale images. Drill dots are represented by small crosses.

Each layout element is also listed in the job tree on the Jobs panel.

7.2.1.1 Objects Overview
Graphic elements which make up the processing geometry are called objects.

For a detailed description of the graphic elements, refer to page 140, Basic Marking Objects
and page 141, Extended Marking Objects.

Essential types of graphic objects:

■ Vector graphic: Geometric object made of lines. Examples: Circle, polygon.

Pre-formed vector objects (as available in the object toolbar) are described by
mathematical properties (e. g. diameter).

Free-shaped vector objects (often imported from a graphics file) are made of layers,
paths, path elements, and the vector coordinates.

Text and code objects are also made of vectors defined by the actual text / code content.

■ Drill points: A single laser emission point or a free grid of laser emission points.

■ Bitmaps: A raster image that is processed as a line of image points (pixels), where the pixel
intensity generates the image contrast.

■ Helix: A three-dimensional spiral spring for deep hole cutting.

■ 3D model: Surface model of a 3D body whose volume is to be engraved into the material.

■ Graphic content of a SP-ICE-3 log file.

Besides graphic objects, the following special object types are available:

■ Automation objects – see page 252, Automation Objects.

■ Containers – see page 291, Containers.

NOTE on buttons:
After RAYGUIDE is installed, the buttons are not displayed for all objects by default. The
required buttons can be added or deselected at any time in the View > Objects menu.
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7.2.1.2 Job Panel
This panel provides an overview of the major job settings. To open the settings dialog directly
from the current job, simply doubleclick in this area.

Below the Job overview, the assigned control cards are shown.

For each control card, icons are used to display the devices connected to the control card in
line with the configuration (e.g. deflection unit, laser, camera, etc., RAYDIME METER).

Fig. 7.5: RG-AGL
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The color of the icons also provides information about the status, which is also noted in the
tooltip:

Control card Deflection unit Laser Camera RAYDIME METER

Not connected (no
answer)

Not connected (no
answer)

Not connected (no
answer)

Not connected (no
answer)

Not connected (no
answer)

- -

Status information
not possible 4

- -

-

Connection lost Not ready / 
Off status 5

-

Connected, 
but measuring laser 

not active

Stand-alone
operation

Error condition
monitoring

- - -

- -

Emission status 5

- -

Ready for use Ready for use Ready for use Ready for use Ready for use

Connected, but not
initialized

Device error 
(status)

Laser alarm 
(not all lasers)

- -

Table. 7.4: RG-107

4 Only exception: nLight Laser.

5 Only applies for nLight laser.
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Job tree and its controls

All objects which are part of a job are listed in the job tree on the Job panel. The default
order is the sequence in which they have been added.

Setting Explanation

Tree controls

Use the buttons for [Expand] / [Collapse] to expand or collapse all freely
shaped marking objects in a single step across all Hierarchy levels.

Use the [Up] / [Down] arrow keys to navigate step-by-step through the job
elements and their individual thumbs.

NOTE: Collapsed hierarchy elements are automatically expanded.

Instead, use the up / down arrow keys of the keyboard if you only want to scroll,
step-by-step, in the currently expanded hierarchy of the tree.

Use the [Hide / Unhide all] buttons to hide / show all current graphic objects in
the viewport.

This option has priority over the single object settings.

Use the [Lock / Unlock all] buttons to lock all current graphic objects in the
viewport against mouse modifications in the viewport.

This option has priority over the single object settings.

NOTE: Locked objects are always displayed with less intensity.

Use the [Reverse order] button to reverse the order of all current job
elements.

Table. 7.5: RG-069

To re-arrange the order of the objects according to process requirements, use the mouse to
pull the objects to the desired position in the tree. Multi-selection is possible.

Free-shaped vector objects are always structured in the hierarchy (object > layer > path > path
element). They can be expanded or collapsed by using the arrow symbols left of the object
names.

Each single layout object listed in the job tree also provides single action buttons again to
hide / show and lock / unlock the object in the viewport.
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Object tooltip

For a better overview, a tooltip that shows some information about the object is displayed
when the mouse is hovered over the object.

Example 1

Fig. 7.6: RG-AFK

Example 2

Fig. 7.7: RG-AFL

Example 3

Fig. 7.8: RG-AFM
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7.2.1.3 Objects Panel
The objects panel (like the equivalent Objects menu) offers buttons to add objects to the job
content or draw markable objects.

The panel is divided into 4 sections separated by a red line at the top border of its section.
The appearance of the panel can be rearranged in various ways:

■ A double-click on the red line collapses or expands the section.

■ The order of the sections can be rearranged. To do this, drag the red line of a section to
another red line.

■ The buttons within each section can also be rearranged with the mouse.

7.2.1.3.1 Adding an object from the panel
■ Click on an object button. The Properties dialog of the respective object then opens. It

contains tabs for settings, pens, fillings and statistics (if available).

When the settings are made, click on the [Apply] button.

The object is created and shown in the job tree and in the viewport (in the center of the
workspace if no offset has been defined).

■ A right click on the triangle corner opens the action menu. To add an object, select
Create, and the object properties dialog also opens.

When the settings are made, click on the [Apply] button.

The object is created and shown in the job tree and in the viewport (in the center of the
workspace if no offset has been defined).

■ With the left mouse button pressed, drag and drop the object into the viewport. The
object appears at the workspace position where it was dropped. In the job tree, the object
is inserted after the last existing object.

■ With the left mouse button pressed, drag and drop the object into the job tree. This way,
the object is inserted in the targeted position in the job tree. In the viewport, the object is
positioned in the center of the workspace if no standard object of this object with offset
has been defined.

NOTE: When a layout object was saved as a default template (see page 261, Templates) the
settings of a newly added layout object will match the template. In addition, fillings and
transformations may be predefined in a template.
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7.2.1.3.2 Draw an Object from the Panel
The small triangle corner indicates all markable objects that can be added or drawn:

Fig. 7.9: RG-ADI

Click on the corner and select Draw if you want to draw the object with the mouse cursor.

Drawing of objects

Line Define the start and end points of the line by clicking on the corresponding
positions in the viewport.

NOTE: If you want to draw a line chain, use the drawing mode of the vector
graphic.

Rectangle Define the first and second (diagonal) corners of the rectangle by clicking on the
corresponding positions.

Press [Ctrl] to fix the X/Y ratio.

When drawing, the general default settings of the object are still used (see
object-related settings).

Circle, Ellipse Define the first and second (diagonal) corners of the object bounding box by
clicking on the corresponding positions.

Press [Ctrl] to fix the X/Y ratio.

Polygon, Spiral, Content,
Code

Define the first and second (diagonal) corners of the object bounding box by
clicking on the corresponding positions.

Press [Ctrl] to fix the X/Y ratio.

When drawing, the general default settings of the object are still used (see
object-specific settings).
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Drawing of objects

Vector graphic, SP‑ICE-3
protocol

First, define the start position of a path by clicking on the corresponding
positions (a single blue point appears). Right-click on the point to open the
context menu for drawing paths:

The path can now be compiled using basic graphic commands: Line, circular arc,
elliptical arc, quadratic curve and cubic curve.

Keep [Ctrl] pressed as long as you want a chain of the same graphic commands.

Keep [Shift] pressed to draw vertically / horizontally only.

RULE: Each new graphic command is always appended at the end of the path.

Table. 7.6: RG-067

7.2.1.4 Object Properties Dialog
To open an object settings dialog:

■ Double-click the object in the job tree or in the viewport.

■ Right-click the object and select [Properties] from the context menu.

■ Select the object and press [F5].
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The figure shows the object panel on the left, the workspace with an ellipsoidal object with
its outer enclosing rectangle (red), and the [Properties] dialog of the ellipsoid:

Fig. 7.10: ABI
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The object settings dialog provides the following tabs:

■ Properties 
For further information, refer to the following sections of this manual in the appropriate
chapter for the respective object type.

■ Pens
For details, see page 271, Pen Properties.

NOTE: This tab can be or become hidden if necessary. For details, see page 101, Visibility.

■ Fillings (optional)
Layout objects that contain closed contours / paths can also fill these areas with a line
patterns, so-called fillings.
For more information on fillings, seepage 188, Object Fillings.

Transformations

Every layout object carries transformation information:

■ The offset of the object and therefore the position of the object center with respect to the
workspace origin.

■ The size and scale factor of the object (scaling change per click) and thus the ratio with
respect to the original size (after adding or importing a layout object).

■ The angle of the object coordinate system in regard to the workspace coordinate system.

For more information on transformations, see page 201, Object Transformation.

7.2.1.5 Object Statistics Tab
On this tab, you can display the object-related statistics. Detailed information on the provided
values is explained on page 311, Job Statistics.

7.2.1.6 Vector List Panel
To open the Vector list panel, click the corresponding tab next to the job panel.

The Vector list panel shows the absolute coordinates of paths plus the end coordinate of each
path element of the currently selected object.

Coordinates are rounded to one decimal digit. Bitmaps provide no vector information.
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7.2.2 Basic Marking Objects

Basic objects and their essential settings

Simple objects in the arrangement are pre-formed vector objects that can be displayed and
edited using a single graphic command.

Object type / Button in
panel

Essentially defined by (mathematic properties)

Line Length [mm]

Rectangle Width, height [mm], Corner radius [mm] (for rounded corners)

Polygon Type (regular or star shaped), Radius outer circle [mm], Corner radius [mm] (for
rounded corners), number of edges

Circle Radius [mm]

Ellipse Radius [mm], Ratio, Orientation

Table. 7.7: RG-023

Additional settings

Additional settings include:

■ For general settings for all marking objects; see page 181, Common Properties of Marking
Objects.

■ For transformations, see page 201, Object Transformation.
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7.2.3 Extended Marking Objects
Compared to simple objects, more and specific settings can be made for complex marking
objects.

■ Spiral (see page 142, Spiral)

■ Bore holes (see page 144, Drill)

■ Text (see page 145, Text)

■ Barcodes (see page 151, Barcode)

■ Vector graphics (see page 156, Vector Graphic)

■ Bitmaps (see page 174, Bitmap)
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7.2.3.1 Spiral

Button

The spiral in its regular form corresponds mathematically to the Archimedean spiral. To allow
for greater flexibility in other applications, the rectangular spiral provides more leeway for
defining the shape of the spiral.

Essential settings:

Setting Description

Shape Select the shape of the spiral:

■ Regular or

■ Rectangular

Specific settings for regular spiral

Radius [mm] Enter the radius up to which the spiral extends.

Chord length [mm] The Chord length [mm] is used to define the length of the line segments and
therefore how sharply or gently a spiral is rounded.

Start angle [°] Specify the angle relative to the X-axis at which the spiral starts on the inside.

Inner radius [mm] Specify here if the spiral does not extend inwards to the center point, but should
start or end on an inner circle.

Specific settings for rectangular spiral

Span (X|Y) [mm] Define here the length of the straight lines of the rectangular spiral in the X and
Y directions in [mm].

Turns Specify the number of spiral windings.

First turn If you set this value to ≠0, the spiral shape will only be drawn after the nth
winding (viewed from the inside out).

Fixed radius + [%] Define whether you always want the same corner radius regardless of the pitch
to the span.

By default, the radius is 50% of the pitch, but it can also be smaller. A sharp
corner is created at 0%.

The value for the span only applies to the first winding (inside) and increases
towards the outside.

NOTE: If this option is not selected, but one side of the rectangle is shorter than
the span you defined, a fixed corner radius may still be applied (viewed toward
the inside).

Pitch Parallel distance in [mm] between the windings.

Turn direction Specify whether the spiral rotates clockwise or counterclockwise.

Feed direction Specify whether the spiral is traveled from the inside out or from the outside in.

Table. 7.8: RG-118
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Examples for spirals

Regular spiral

■ Constructed as a polyline

“Rectangular” spiral

■ Consisting only of circular arcs

■ With a value of zero for both spans

“Rectangular” spiral

■ With value zero for a span, 
i.e. increasing radii

“Rectangular” spiral

■ With two values for the span, 
which is why a fixed radius is applied to the inside

“Rectangular” spiral

■ With value zero for a span, 
i.e. increasing radii

■ And initial winding = 4

“Rectangular” spiral

■ With a value of zero for one span

■ And the “fixed radius” option

Table. 7.9: RG-119
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7.2.3.2 Drill

 
Button

A drill object is used to apply the laser beam to one or more points on the material, for
example, to drill a hole or mark a dot / dot array.

Essential settings

Setting Description

Drill

Mode Pulse: The dwell time per drill point is defined on the basis of the number of
pulses and the frequency defined in the pen and the resulting pulse period.

Time: The dwell duration per drill point is defined directly as the target value.

Pulses / Time Number of laser pulses or duration [ms]

Import

A table of X-Y coordinates can be imported (CSV, TXT), defining a drill pattern. Click on the [Import]
button to select a file. The [Reset] button dismisses the pattern and returns to a single drill point mode.

NOTE: The first line of the import file must already contain coordinates (no text / headlines).

If you aim for a pattern with regular distances in both X and Y directions, you may integrate the drill object
in a matrix copy container. See page 291, Containers.

Unit Unit to be applied to the coordinates being imported.

Table. 7.10: RG-024

Additional settings

Additional settings include:

■ For general settings for all marking objects; see page 181, Common Properties of Marking
Objects.

■ For transformations, see page 201, Object Transformation.
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7.2.3.3 Text

Button

A text object adds text, numbers, and date / time items to your job.

Essential settings

Fig. 7.11: RG-ADU
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Setting Description

Text style icons

Use the well-known buttons to define a bold, italic, underlined text style.

NOTE: The underlined style is not available for circular text. Each style will
always apply to the entire text content.

Multiline adjustment icons

Use the well-known buttons to define whether multi-line text is left-, center- or
right-aligned.

Process direction icons

Use the buttons to define whether all text lines are processed from left to right,
from right to left or in both directions.

Textsetting icon

Use the button to actively prevent font-specific ligatures as well as undercuts.

Example ligature: Example undercut:

Font

Type True Type fonts are defined by a contour. All True Type fonts installed on the PC
are available.

The line fonts are provided internally by RAYGUIDE.

Font name Select the font to be applied.

Font height [mm] The value defines the height of the font based on the upper case character "M".
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Setting Description

Orientation Defines the layout of the text characters:

■ Horizontal: The characters are arranged next to each other (= default
setting).

■ Stacked: The characters are arranged one below the other.

■ Convex: The characters are arranged on the outside of a circular path.

■ Concave: The characters are arranged on the inside of a circular path.
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Setting Description

Radius [mm] Specification of the radius in [mm] for concave / convex text layout.

Fixed size [mm] Specify a fixed frame size into which the text content must fit, independent of
the number of characters and text size.

NOTE: If you only want to fix the text length, but the text height should be a
function of the font height, enter the fixed text length as an X value for the
frame and “zero" for the Y value.

NOTE: This option can only be used with horizontally arranged text.

Fixed angle [°] Specify a fixed angle in which the radially arranged text content should fit,
regardless of the number of characters.

NOTE: This option can only be used with concave or convex text.

Attachment point Click on one of the fixation points:

■ Left / Center / Right point: The text is enlarged from this point.

■ Upper / Basic / Lower point: The text is fixed for all character heights on this
line.

If the text varies in length, its fixation point is also adjusted.

Character spacing [%] Spacing of characters in percent. Values greater than 100% increase the spacing
predefined by the font, values less than 100% decrease the spacing.

Data

Source Select a source for the text:

String: Use the text as entered from the text field below.

File: Text from a source file. In the file, the text can run over one line or over
multiple lines. Multiple lines are used with the following settings:

■ Start: The number of the line in the source file to start with.

■ Increment: Delta of lines after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ File: To select the data source file (TXT, CSV format)

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute] > Resets the iteration value every time a job is executed.

– Load > Resets the iteration value whenever a job is loaded.

■ “Wrap around” checkbox: Enable this checkbox if you want to continue with
the first line of the source file when the end of the source file is reached.

■ “Cache” checkbox: This tab is set by default, as RAYGUIDE usually caches the
content of the source file in the working memory. 
Disable the tab if you want to edit the content of the source file during
runtime.
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Setting Description

Date: Select one of various date format presets. Custom and sortable formats
can be manually edited in the Format field.

Increment: Creates a number that will be incremented as follows.

■ Start: Number to start with.

■ Increment: Delta in counter after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ Digits: How many leading zeros are added to the number.

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute]: Resets the iteration value every time a job is executed.

– Load: Resets the iteration value whenever a job is loaded.

Custom: Text-, number characters and date / time items can be combined.

Click on the [Placeholder] drop-down list to display a list with predefined
placeholders for different formats. You may combine them according to your
needs.

In addition, the content of variables can be inserted by means of syntax %
(NameVariable). The content of variables can be assigned via pop-up dialogs
(dynamic – see page 254, Dialog), via the job settings (static – see page 313, Job
variables) or via a text- / code object (dynamic).

NOTES:
■ The assignment of the variable content must be done in the job sequence

before the variable is inserted.

■ The variable name is case sensitive.

■ The variable and its content are also listed on the Variables tab of the job
properties (see page 313, Job variables).

Optional fields in case the custom string contains an incrementing number:

■ Start: Number to start with.

■ Increment: Delta in counter after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ Digits: How many leading zeros are added to the number.

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute] > Resets the iteration value every time a job is executed.

– Load > Resets the iteration value whenever a job is loaded.

NOTE: The date separator character corresponds to the local format in the
operating system.
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Setting Description

Content Field for the definition of content. For dynamic data sources, the placeholders or
even date formats are displayed here.

NOTE: The size of the text field in the dialog can be adjusted. Click on the black
triangle in the lower right corner and drag it using the mouse until it reaches
the desired size. Otherwise, the text will wrap automatically.

Add character Click on the label and a dialog opens to select special characters that are not
part of the regular alphabet.

Log Available option if the content of the text is variable. You can define a file
(name and location) which then logs all text content that is processed. The
protocol marks each edited content with a timestamp.

Resulting content In this line you see the resulting text that appears after you have pressed the
[Apply] button.

Save content to variable Select if the previously defined content is to be assigned by the text object as
variable content.

In the field next to it, specify the name of the variable.

Table. 7.11: RG-025

NOTE: Variable text content features are not supported when a job is executed at the control
card level.

Additional settings

Additional settings include:

■ For general settings for all marking objects; see page 181, Common Properties of Marking
Objects.

■ For transformations, see page 201, Object Transformation.
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7.2.3.4 Barcode

Button

The barcode is a layout element that encodes content using either a barcode (1D) consisting
of lines of varying thickness, or 2D codes and filled cells.

Essential settings

Setting Description

Barcode

Type List of all available standard code types. The last three code types used are
shown in extra list on top.

The most common 2D codes like Datamatrix, QRCode, MicroPDF, PDF417, as well
as common barcodes like Code 128, Codabar and many more are offered.

Optional code settings: Depending on the selected code type, one or more optional settings are available. A
detailed explanation of their purpose and the available parameters can be found in the code library manual
contained in this PDF.

Some of the generic settings are explained below.

Subset Some codes are grouped to certain types. The specific code is defined here, for
example: Type = Postal > SubType = AustralianPstRouting

See the code library manual for details.

Narrow wide ratio Defines the ratio of narrow gaps / bars to the wide gaps / bars.

The range of values extends from 2 to 3.

NOTE: This parameter is only available for some barcodes.

Bar width reduction [%] Reduces the bar width of all bars by as much in absolute terms as the
percentage drop in relation to the narrowest bar.

The parameter can be used to compensate the laser spot width for very narrow
code bars.

NOTE: This parameter is only available for some barcodes.

Code format Format that is available for some code types.
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Setting Description

Size mode ■ For 2D code types:

Choose if you want to fix the size of the 2D code or the size of a code cell.

■ For 1D code types Code128 and Code\Code39, you can select between:

– Width: 
The code width remains fixed regardless of the content (according to the
value in the Size field). The width of the bars is adjusted accordingly.

– Height: 
The code width remains fixed regardless of the content (according to the
value in the “Size” field). The bar width can remain constant and the code
width varies with the content.

NOTE: Any text displayed in the code content is included in the height
specification.

Module width scaling Specification in [%] by which the modules (bars) can be scaled in width.

NOTE: This value is only available for the two 1D codes that can be defined with
a fixed height.

Cell size [mm] Enter the size of code cells in [mm].

Usable only for 2D codes

Size Enter the size of the complete code in [mm].

For other codes than 2D, the size value refers to the X-dimension.

Invert Inverts the appearance of the code pattern. If inverted, it is recommended to
define the “Quiet zone” as well to have a black frame surrounding the code
pattern. Useful when marking on a dark material.

Quiet zone [cells] An area free of any printing or marks that precedes the start character of a
barcode and follows the stop character of the barcode.

See the code library manual for details.

Translate escape
sequences

Check this box if you want to use non-printable or special characters in a
barcode preceded by an escape sequence, e.g. a backslash. Specifying the values
for the ASCII characters primarily in HEX format and not in decimal format is
recommended.

Some typical examples are:

■ GS (Group Separator) = \x1d

■ RS (Record Separator) = \x1e

■ EOT (End of Transmission) = \x4
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Setting Description

Show text This option is only available for 1D barcodes.

Deselect this option if the code is to be created without the readable text.
Otherwise, it will be included with the 1D barcode by default.

Data

Source Select a source for the text.

String: Use the text as entered from the text field below.

File: Text from a source file. In the file, the text can run over one line or over
multiple lines. Multiple lines are used with the following settings:

■ Start: The number of the line in the source file to start with.

■ Increment: Delta of lines after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ File: To select the data source file (TXT, CSV format)

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute] > Resets the iteration value every time a job is executed.

– Load > Resets the iteration value whenever a job is loaded.

■ “Wrap around” checkbox: Enable this checkbox if you want to continue with
the first line of the source file when the end of the source file is reached.

■ “Cache” checkbox: This tab is set by default, as RAYGUIDE usually caches the
content of the source file in the working memory. 
Disable the tab if you want to edit the content of the source file during
runtime.

Date: Select one of various date format presets. Custom and sortable formats
can be manually edited in the Format field.

Increment: Creates a number that will be incremented as follows.

■ Start: Number to start with.

■ Increment: Delta in counter after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ Digits: How many leading zeros are added to the number.

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute]: Resets the iteration value every time a job is executed.

– Load: Resets the iteration value whenever a job is loaded.

Custom: Text, number characters and date / time items can be combined. 
Click the [Placeholder] drop-down list to display a list with predefined
placeholders for several formats. You may combine them according to your
needs.
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Setting Description

In addition, the content of variables can be inserted by means of syntax %
(NameVariable). The content of variables can be assigned via pop-up dialogs
(dynamic – see page 254, Dialog), via the job settings (static – page 313, Job
variables) or via a text- / code object (dynamic).

NOTES on variables:
■ The assignment of the variable content must be done in the job sequence

before the variable is inserted.

■ The variable name is case sensitive.

■ The variable and its content are also listed on the Variables tab of the job
properties (see page 313, Job variables).

Optional fields in case the custom string contains an incrementing number:

■ Start: Number to start with.

■ Increment: Delta in counter after the batch has been processed.

■ Batch: The increment is only applied after n executions.

■ Digits: How many leading zeros are added to the number.

■ Current iteration: Displays the current increment status.

■ Auto reset:

– Never

– [Execute] > Resets the iteration value every time a job is executed.

– Load > Resets the iteration value whenever a job is loaded.

NOTE: The date separator character corresponds to the local format in the
operating system.
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Setting Description

Content Field for the definition of content. For dynamic data sources, the placeholders or
even date formats are displayed here.

NOTE: The size of the text field in the dialog can be adjusted. Click on the black
triangle in the lower right corner and drag it using the mouse until it reaches
the desired size. Otherwise, the text will wrap automatically.

Add character Click on the label and a dialog opens to select special characters that are not
part of the regular alphabet.

Resulting content In this line you see the resulting code content that appears after you have
pressed the [Apply] button.

Head Protocol Available option if the content of the text is variable. You can define a file
(name and location) which then logs all text content that is processed. The
protocol marks each edited content with a timestamp.

Save content to variable Select if the previously defined content is to be assigned by the text object as
variable content.

In the field next to it, specify the name of the variable.

Statistics Characters = Displays the number of characters from the defined content, as the
code size depends on it.

Cells = Displays the number of cells per code row / column (available only for 2D
codes)

Table. 7.12: RG-026

NOTE: Variable code content features are not supported when a job is executed at the
control card level.

Additional settings

Additional settings include:

■ For general settings for all marking objects; see page 181, Common Properties of Marking
Objects.

■ For transformations, see page 201, Object Transformation.
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7.2.3.5 Vector Graphic

Button

A vector graphic consists of a collection of geometric figures such as lines, polylines, Bezier
curves, circles and ellipses, which can be mathematically described. Some vector graphics can
also contain text elements.

Structure of vector graphics

A vector graphic always has a hierarchical structure:

Object> Layer > path> path element

A layer is a group of paths; a path is a chain of path elements. Path elements consist of
graphic commands or action commands. A graphic command is a mathematically described
geometric figure.

This manual refers to layers, paths, and graphic commands as (graphic) elements.

Fig. 7.12: RG-ADA
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■ layer : All graphics content is contained in one or more layers. A layer contains one or
more paths. Its geometry level entry also displays the count of its paths.

■ text layer: Represents a special form of the "Layer" hierarchy, since this layer does not
consist of the classic paths, but of a text element. The text element has all the properties
described in page 145, Text, but is an integral part of the vector graphic. This type of layer
is mostly used when importing corresponding graphic files.

■ Path: A path is a continuous line or contour (straight and / or curved) that can be processed
with continuous laser emission. A path can be open (start and end point are not identical)
or closed. All path segments are described by commands.

■ Path element: A path element is either a geometrical object (graphic command, described
mathematically) or a process-related instruction (action command).

There are 5 graphic commands and 2 action commands.

Path elements

Graphic commands

Polyline A straight line or combination of straight lines defined by vector coordinates.

Circular arc A segment of a circle defined by an angle and the center point.

Ellipse A curve surrounding two focal points.

Quadratic curves A parabola that is the graph of a quadratic function.

Cubic curve A curve described by cubic equations.

Action commands (control the laser behavior in a path)

Laser on Switches the laser on for a defined amount of time. Similar to a drill object.

Change pen Selects another pen to switch to different process parameters.

Table. 7.13: RG-091
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NOTE: The start point coordinate of each graphic command is either the coordinate of the
path geometry level (if first graphic command) or the end point of the previous graphic
command. In the dialog for the properties of the graphic command, however, the “start point
coordinate” is also displayed as read-only information.

NOTE: Some graphic commands also display information like length or radius.

For each type of hierarchical graphic element, a settings dialog is used to define the element
properties. Double-click an element or choose Properties from its context menu.

The following table explains all available settings for layers.

Setting Explanation

Tree Icon
 Common layer

 text layer

Index When adding layers: Number of the layer within an object

Name Optional name of a layer

Sequences The sequence “inherits” the layer from the object structure level. The process
runs defined in the sequence cannot be changed in the layers-structure level,
but the pens used can be changed if necessary.

Mark Selection indicating whether this layer is to be executed with all its paths or not.

NOTE: If you merge multiple layers with different settings, you obtain 2 layers:
One layer that contains all paths to be marked, and one that contains all paths
that are not to be marked.

Tab Fillings

The layer itself can be filled with the default fill options.

NOTE: Only closed areas of paths are considered by the fill routine.

NOTE: When you are processing a layer, you are in the processing mode. This means that the filling will not
be visible until you leave the processing mode. The layers symbol is now grayed out.

Table. 7.14: RG-027
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The following table explains all settings for paths.

Setting Explanation

Tree Icon
 For closed paths

 For open paths

Index When adding paths: Ordinal number of the path within a layer

Sequences The sequence “inherits” the path from the object structure level. The process
runs defined in the sequence cannot be changed in the path structure level, but
the pens used can be changed if necessary.

Location Coordinates of the start point of the path

Tab Fillings

A closed path itself can be filled with the standard fill options.

Open paths can either use the inset fill with a counted number of contour lines or the filling ends at virtual
closing lines.

NOTE: The path filling routine does not consider closed areas that arise in combination with other paths.

NOTE: When you are processing a path, you are in the processing mode. This means that the filling will not
be visible until you leave the processing mode. The path symbol is now grayed out.

Table. 7.15: RG-028
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For graphic commands, the settings depend on the respective graphic command type. The
following table explains the settings for graphic commands.

Setting Explanation

Polyline

Adds a coordinate point before or after the actual coordinate point graphic
command.

Removes a point with or without closing the gap by connecting the next nearest
points.

Moves a point up and down in the sequence of the points.

Splits the graphic command in two polylines before the marked point.

Arc

Angle [°] Angle in degrees. Positive values turn anti-clockwise, negative values turn
clockwise.

Center [mm] Coordinates of the virtual center point of the arc.

The radius results from the distance between start and center.

Ellipse

Sweep angle [°] The angle the contour will cover.

Orientation angle [°] The angle of the longer side axis in relation to the coordinate system of the
object.

Axes ratio Ratio of the longer axis to the shorter axis.

Center [mm] Coordinate of the center point.

Quadratic curve

Control point [mm] Coordinates to define the point positions.

This curve is defined using one control point.End point [mm]

Cubic curve

Control point 1 [mm] Coordinates to define the point positions.

This curve is defined using two control points.Control point 2 [mm]

End point [mm]
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Setting Explanation

Laser on

Same concept as with a drill object. The laser turns on for a defined amount of time. The coordinate is
either the coordinate of the path geometry level (if first graphic command) or the end point of the previous
graphic command.

Mode Select Pulse to enter the number of laser pulses to apply at this point.

Select Time to enter the duration of laser application at this point.

Pulses or Time Number of pulses or time in µs

Set pen

Pen number Pen (from the base pen set of the job) to be used for the succeeding graphic
commands. Use the [Edit] button to edit the pen settings.

Table. 7.16: RG-029

You can add any hierarchy element by using the context menu of the higher-level hierarchy
element. For example, use the context menu of a layer to add a new path.

Import, conversion or creation of vector graphics

In most cases, the vector graphic is generated in a CAD or design program and imported into
the workspace from a file.

To add a vector graphic to the job by importing it, you have the following options to choose
from in the corresponding import dialog:

■ Click on [Vector graphic] in the object panel.

■ Main menu: File > Import > Vector graphic
■ Main menu: Objects > Vector graphic, and then double-click on the corresponding entry

in the job tree.

■ Drag the mouse from the [Vector graphic] button in the object panel (holding down the
left mouse button) to the desired position in the job tree and then double-click the
corresponding entry.
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Alternatively, you can also drag the vector file(s) directly from the Explorer folder into the
viewport. In this case, the import dialog is skipped for the time being, as the default settings
for the import are applied.

The subsequent import dialog for vector graphics makes the following settings available:

Fig. 7.13: RG-ADS

Setting Description

Import settings

File Opens a file browser to navigate to the graphic file you want to import. After
selecting the file, click on [Open] in the browser and the preview displays the
file content.

If files were already imported, these are made available in the drop-down list
for renewed selection.

Supported file formats are: DXF, PLT, SVG, DWG, CGM, HPGL, GBR, CSV 6, TXT 6.

Valid separators are: Space, semicolon and “\\t”.

An empty line acts as a separator between a path and another, subsequent path
in the vector graphic.

Scale to size Activate to scale the size of the imported graphic to the specified size in [mm].

6 NOTE: You can import a contour created as a polyline defined as a coordinate table: X / Y / (Z) / pen
number.



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 163MN_RAYGUIDE [V2.11]

Setting Description

Unit Defines the unit of the imported vectors. This is usually the value = 1 and the
unit in which the layout was created. Select from [mm], [µm] and [inch].

A value ≠ 1 would additionally add a scale factor to it. Only applicable if Scale to
size is not used.

Center XY Incorporates the vector graphic centered on the XY axes of the workspace.

Align Z [mm] Specification of the Z position in [mm], according to which either the upper side,
center position or underside of the 3D vector graphic file aligns itself when
importing.

Import hidden elements Some file formats (e.g. DXF) can contain layers marked as hidden. These layers
are ignored during import by default. Use this option if you want to import
them anyway.

Mirror direction Activate the toggle buttons for the X / Y / Z direction if the vector graphic is to
be mirrored accordingly when imported.

Overwrite pens Overwrites the pens defined for the job (only the color and the dashed line
pattern setting) by the pens defined in the imported file.

Unify colors/pens Assigns the job default pen to all layout elements of the imported graphic. This
unifies all original multiple colors to one color = one pen.

Convert text to vectors If the vector graphics file contains text-based elements, these will be converted
to vector-based layers during import.

If this option is not active, text-based elements are displayed as so-called "text
layers" after import.

NOTE: This option is active by default.

Optimizations

Optimization functions applied in the import process.

Sort vectors Optimizes the vector order to reduce jumps and to get a time-optimized vector
sequence.

Set z-coordinates to zero If the imported graphic contains Z coordinates that are not zero, they will be
reset to zero.

Remove drills Deletes inadvertent drill points from the graphic.

Join layers Merges multiple layers to one layer.

Remove straight points Deletes unnecessary intermediate points from polylines. If points are on a
straight line between the end points, they can be removed. This speeds up the
marking process.

A corresponding tolerance value can be set in the system settings: System >
Preferences > User (current user), Tolerances tab, collinear distance.
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Setting Description

Straight curves by lines Converts graphic elements that are straight into straight line graphic commands.

The corresponding tolerance value that determines how close the curve shape
equals a straight line is defined under System > Preferences > User (current
user), Tolerances tab, collinear distance.

Concatenate similar arcs Combines multiple arcs to one arc if they appear to have the same radius and
the same center coordinate.

To determine whether the center points are the same, a corresponding
tolerance value can be defined: System > Preferences > User (current user),
Tolerances tab, Location.

[Save as default] Button to save the created settings as default settings for future imports of
vector graphics.

Table. 7.17: RG-030

NOTE: Once a vector graphic file has been imported, the object properties only provide the
usual settings: General, bounding box, transformation.

Additional settings

Additional settings include:

■ For general settings for all marking objects, see page 181, Common Properties of Marking
Objects.

■ For transformations, see page 201, Object Transformation.

Additional layers, paths, and path elements can always be added to a vector graphic in
RAYGUIDE – even after import.

It is also possible to convert a pre-shaped vector object into a free-shaped vector graphic:
Open the context menu of an object and select Convert to vector graphic.

Alternatively, you can generate a vector graphic with the following basic steps:

1. Add a new vector object to the job tree with no import file associated to it.

2. Add a new layer to the empty object. (NOTE: The layer must be of type "vector graphic"
to add paths afterwards. If you add a layer of type “text”, its content is determined purely
by the text properties.)

3. Add a new path to an empty layer.

4. Add a new path element to an empty layer.

Another alternative is to “draw” the graphic directly, see page 136, Draw an Object from the
Panel.
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7.2.3.6 Dynamic vector graphic

Button optional, 
see page 130,
Objects Overview

Dynamic vector graphics primarily differ by the kind of usage compared to regular vector
graphics.

Every time the job is reloaded, the graphic is to be automatically imported again from the
referenced source file. Likewise, when job execution is repeated, this graphic can be imported
again from the referenced source file. This enables you to mark graphics that change
dynamically with the changing content of the source file.

In return, the dynamic vector graphic does without the basic structure in the job tree of the
regular vector graphic (object > Layer > path > path element). Modifications to the graphic
can only be made directly during the import using the standard import options. See page 156,
Vector Graphic.

Dynamic vector graphics can only be added to a processing job by importing a corresponding
graphic file.

■ To add a dynamic vector graphic to the job by importing it, you have the following options
to choose from in the corresponding import dialog:

■ Click on the [Dynamic vector graphic] button in the object panel

■ Main menu: File > [Import] > Dynamic vector graphic
■ Main menu: Objects > Dynamic vector graphic, and then double-click on the

corresponding entry in the job tree.

■ Drag the mouse from the [Dynamic vector graphic] button in the object panel (holding
down the left mouse button) to the desired position in the job tree and then double-click
the corresponding entry.

The subsequent import dialog for dynamic vector graphics makes the following settings
available:

Setting Explanation

Import settings

Primarily the same import settings are available to you here that are also available for the regular vector
graphic; see page 156, Vector Graphic.

Automatic reload Select if the vector graphic is to be re-imported from the referenced source file
every time the job execution is repeated.

Optimizations

Optimization functions applied in the import process.

The same optimization functions are available to you here that are also available for the regular vector
graphic, see page 156, Vector Graphic.

Table. 7.18: RG-087
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NOTES on application:

If the changing graphics have slightly different dimensions or positions in the original graphic
file, but should always be marked in the same position and more or less with the same size in
the RAYGUIDE job, it is useful to use the following import settings: Center XY and Scale to
size. An additional object transformation then acts equally on all automatic graphic imports.

If graphics are imported in the sequence that otherwise are partially or completely outside of
the workspace, the geometry validation will not be able to catch this. Consequently, there
will also be no marking.

NOTE on job execution types:

The option to reload the graphic on each job execution only works in the “On PC” execution
mode.

Dynamic vector graphics within a copy container

In general, the graphic is reloaded per copy during execution, provided that the container
option Execute as single vector graphic is not selected. The decisive factor here is whether you
manage to exchange the contents of the referenced source file fast enough before marking
of the subsequent copy starts.

NOTE on job file transfer:

Jobs that contain a dynamic vector graphic cannot be easily opened on another PC in
RAYGUIDE, unless the referenced graphic file is also located in the same directory path.
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7.2.3.7 Extruded vector graphic

Button optional, 
see page 130,
Objects Overview

The extruded vector graphic is characterized by the fact that

■ It is repeated in a number of focus positions

■ The start and end position of the paths shifts slightly at each focus position

This procedure is used for deep cutting of glass, for example, to prevent a vertical groove
from forming at the point where the path is cut.

A cone countersink (chamfer) can also be engraved on the upper and lower workpiece
surfaces.

NOTES:
■ The extruded vector graphic can generally contain several paths as well as fillings.

However, the paths and fill lines should always be closed.

■ You can also convert text or any simple marking object (e.g. circle, polygon, rectangle,
ellipse) into an extruded vector graphic (see page 236, More Object-related Operations in
the Context Menu)

Setting Explanation

Import settings

Primarily the same import settings are available to you here that are also available for the regular vector
graphic; see page 156, Vector Graphic.

Optimizations

Primarily the same optimizations are available to you here that are also available for the regular vector
graphic; see page 156, Vector Graphic.

Extrusion

Number of slices Specify the number of focus positions in which the graphic should be executed.

ΔZ [µm] Specify the focus offset per focus position in [µm]. This value is always positive.

Start point offset [mm] Specify by how many [mm] the start/end point of the paths shifts in the
processing direction at each next focus position.

NOTE: Negative values cause a shift in the opposite direction to the processing
direction.

Processing direction Specify whether the focus should change from top to bottom or from bottom to
top per slice.
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Setting Explanation

Top / bottom chamfer

Select whether a chamfer will be engraved on the upper and / or lower workpiece surface.

Count Specify the number of parallel curves.

The number of parallel curves then decreases, for example, from top to bottom
(upper chamfer).

Count x Distance determines the width of the chamfer.

Distance [µm] Enter the distance between the parallel lines in [µm].

Start layer Specify the number of layers by which the chamfer starts offset from the actual
extrusion.

This setting can be used if the actual extrusion extends beyond the surfaces of
the workpiece, but the chamfer starts on the workpiece surface.

Layer count Specify the number of layers over which the parallel curves extend in the Z
direction.

Layer count x ΔZ determines the depth of the chamfer.

Table. 7.19: RG-117
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7.2.3.8 Solid

Button optional, 
see page 130,
Objects Overview

A solid represents a 3-dimensional volume, or its surface. The surface is described using
triangular facets in the STL file format currently in use.

The solids being imported are primarily used for laser processes such as deep engraving, "in-
glass marking" and additive manufacturing. The solid is always divided into horizontal slices
that are processed in a specific order, and are usually also provided with a filling. The focal
position is changed between the filled slice geometries. This requires the use of a
corresponding deflection unit (e.g. RAYLASE FOCUSSHIFTER, AXIALSCAN, AS FIBER) and the
corresponding configuration with a 3‑ dimensional correction file.

To add a solid object to a job, you have the following options:

■ Click on the [Solid] button in the object panel

■ Main menu: File > [Import] > Solid
■ Main menu: Objects >Solid, and then double-click on the corresponding entry in the job

tree.

■ Drag the mouse from the [Solid] button in the object panel (holding down the left mouse
button) to the desired position in the job tree and then double-click the corresponding
entry.

The subsequent import dialog for solid objects makes the following settings available:

Fig. 7.14: RG-AEN
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Setting Explanation

Import settings

File Opens a file browser to navigate to the file of the solid you want to import.
After selecting the file, click [Open] in the browser. The preview displays the
file content.

If files were already imported, these are made available in the drop-down list
for renewed selection.

Supported file formats are: *.STL (stereolithography file)

Scale to size Activate to scale the size of the imported solid to the specified size in [mm]. It is
always the longest edge of the bounding box that is scaled to the value.

Unit Defines the unit of the imported vectors. This is usually the value = 1 and the
unit in which the layout was created. Select from [mm], [µm] and [inch].

A value ≠ 1 would additionally add a scale factor to it. Only applicable if Scale to
size is not used.

Center XY Incorporates the solid object centered in the XY axis view (corresponds to the
view from above) of the workspace.

Align Z [mm] Specification of the Z position in [mm], according to which either the upper side,
center position or underside of the solid aligns itself when importing.

Mirror direction Activate the toggle buttons for the X / Y / Z direction if the solid is to be
mirrored accordingly when imported.

[Save as default] Button to save the created settings as default settings for future imports of body
objects.

NOTE: For solid objects, the standard also contains the settings for the slices.

Table. 7.20: RG-085
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The following settings are available for importing solid objects and can be found in the object
settings:

Setting Explanation

Slices

∆Z [µm] The distance between the slices in [µm]. Depending on the process direction, the
value is specified either from the upper edge or the lower edge of the solid.

First layer offset [µm] The distance between the absolute highest point of the solid and the first slice
shown in the navigator (see page 24, Toolbar).

NOTE: Due to the nature of STL files (triangular facets of the surface), it can
happen that individual points minimally protrude beyond a surface that appears
to be flat. If a slice was displayed here, it would consist of only one point or a
fragment of a slice.

Processing direction Select whether the slice of a solid is to be processed from top-to-bottom (e.g.,
for deep engraving) or from bottom-to-top (e.g., for additive manufacturing).

Negative (mold) Define whether the STL file being imported contains the solid as a negative
form.

This selection determines which areas of the slices are filled, for example for the
engraving process.

Example of an STL file with a negative form for deep engraving:

Number of slices Shows the number of slices resulting from the object height and ∆Z.

NOTE: This display is only available in the object settings, not in the import
dialog.

Table. 7.21: RG-086
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NOTES on the character of the solid:

We recommend, regardless of the laser application, to primarily use solids that do not
represent a negative form.

If negative forms are used, note the following:

The number of slices is not based only on the depth of the negative form, but also on the
total component height. That means empty slices can also occur in the slice navigator.

Special case of a negative form

When the negative form reaches to the edge of the solid.

Example:

Fig. 7.15: RG-AEO

In this case, the outer contour is interrupted in some slices, which would lead to an unusable
filling result when using the regular filling routine. For this reason, the Invert fillings option
must be used in these cases (see page 188, Object Fillings). At the same time, the "Filling
only" marking mode must be used as otherwise the outermost boundary contour for the
filling is executed for all slices.
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Further special case of a negative form

The surface to be engraved is not flat.

Example:

Fig. 7.16: RG-AEP

This type of solid for deep engraving is not supported.

NOTE on solid objects and sequences:

■ In solids, each slice geometry is treated as a Layer hierarchy element.

■ For this reason, the Execution loop assignment option is set to Layer by default.

■ The Alternate contour/filling option is likewise set by default.

NOTE on solid and execution options:

■ The Test run execution option only executes the currently selected slice.

■ The preview likewise only shows the selected slice.

NOTE on solid and statistics:

■ For a solid object, the statistics (regardless of whether object statistics or job statistics) only
show the values for the active slice. In addition, the number of slices based on the height
of the complete solid is indicated.
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7.2.3.9 Bitmap

Button

A bitmap graphic is a two-dimensional array of pixels, representing an image. It is always
imported from a file. The grayscale value of each pixel is either translated into a laser power
value or into the time of laser emission per pixel.

To add a bitmap graphic to the job, it must be imported.

To open the import dialog, you can choose between the following options

■ Click on [Bitmap] in the object panel.

■ Main menu: File > [Import] > Bitmap
■ Main menu: Objects > Bitmap (Bitmap), and then double-click on the corresponding

entry in the job tree.

■ Drag the mouse from the [Bitmap] button in the object panel (holding down the left
mouse button) to the desired position in the job tree and then double-click the
corresponding entry.

Alternatively, you can also drag the bitmap file(s) directly from the Explorer folder into the
viewport. In this case, the import dialog is skipped for the time being, as the default settings
for the import are applied.
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The subsequent import dialog for bitmap graphics makes the following settings available:

Fig. 7.17: RG-AEQ
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Setting Description

Image processing

File [Load file...] opens a file browser to select a bitmap file.

Choose the Insert option to embed the file content into the job file
(important if you want to send the job file to another user).

Choose Link to File to store only the file path in the job file.

Supported file formats are: JPG, BMP, EXIF, GIF, PNG, JPEG.

Mode ■ Sprint: The laser beam moves in lines with continuous speed and emits
one laser pulse per pixel.

The grayscale value of the pixel modulates the laser power, resulting in
the desired degree of contrast.

The grayscale value has a resolution of 16 bit.

APPLICATION NOTE: In Sprint mode, the laser frequency results from
the pixel density (DPI) and the marking speed. The LM frequency named
in the pen is not used.

■ PointAndShoot: The mirror position jumps from pixel to pixel and the
laser beam stays at each pixel for a certain period of time, according to
the grayscale value, in order to reach the desired degree of contrast.

NOTE: "White" pixels are automatically skipped.

Bidirectional Enables alternating marking directions of the bitmap lines.

Scan direction Sets the main processing direction:

■ Horizontal ↑ : Starts at the bottom and goes up row by row.

■ Horizontal ↓ : Starts at the top and goes down row by row.

■ Vertical → : Starts at the left and goes to the right row by row.

■ Vertical ← : Starts at the right and goes to the left row by row.

APPLICATION NOTE: For bitmaps with a vertically orientated rectangle
shape, vertical processing saves more time as it reduces the number of
bitmap lines and therefore the number of line wraps.

Invert pixel Inverts the grayscale value of each pixel.
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Setting Description

Power scale [%] Min/Max Scales the laser power per pixel grayscale value in a linear fashion between
the minimum and maximum power.

Example:

If 80% laser power already results in a completely black pixel, any excess
would probably cause laser burns and cost valuable time. For this reason,
80 should be set as the maximum value in this case. Likewise, a minimum
value may be necessary for the laser effect in order to generate any effect
on the material at all.

[Non-linear power
mapping]

Opens the settings dialog that allows for flexible configuration of the
conversion from intensity to laser power. This makes it possible to react
more flexibly to the color change from material to laser power:

Click on the graph with the mouse to insert a new support point. This will
then also appear in the table.

■ Drag the support point with the mouse for a reassignment of laser
power to intensity, or

■ Use the table to make the assignment very precisely.

NOTES:
■ The upper and lower power limits for the support points are max/min

values of the power range.

■ Any count of support points can be inserted.
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Setting Description

Exposure time [ms] Only relevant for PointAndShoot mode.

Maximum duration [µs] that the laser emits on a pixel. The actual time is
modulated by the grayscale value of the pixel.

Modulation type Time: The grayscale value of the pixel modulates the emission time,
resulting in the desired degree of contrast.

Power: The grayscale value of the pixel modulates the laser power,
resulting in the desired degree of contrast.

Trim scan lines / Threshold Bitmaps are always imported as rectangular objects. However, the lines of
the bitmap do not necessarily begin or end with visible pixels.

Enable this feature to shorten the marking time for the bitmap by
completely omitting pixels which are equal to or exceed the specified
threshold value (255 = White).

Instead of moving to any pixel position in any line regardless of visibility,
the scanners move immediately from the last visible pixel of the current
line to the first visible pixel of the next line.

Size

Resolution [dpi] Sets the pixel resolution in [dpi] (dots-per-inch) for the X and Y directions.
More dots per inch result in a finer resulting image, however, the image
will take more time.

The X-Y ratio can be locked / unlocked with the [Lock / Unlock] button.

Keep size forces the resulting image dimensions to remain at the original
size, regardless of the specified resolution.

Pixels

Pixel distance [mm]

Displays values for the number of pixels in the X-Y direction and the pixel
spacing corresponding to the currently set resolution.

[Save as default] Click on [Save as default] to save the created settings as default settings
for future imports of raster graphics.

Table. 7.22: RG-031
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Additional settings

Additional settings include:

■ For general settings for all marking objects, see page 181, Common Properties of Marking
Objects.

■ For pen settings and details on object-related process parameters, see page 271, Pen
Properties.

NOTE on display: Bitmaps are always displayed in grayscale, with the opacity of the pixels
corresponding to their grayscale value. This makes it possible to see the superimposed
graphics in the same way as they are marked on the material, regardless of their sequence in
the job tree.

Example:

Fig. 7.18: RG-AEL
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7.2.3.10 Helix

Button (optional) 
See page 130,
Objects Overview.

A helix is a 3-dimensional winding circular or elliptical path similar to a spring. This requires
the use of a corresponding deflection unit (e.g. FOCUSSHIFTER, AXIALSCAN, AS FIBER) and
the corresponding configuration with a 3‑dimensional correction file.

Setting Description

Radius [mm] Radius of the circular path (or ellipse main axis) in [mm].

Ratio Ratio of the Y-dimension relative to the X-dimension of an ellipse.

Z-dimension Depending on the sign, the helix goes up or down (negative sign).

Turns Number of windings that are evenly distributed over the Z dimension.

Flat ends Select whether you also want to add a flat winding at the top and bottom
end of the helix (i.e. without a slope). These two extra turns are added to the
specified number of windings.

Turn direction Choose whether the helix rotates clockwise or counterclockwise.

Table. 7.23: RG-108
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7.2.4 Common Properties of Marking Objects
The table shows settings that are similar for all object types. They are included in the settings
dialog of all objects.

Setting Explanation

General

Short label Appropriate name for the object, according to its content / purpose. For
imported files, the file name is used by default.

Enable binning Starts object processing only if a specified condition is fulfilled. The dialog has
been extended to include other inputs:

■ I/O controller: Select the control card where the I/O signals will arrive.

■ I/O port: Select the preconfigured I/O port of the respective control card (see
page 49, Scan Controller Configuration, I/O section).

■ Binning value: Set the bit pattern to be received to process this object.

You can also use the masking technique. For details, see page 49, Scan
Controller Configuration, Port masking section.

■ The “Ahead-of-time evaluation” option is set by default and ensures that the
condition (bit pattern) is checked in advance so no time is lost during the
process. In cases in which the condition may only be set when the object is
about to be processed, this option should be disabled. This may be the case
after a preceding wait condition, for example.

Sequences The pens that the object uses are assigned here, arranged by contour and filling.
The pen for the filling is, as a rule, preselected in accordance with the pen for
the contour.

In addition, the number of passes is defined. The number of passes can also be
set to "Infinite". This infinite loop can only be exited by aborting the execution
either using the [Abort] button or with an external stop signal at the control
card. However, this results in the fact that subsequent objects or sequences will
never be executed.

The number of executions is also passed on to all lower-level structure levels and
cannot be changed there.

The number of execution loops and the pens used in the process are referred to
as sequences.

The "+" can be used to add more sequences, which are executed one after the
other.
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Setting Explanation

NOTE: The colored depiction of the pens always corresponds to the 1st
sequence.

NOTE: If, in a sequence, a pen with power ramp(s) is used in order to repeat one
or more closed contours with n-iterations, the execution loop must be assigned
to the path structure level in order to obtain only one start ramp at the
beginning and one end ramp at the end of the execution loops.

Below the table, additional explanations are presented on the basis of various
examples.

Execute Select whether the object is to be processed.

This option is available in markable objects as well as in containers and
automation objects.

Marking mode Use the available options to select whether contour and / or filling are to be
executed and in which order to each other.

Select if only filling or contour is to be marked, or filling before contour, or
filling after contour.

Alternating contour /
filling

Use this option if you want to change between contour and filling per
executions within one sequence. REQUIREMENT: The filling must have been
used on the same structure level as selected in the subsequent assignment.

Execution loop
assignment

Defines whether the whole object, only a whole layer, or only a path is to be
executed in the loop before the next loop, if any, starts.

Scan controllers Only appears if the job is assigned to several control cards. Set to "Auto" by
default.

In “Auto” mode, the RAYGUIDE logic automatically assigns the graphic object to
the responsible control card. Select "Manual" if you want to manually select the
explicit control card for the object.

NOTE: This setting is only relevant if the complete graphic object can in
principle be executed by several control cards.

BoundingBox

Size, Center Read-only values, showing the size of an imaginary orthogonal rectangle
surrounding the whole object.

NOTE: The information on the bounding box can be or become hidden if
necessary. For details, see page 101, Visibility.

Table. 7.24: RG-032

An additional group of general settings are object transformations; see page 201, Object
Transformation.
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Examples for sequences

How a sequence will be executed ultimately depends on the sequence itself, the execution
mode, the assignment of the execution loop, and the option to alternate between the filling
and contour.

Legend:
■ […] = Encloses a sequence

■ {…} = Encloses an execution loop

Example 1: 2 sequences with different pens for contour and filling, contour before.

Fig. 7.19: RG-AEG

Executed order:

[2 x complete contours with pen 1 > 2 x filling with pen 2] > [3 x complete contour with
pen 3 > 3 x filling with pen 4]
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Example 2: Here, in contrast to example 1, the option to alternate between the filling and contour is
enabled.

Fig. 7.20: RG-AEH

Executed order:

[{1 x complete contour with pen 1 > 1 x filling with pen 2} > {1 x complete contour with
pen 1 > 1 x filling with pen 2}] >

[{1 x complete contour with pen 3 > 1 x filling with pen 4} > {1 x complete contour with
pen 3 > 1 x filling with pen 4} > {1 x complete contour with pen 3 > 1 x filling with pen 4}]
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Example 3: Here, in contrast to example 2, the assignment of the execution loops is set on the path level.

Fig. 7.21: RG-AEI

Executed order:

[2 x 1st path with pen 1] > [3 x 1st path with pen 3] >

[2 x 2nd path with pen 1] > [3 x 2nd path with pen 3] >

…

[2 x 6th path with pen 1] > [3 x 6th path with pen 3] >

[2 x filling with pen 2] > [3 x filling with pen 4]

Each path is run through in accordance with the number of executions of a sequence before
the next path is started. However, there is no alternating between contour and filling. The
reason for this in this example is that the filling is on the object level, while the sequence was
assigned to the path level.

NOTE: Alternating between contour and filling only works if the filling is assigned to the
corresponding structure level; see the following example 4:
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Example 4: Here 2 of the circular paths have been filled at the path level.

Fig. 7.22: RG-AEJ

Executed order:

[2 x 1st path with pen 1] > [3 x 1st path with pen 3] >

[{1 x 2nd path with pen 1 > 1 x filling 2nd path with pen 2} >

{1 x 2nd path with pen 1 > 1 x filling 2nd path with pen 2}]>

[{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4} >

{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4} >

{1 x 2nd path with pen 3 > 1 x filling 2nd path with pen 4}]>

[{1 x 3rd path with pen 1 > 1 x filling 3rd path with pen 2} >

{1 x 3rd path with pen 1 > 1 x filling 3rd path with pen 2}]>

[{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4} >

{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4} >

{1 x 3rd path with pen 3 > 1 x filling 3rd path with pen 4}]>

[2 x 4th path with pen 1] > [3 x 4th path with pen 3] >

[2 x 5th path with pen 1] > [3 x 5th path with pen 3] >

[2 x 6th path with pen 1] > [3 x 6th path with pen 3]
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7.2.4.1 Edit common object properties
For example, it may be necessary to assign the same number of passes to all marking objects.
Instead of changing this parameter object by object, you can change it for a multiple
selection of objects:

■ Select all desired objects in the tree structure.

■ Right mouse click > Context menu
■ Select common properties.

■ Edit the desired parameter and it will be applied to all selected objects.

Fig. 7.23: RG-ADY

NOTE: For objects of different types, only the general properties are available for editing. For
objects (only basic marking objects) of the same type (e.g. rectangles) you can also edit the
object-specific parameters.
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7.2.5 Object Fillings
A two-dimensional vector object which has at least one closed path can be filled with a
pattern. Individual layers or path entities of a free-shaped vector object can also be filled.
Please note the rules mentioned in the tables, see page 156, Vector Graphic.

The example shows a vector graphic before and after filling with a spiral pattern.

Example:

Fig. 7.24: RG-ABJ

Fig. 7.25: RG-ABK

A filling applies only to a selected object.

If an object contains paths which lay inside each other, the filling starts with the outermost
area, skips the next area, and continues with the next area, and so on.
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If the closed paths create intersecting areas, the filling algorithm will fill or not fill these areas
alternately.

Example:

Fig. 7.26: RG-ABL



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 190MN_RAYGUIDE [V2.11]

7.2.5.1 Variants of fillings
To create a filling, select an object, open its settings dialog, and go to the Fillings tab. To add
a fill pattern, click the red plus sign for [Add].

Select one of the following pattern types for the filling.

Type Explanation

Hatching Parallel lines

Inset Duplicates the outline contour of the respective area continuously towards the
inside of the object.

The inset fill follows the outer contour, while inner contours are cut out of the
fill pattern like a stencil.

Spiral The fill pattern is defined by a single spiral. Here, the object contour acts like a
mask that lies in front of this spiral and whose closed areas alternately show the
background spiral.

Spiral-specific value: Chord length.

Drill points The fill pattern consists of a homogeneous arrangement of drill points.

Cell hatching Defines a discrete number of fill lines per cell. Only available with barcode type
objects, most useful for 2D codes.

Cell drill Define the number of point grids per cell. Only available with barcode type
objects, most useful for 2D codes.

Cell circle Fills a 2D code cell with circles.

Table. 7.25: RG-033

Multiple fillings can be added and combined.

NOTE: If you have chosen a small pitch value and you do not see the fill lines as separated
lines, you can reduce the display stroke width (in the main toolbar).
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7.2.5.2 General settings for fillings
Each filling pattern type has its own settings dialog:

Setting Explanation

Pitch [mm] Distance between fill lines

Invert 7 Inverts the filling logic. A virtual rectangular frame is always drawn around the
layout object as the outer filling boundary. In doing so, the following parameter
of the quiet zone is taken into account.

Quiet zone 7 Entry in [mm] indicating the distance between the virtual rectangular frame and
the layout object. The value always has a positive sign, and zero is permitted.

NOTE: The object size is adjusted according to the filled quiet zone. The red,
enclosing rectangle continues to be in relation to the actual layout object.

Sort Select whether the processing sequence of the fill lines and thus the jumps
should be optimized automatically to save process time.

Select if you want the filling to be processed with the minimum number of
required jumps to save process time.

7 NOTE: Not available for spiral filling and special code fillings.
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Setting Explanation

Padding [mm] Creates a non-filled frame between filling and respective filling outline.

Positive values generate a distance toward the inside (from the contour to the
filling), while values with a negative sign generate a distance toward the
outside.

NOTE: For 2D codes, connected cells are filled together. The parameter operates
differently depending on whether a specific cell filling or a generic filling is
used:

Table. 7.26: RG-034
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7.2.5.3 Special parameters for hatching filling

Setting Explanation

Angle [°] Angle of fill lines related to the object’s own coordinate system.

NOTE: The fill lines are processed from the bottom to the top by default (with
respect to the object). To change processing from the top to the bottom, an
angle of 180° must be entered.

Delta angle Angle in degrees by which the filling rotates per execution.

Offset [mm] Shifts the filling vertically to the fill line direction by the respective value.

Delta shift Shift of the fill lines in [mm] by which the fill lines move per execution.

Cross hatch Select to define a cross hatch filling style. Equal spacing is used for both
directions and the cross angle is fixed to 90 degrees.

If you want the filling directions to be at a different angle to each other, simply
add a second filling and define the angles accordingly.

If you require a different cross angle, simply add a second hatch filling and
adjust the angles accordingly.

Direction Unidirectional / Bidirectional / Meander

Bidirectional provokes alternating marking directions of the fill lines.

The meander is equally bidirectional, but the u-turn jumps are marked.

Table. 7.27: RG-109
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7.2.5.4 Special parameters for contour filling

Setting Explanation

Inbound Select the checkbox (tick the box) if you want to process the filling from the
inside to the outside (standard setting). Deselect it if you want to process the
filling from the outside to the inside.

Number of insets ■ Auto: Closed contours get filled completely.

■ Defined number: Useful to create a defined number of contour lines
equidistant from the master path. Therefore, it is also ideal for open paths.
Algebraic sign of the pitch value defines whether the contour copies are
added to the left or right from the path.

Example:

NOTE: To design a contour copy as in the example, the advanced fill option End
type must be set to Open butt.

Table. 7.28: RG-110
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7.2.5.5 Special parameters for spiral filling

Setting Explanation

Center Use this option if the spiral is centered on the processing field rather than on
the object.

Offset Shifts the center of the spiral relative to the center of the object bounding box

Rotation angle,
Delta angle

Angle by which the spiral is rotated relative to the X-axis.

The delta angle can be used to ensure that the spiral rotates with each
execution.

Start angle Specify the angle relative to the X-axis from which the spiral starts inside.

Pitch [mm] Parallel distance in [mm] between the spiral windings

Chord length [mm] Length of the polyline segment that represents the spiral shape

Feed direction Specify whether the spiral is traveled from the inside out or from the outside in.

Table. 7.29: RG-111

7.2.5.6 Special parameters for filling with drill points

Setting Explanation

Distance X / Y Distance at which the drill points will be arranged in the X and Y directions.

Mode Pulse: The dwell time per drill point is defined on the basis of the number of
pulses and the frequency defined in the pen and the resulting pulse period.

Time: The dwell duration per drill point is defined directly as the target value.

Pulses / Time Number of laser pulses or duration [ms].

Table. 7.30: RG-112
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7.2.5.7 Special parameters for circular filling of code cells

Setting Explanation

Count Number of circles per row / column or number of concentric circles.

Roundness [%] A value of 100% corresponds to a circle. A value of 0% corresponds to a square.
All values in between yield squares with rounded corners.

Scale [%] Scales the diameter of the circle(s), which otherwise adjusts itself to the cell size.

Concentric Activates the concentric arrangement of the circles instead of a matrix
arrangement.

Table. 7.31: RG-113

7.2.5.8 Special parameters for fillings per vector graphic

Setting Explanation

[Load file...] Opens a file browser to select and load the vector graphic file that should
represent the fill pattern.

Scale to size Activate to scale the size of the imported graphic to the specified size in [mm].

Unit Defines the unit of the imported vectors. This is usually the value = 1 and the
unit in which the layout was created. Select from [mm], [µm] and [inch].

A value ≠ 1 would additionally add a scale factor to it. Only applicable if Scale to
size is not used.

Center XY Activate this option to center the fill graphic relative to the graphic to be filled.

[Embed] Clicking on the button embeds the fill graphic directly into the job file. This also
makes it available for other RAYGUIDE applications.

CAUTION: After embedding, the import options such as centering to each other
are no longer available.
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Setting Explanation

Contour points For vector graphics as fill patterns, all curve commands and arcs contained inside
them are automatically converted into polygons.

■ The first step creates a polyline containing the number of points given here.

■ In the second step, the number of points that are entirely or almost entirely
in a straight line is reduced using the collinearity distance tolerance value.

Collinearity distance
[mm]

Parameter for deciding whether a point lies on the same line defined by its two
predecessor points.

If its distance to that line is less than the specified value (e.g. 0.1 mm), the point
is considered to lie on the line.

Offset [mm] Offset of the center of the fill graphic to the center of the graphic to be filled.

Rotation [°] Rotation of the fill graphic relative to the graphic to be filled.

Table. 7.32: RG-114
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7.2.5.9 Advanced settings for fillings

Setting Explanation

Click [Expander] to open the advanced settings section.

It is not recommended to use all available settings in the advanced sections. The advanced settings options
are only relevant for the “Contour” filling pattern.

Some of the relevant settings are listed below.

Activate Select whether this fill profile is to be executed or not.

NOTE: This option is active by default. Can be used if an object has several fill
profiles but not all are to be executed.

Clipping zone Specification in [mm] for a zone around the contour in which fill lines are
trimmed or omitted completely.

NOTE: This parameter does not change the position of the fill lines compared to
the value padding.

Application example:

If a circular contour fill line overlaps with a circular contour line, both are
converted into polygons by the fill routine so that this fill line may become a
stroke line:
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Setting Explanation

Join type Varies the way the filling lines meet on inner corners:

Miter vs. Round vs. Square

Square

Round

Miter
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Setting Explanation

End type ■ Open butt: Is used for contour copy of open paths

■ Closed polygon: Closes an open path with a virtual line as a fill border

Example:

Table. 7.33: RG-115

7.2.5.10 Fill dialog buttons

Type Explanation

Click on the buttons for [Expand] / [Collapse] to expand or collapse the
various sections of fillings in the dialog box.

Click on the [Up] / [Down] arrow key to change the order (corresponds to the
processing sequence) for a multiple-fill pattern.

Use the [Save] button to store the actual filling as a filling template. Use
[Load] to list all filling templates available to add one.

Table. 7.34: RG-066
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7.2.6 Layout Modification

7.2.6.1 Object Transformation
Every layout object carries transformation information.

When an object is placed on the workspace for the first time, it is registered in the job file
with its initially defined parameters. The initial / original values are not changed by a
transformation. Instead, any change to the object is additionally stored as either a
transformation or a direct edit of a graphic element or vector position.

Types of transformations
■ The object offset and thus the position of the object center in relation to the workspace

origin.

■ The size and scale factor (scaling change per click) of the object (or the surrounding
rectangle) and thus the axes ratio in relation to the original size (after adding or importing
a layout object).

■ The rotation of an object around its transformation center.

Access to transformations

Transformations can be performed with the mouse in the viewport or by entering values. You
can use three GUI locations:

■ The viewport, using the mouse (cursor) or the arrow keys (limited to translation in the XY
plane)

■ Transformation panel

■ Object settings dialog
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Transformation panel

The main location for performing transformations is the Transformation panel (by default, on
the right side of the screen). Here, all transformation options are available.

Fig. 7.27: RG-ABM

Object settings dialog

The settings in this dialog reflect the settings provided in the Transformation panel.

To open an object settings dialog, go to the Settings tab, Transformation section.

Fig. 7.28: RG-ABN

The table shows the current offset and the dimensions of the object, and thus its scale factors,
in relation to the original values (i.e. at the time of initial creation).
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Object selection

Transformations can be applied to pre-formed objects and to free-formed graphics as a whole
and to the layers, paths, and path elements of an object, or even at container level. When a
container element is transformed, the transformation is applied to the container as a whole
and to all of its subordinate objects (so-called "children"). (If a pattern object is taken out of
the container again, it loses this transformation.)

Coordinate systems

Please note that there are two coordinate systems to consider when performing
transformations:

■ The coordinate system of the workspace.

■ The coordinate system of a graphic object. Each object has its own coordinate system.

Each transformation always relates to a transformation center of an object (or a group of
selected objects). Note the following definitions:

■ Coordinate origin of the workspace: Zero coordinates of the workspace, which can be a
combination of multiple scan fields. In case of multiple scan fields: The workspace origin is
equal to the origin in the workspace definition and its scan field offsets.

■ Object center: Center of the enclosing rectangle which encloses an object

■ Object origin: Mathematical starting point of a pre-formed object. The origin of the object
is generally the center of the object, with the exception of polygons and spirals, for
example.

■ Transformations center: By default, the transformation center is the object center.
Transformations of scale and rotation relate to the transformation center. The absolute
position of the transformation center is available in the panel under “Center point”. The
position can be shifted with the mouse and reset to the object center using the [Reset]
button next to the “Center point” coordinates.
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The following example figure shows the essential items regarding transformations:

Example:

Fig. 7.29: RG-ABO
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Transformation details

The following transformation operations are available:

Setting Explanation

Mode Absolute: Transform to … (can only be applied at the Object Hierarchy level)

Relative: Transform by …

Offset [mm]

In Absolute mode: Shows / Defines the offset (and thus the position) on the X-
Y-Z axes from the object origin to the coordinate origin of the workspace.

In Relative mode: Shifts the selection by the entered value in the X-Y-Z-
direction.

Applicable to containers, objects, or individual layer, paths, path element or
groups of thumbs.

Size In Absolute mode: Shows / Defines the absolute size of an object or of the
surrounding rectangle.

Use the [Lock / Unlock] toggle button to fix the side ratio.

Note that size and scale values are intertwined.

Gain [%] In Absolute mode: Shows / Defines the scale factor as a percent relative to the
original size of the object. The center point of the transformation is the
transformation center, which usually coincides with the object center.

In Relative mode: Shows / Defines the scale factor as a percent by which the
current selection is scaled relative to the current size.

Can be applied to containers, objects, layers (exception: text layers), paths.

Multiple selections are possible in principle, but only in the same Hierarchy level.
By default, the transformation center is at the center point of the shared
enclosing bounding box.

Use the [Lock / Unlock] toggle button to fix the side ratio.

Note that size and scale values are intertwined.

Flip Toggle buttons to flip / unflip the selection in direction of the respective
coordinate axis.

X direction / Y direction / Z direction
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Setting Explanation

Rotation [°]

Shows / Defines the angle in degrees by which the current selection is rotated
around the transformation center.

In Absolute mode, the angle is specified relative to the respective coordinate
axes.

In Relative mode, the angle is specified relative to the current orientation.

Can be applied to containers, objects, layers (exception: text layers), paths.

Multiple selections are possible in principle, but only in the same Hierarchy level.
By default, the transformation center is at the center point of the shared
enclosing bounding box.

The [Reset] buttons reset the respective absolute transformation to the original
object position / size / orientation.

Fixed rotation angle Buttons for the fixed rotation per spatial axis by 90 degrees each in the
clockwise / anti-clockwise direction around the center of transformation.

Orientation of the rotational axis through the transformation center:

Parallel to: X-axis / Y-axis / Z-axis

Center [mm] The coordinates of the transformation center of an object or of a multiple
selection (displayed by an "x" on the "rotating handle")

The [Reset] button resets the transformation center to the object center.

Table. 7.35: RG-035

The [Reset] button actively resets the respective transformation to absolute zero in case of
offset, scaling and rotation, both in absolute and relative mode.

The [x] buttons in “Relative” mode set values to zero.

Command buttons

Click on the [Checkmark] button to apply the transformation.

Click on the [Apply to copy] button to copy the object and transform it at the same time.
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7.2.6.2 Edit Mode
Edit mode must be activated to be able to edit vector-based layout objects or parts thereof,
such as individual thumbs.

To access Edit mode, go to Edit vectors in the context menu of the object.

Alternatively, you can directly select the layout element in the tree directory to switch directly
to Edit mode.

In Edit mode, contours are displayed but not fillings. View options such as the display of
jump vectors, vector tips and sharp corners are ignored in this mode.

7.2.6.3 Automated vector optimization

7.2.6.3.1 Overview
Many imported layout files are not optimally prepared for laser processing. RAYGUIDE thus
offers a broad range of optimization functions:

■ Rearrange the vector sequence.

■ Optimize the processing result.

■ Adapt the geometry to the real situation if necessary.

To obtain an impression of how the layout object will be processed, use the "Display vector
tips" and "Display vector jumps” view options. You may also navigate through the object tree
and follow the highlighted thumbs in the viewport.

Some optimization functions require a tolerance parameter. The corresponding parameters
are mentioned with each optimization function and explained in the section on the
associated settings at the end of this chapter.

Right-click an item of the object tree to open the context menu and select Vector
optimizations.

The table provides an overview of all functions, and at which geometry level you can use
them. The following sections explain each function in more detail and provide examples. The
examples show the situation before and after applying the function.
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Function Available at level See …

Object Layer Path Path
eleme

nt

Sort Minimize jump
distance

✓ ✓ page 211, Sorting to minimize jump
distance

By direction ✓ ✓ page 212, Sorting by direction

Layers by name
(ascendend /
descendent)

✓ page 212, Sorting layers by names

Close paths ✓ ✓ ✓ page 213, Close paths

Close gaps ✓ ✓ page 213, Closing gaps

[Change orientation] ✓ ✓

Set z-coordinates to zero ✓ ✓ ✓ ✓ page 214, Setting z-coordinates to
zero

Split path ✓ page 214, Split path

Split commands ✓ ✓ ✓ ✓ page 214, Splitting elements

Define as start of path ✓ page 214, Defining as start of path

Merge / Join Layers ✓ page 215, Merging / Joining layers

Touching paths ✓ ✓ ✓ page 215, Merging / Joining
touching paths

Polylines ✓ ✓ ✓ page 215, Merging / Joining
polylines

Straight lines ✓ ✓ ✓ page 215, Merging / Joining
straight lines

Similar circular
arcs

✓ ✓ ✓ page 216, Merging / Joining similar
arcs

Selected points
with lines

✓ ✓ page 216, Merging / Joining
selected points with lines
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Function Available at level See …

Object Layer Path Path
eleme

nt

Remove Drills ✓ ✓ ✓ page 217, Removing drills

Duplicates ✓ ✓ ✓ ✓ page 217, Removing duplicates

Straight points ✓ ✓ ✓ ✓ page 218, Removing straight points

Empty layers ✓ page 218, Removing empty layers

Empty paths ✓ ✓ page 218, Removing empty paths

Replace Lines / Polylines
by ...

■ Rearranged
polylines,

■ Circular arcs,

■ Quadratic
curves,

■ Cubic curves

✓ ✓ ✓ ✓ page 219, Lines / Polylines

Circular arcs by ...

■ Lines,

■ Polylines,

■ Elliptical arcs,

■ Quadratic
curves,

■ Cubic curves

✓ ✓ ✓ ✓ page 223, Circular / Elliptical arcs

Elliptical arcs by ...

■ Lines,

■ Polylines,

■ Circular arcs,

■ Quadratic
curves,

■ Cubic curves

✓ ✓ ✓ ✓ page 223, Circular / Elliptical arcs
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Function Available at level See …

Object Layer Path Path
eleme

nt

Quadratic curves
by ...

■ Lines,

■ Polylines,

■ Circular arcs,

■ Cubic curves

✓ ✓ ✓ ✓ page 226, Quadratic curves / Cubic
curves

Cubic curves by ...

■ Lines,

■ Polylines,

■ Circular arcs,

■ Quadratic
curves.

✓ ✓ ✓ ✓ page 226, Quadratic curves / Cubic
curves

Straight curves by
lines

✓ ✓ ✓ page 228, Replacing straight curves
with lines

Circles by Drills ✓ ✓ ✓ page 229, Replacing arcs with
drills / drills with circles

Drills by Circles ✓ ✓ ✓ page 229, Replacing arcs with
drills / drills with circles

All commands by
polylines

✓ ✓ ✓ page 229, Replacing all commands
with polylines

All commands by
drills

✓ ✓ page 230, Replacing all commands
with drill holes

All commands by
paths

✓ ✓ ✓ ✓ page 231, Replacing all commands
with paths

Double points in polylines ✓ ✓ ✓ ✓ page 231, Doubling points in
polylines

Table. 7.36: RG-036
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7.2.6.3.2 Sorting

7.2.6.3.2.1 Sorting to minimize jump distance

This function rearranges all paths and, if necessary, the graphic command order to avoid
unnecessary jumps. This may also imply that a path succession gets reversed. If a subsequent
path has a start point matching its predecessor’s end point, the paths are joined after sorting.

The function should be executed before all other optimization functions, because other
functions work better if the elements are already sorted.

Context menu: Vector optimizations > Sort > Minimize jump distance

Hierarchy levels: Object, layer

Related tolerance value: Min. point distance (for sorting) [mm]

Example:

Fig. 7.30: RG-ABP
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7.2.6.3.2.2 Sorting by direction

This function rearranges all paths by considering a belt angle to optimize MOTF execution.
Enter an angle that is opposite to the direction of belt movement through the scan field.

Context menu: Vector optimizations > Sort > By direction

Hierarchy levels: Object, layer

Example: Three lines of text processed line by line by default

Fig. 7.31: RG-ADN

7.2.6.3.2.3 Sorting layers by names

This function sorts the order of the layers alphabetically by name, either ascending or
descending.

Context menu: Vector optimizations > Sort > Layers by name (ascendend /
descendent)

Hierarchy levels: Object
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7.2.6.3.3 Close paths
This function closes open paths by connecting the end point of the last graphic command to
the path coordinate with a single line graphic command.

Context menu: Vector optimizations > Close paths

Hierarchy levels: Object, layer, path

Example:

Fig. 7.32: RG-ABQ

7.2.6.3.4 Closing gaps
This function closes gaps between adjacent open paths by inserting a line between the paths
and joining the paths. The corresponding tolerance value sets the maximum size of the gap
that can be closed by this routine.

This routine does not identify gaps that might appear on a T-crossing.

Context menu: Vector optimizations > Close gaps

Hierarchy levels: Object, layer

Related tolerance value: Min. point distance

Example:

Fig. 7.33: RG-ABR

Because the “circular” path is closed, it is not joined with its predecessor and the gap remains
open.
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7.2.6.3.5 Setting z-coordinates to zero
This function will reset all Z-coordinates to zero. You can convert a 3D vector geometry into a
2D geometry in this way. Also, the function is useful if, by mistake, coordinates have been
generated with a Z-value unequal to zero.

Context menu: Vector optimizations > Set z-coordinates to zero

Hierarchy levels: All

7.2.6.3.6 Split path
This function splits a path into two. The selected graphic command becomes the first graphic
command of the new path.

Context menu: Vector optimizations > Split path

Hierarchy levels: Path element

7.2.6.3.7 Splitting elements
This function splits polylines, circular arcs, quadratic and cubic curves into two graphic
commands of the same type, preserving the original shape.

If points of a polyline are selected (not the path the polyline belongs to), the polyline is split
at these points.

If the path of the polyline is also selected, the polyline is split into two polylines – the selected
polyline points are ignored.

Context menu: Vector optimizations > Split commands

Hierarchy levels: All

Example:

Fig. 7.34: RG-ABS

7.2.6.3.8 Defining as start of path
Select a thumb that will be the new starting point of the path and then use this function to
redefine the starting point of the path.

Context menu: Vector optimizations > Define as start of path

Hierarchy levels: Path element, transition points (red)
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7.2.6.3.9 Merging / Joining

7.2.6.3.9.1 Merging / Joining layers

This function combines all layers of a vector graphic in one layer.

Context menu: Vector optimizations > Merge / Join > Layers

Hierarchy levels: Objects

7.2.6.3.9.2 Merging / Joining touching paths

This function merges two adjacent paths if the end coordinates of one path and the start
coordinates of the next path are within a given tolerance. Compared to the “close gaps”
function, the subsequent path start is adapted and no additional line graphic command is
added.

Context menu: Vector optimizations > Merge / Join > Touching paths

Hierarchy levels: Object, layer, path

Related tolerance value: Min. point distance

7.2.6.3.9.3 Merging / Joining polylines

This function joins two polylines if both polyline graphic commands follow the same path.

Context menu: Vector optimizations > Merge / Join > Polylines

Hierarchy levels: Object, layer, path

7.2.6.3.9.4 Merging / Joining straight lines

This function joins two adjacent straight lines within a path if they are collinear.

Context menu: Vector optimizations > Merge / Join > Straight lines

Hierarchy levels: Object, layer, path

Related tolerance value: Collinear distance
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7.2.6.3.9.5 Merging / Joining similar arcs

The function merges two adjacent circular arcs in one path if their center points (almost)
coincide, and they have the same radius.

Context menu: Vector optimizations > Merge / Join > Similar circular arcs

Hierarchy levels: Object, layer, path, path element – multiple selection

Related tolerance value: Min. point distance (for evaluating the center points)

Example:

Fig. 7.35: RG-ABT

7.2.6.3.9.6 Merging / Joining selected points with lines

This function joins two selected points with a line, which represents a new path.

If more than two points are selected, the sequence in which the points are connected is
undefined.

Context menu: Vector optimizations > Merge / Join > Selected points with lines

Hierarchy levels: Path, path element

Example:

Fig. 7.36: RG-ABU
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7.2.6.3.10 Removing

7.2.6.3.10.
1

Removing drills

This function removes all drills (Laser on command) from the selected graphic element. This
can affect single drill as well as Laser on action commands within a path sequence.

Context menu: Vector optimizations > [Delete] > Drills

Hierarchy levels: Object, layer, path

Example:

Fig. 7.37: RG-ABV

7.2.6.3.10.
2

Removing duplicates

This function removes adjacent duplicate thumbs and adjacent loops in polylines if the
thumbs have a distance less than the min. point distance.

NOTE: This function is not able to detect two separate paths which are completely or partially
identical.

Context menu: Vector optimizations > [Delete] > Duplicates

Hierarchy levels: All

Related tolerance value: Min. point distance

Example:

Fig. 7.38: RG-ABW
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7.2.6.3.10.
3

Removing straight points

This function removes all points within a polyline that lie on a “nearly straight line”. The user
can set the tolerance of what is considered a “nearly straight line”.

Context menu: Vector optimizations > Remove > Straight points

Hierarchy levels: All

Related tolerance value: Collinear distance

Example:

Fig. 7.39: RG-ABX

7.2.6.3.10.
4

Removing empty layers

This function removes all layers which contain no paths.

Context menu: Vector optimizations > Remove > Empty layers

Hierarchy levels: Object

7.2.6.3.10.
5

Removing empty paths

This function removes all paths which contain no path elements.

Context menu: Vector optimizations > Remove > Empty paths

Hierarchy levels: Object, layer
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7.2.6.3.11 Replacing
Replacing functions are used to convert one type of graphic command to another.

Available sub-functions are listed in the preceding table.

Some of the sub-functions require explanation:

7.2.6.3.11.
1

Lines / Polylines

Replacing lines / polylines with rearranged polylines

This function can split one polyline graphic command into several polyline graphic commands.
The user must select the section(s) of the polyline (a section must always contain more than
one polyline point) that will become a new polyline graphic command.

NOTE: This function works opposite to the “Join polylines” function.

The example shows a single polyline graphic command describing an elliptical arc where two
sections are selected (row of red thumbs).

After the function was applied, the elliptical arc is represented by five polyline graphic
commands.

Context menu: Vector optimizations > Replace > Lines / Polylines by >
Rearranged polylines

Hierarchy levels: Polyline graphic command

Example:

Fig. 7.40: RG-ABY
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Replacing lines / polylines with circular arcs

This function converts either complete polylines (a) or a selected section of points of a
polyline (b) with circular arcs approximating the polyline shape.

Use case a) The complete polyline describes a closed circle / ellipse. In this case, you can use this function
directly for the following hierarchy Hierarchy levels: Object, layer, path.

Use case b) A section of the polyline describes an arc. In this case, you need to select all thumbs that
belong to the arc section and apply the function to this section only. Multiple-selection of
sections is not advisable.

Context menu: Vector optimizations > Replace > Lines / Polylines by > Circular
arcs

Hierarchy levels: All / Polyline graphic command

Example a)

Fig. 7.41: RG-ABZ
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Example b)

Fig. 7.42: RG-ACA
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Replacing lines / polylines with quadratic curves

This function replaces each single-line segment of a polyline with a quadratic curve,
preserving the polyline shape.

Context menu: Vector optimizations > Replace > Lines / Polylines by > Quadratic
curves

Hierarchy levels All

Example:

Fig. 7.43: RG-ACB

Replacing lines / polylines with cubic curves

This function replaces each single-line segment of a polyline with a cubic curve, preserving
the polyline shape.

Context menu: Vector optimizations > Replace > Lines / Polylines by > Cubic
curves

Hierarchy levels: All

Example:

Fig. 7.44: RG-ACC
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7.2.6.3.11.
2

Circular / Elliptical arcs

Replacing circular / elliptical arcs with polylines

This function replaces a circular or elliptical arc with a polyline approximating the original
shape.

This is done in two steps:

In the first step, the circular arc is replaced with a polyline with the number of points set in
the Number of points tolerance parameter.

In the second step, all superfluous points are removed from the straight lines using the
Collinearity distance parameter.

With carefully chosen parameters, the result is a polyline with enough points to approximate
the circular arc smoothly even in areas with strong curvature.

NOTE: If you select too few points, the adjustment to the arc shape is not very precise,
regardless of the value you set for the collinearity distance.

Context menu: Vector optimizations > Replace > Circular arcs by > Polylines

Hierarchy levels: All

Related tolerance values: Number of points, collinear distance

Example:

Fig. 7.45: RG-ACD
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Replacing circular / elliptical arcs with elliptical / circular arcs

This function replaces a circular arc with an elliptical arc or an elliptical arc with a circular arc.

In the first case, an elliptical arc is created with both semi axes having the same radius as the
original circular arc, preserving the original circular arc shape.

In the second case, a circular arc is created with the same start and end points as the original
elliptical arc and a radius that is a type of average value of the ellipse semi axes. Therefore,
the shape cannot be preserved.

Context menu:

■ Circular arcs Vector optimizations > Replace > Circular arcs by > Elliptical arcs
■ Elliptical arcs Vector optimizations > Replace > Elliptical arcs by > Circular arcs

Hierarchy levels: All

Example:

Fig. 7.46: RG-ACE
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Replacing circular / elliptical arcs with quadratic curves

This function replaces a circular or elliptical arc with a set of quadratic curves approximating
the original shape. A full circle or ellipse is replaced with eight quadratic curves, smaller arcs
are replaced with a suitable smaller number of quadratic curves.

Context menu:

■ Circular arcs Vector optimizations > Replace > Circular arcs by > Quadratic
curves

■ Elliptical arcs Vector optimizations > Replace > Elliptical arcs by > Quadratic
curves

Hierarchy levels: All

Example:

Fig. 7.47: RG-ACF

Replacing circular / elliptical arcs with cubic curves

This function replaces a circular or elliptical arc with a set of cubic curves approximating the
original shape. A full circle or ellipse is replaced with four cubic curves, smaller arcs are
replaced by a suitable smaller number of cubic curves.

Context menu:

■ Circular arcs Vector optimizations > Replace > Circular arcs by > Cubic curves
■ Elliptical arcs Vector optimizations > Replace > Elliptical arcs by > Cubic curves

Hierarchy levels: All

Example:

Fig. 7.48: RG-ACG
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7.2.6.3.11.
3

Quadratic curves / Cubic curves

Replacing quadratic / cubic curves with lines

This function replaces a quadratic or cubic curve with a single line connecting the original
start and end point.

Context menu:

■ Quadratic curves Vector optimizations > Replace > Quadratic curves by > Lines
■ Cubic curves Vector optimizations > Replace > Cubic curves by > Quadratic

curves

Hierarchy levels: All

Example:

Fig. 7.49: RG-ACH

Replacing quadratic / cubic curves with polylines

This function replaces a quadratic or cubic curve with a polyline approximating the original
shape.

The conversion logic is similar to replacing a circular / elliptical arc with a polyline.

Context menu:

■ Quadratic curves Vector optimizations > Replace > Quadratic curves by > Polylines
■ Cubic curves Vector optimizations > Replace > Cubic curves by > Polylines

Hierarchy levels: All

Example:

Fig. 7.50: RG-ACI
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Replacing quadratic / cubic curves with circular arcs

This function replaces each quadratic or cubic curve with an arc approximating the original
shape.

Since this conversion is performed via the intermediate step of a polyline, the tolerance values
number of points and collinearity distance are taken into account.

As shown in the example: If a rather small collinearity distance is selected, the center points of
all arcs are close together and can be optimized further.

Context menu:

■ Quadratic curves Vector optimizations > Replace > Quadratic curves by > Circular
arcs

■ Cubic curves Vector optimizations > Replace > Cubic curves by > Circular arcs

Hierarchy levels: All

Example:

Fig. 7.51: RG-ACJ
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7.2.6.3.11.
4

Replacing straight curves with lines

This function replaces quadratic or cubic curves with lines, but only if the control points are
on the line defined by the start and end points of the curve; i. e. the curve has no curvature, it
is straight.

How much the control points may differ from the line can be adjusted by the collinearity
distance.

Context menu: Vector optimizations > Replace > Straight curves by lines

Hierarchy levels: Object, layer, path

Related tolerance values: Collinear distance

Example:

Fig. 7.52: RG-ACK
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7.2.6.3.11.
5

Replacing arcs with drills / drills with circles

This function replaces “small” arcs (circles) with drill holes (laser-on command) or vice-versa.

The arcs do not necessarily need to describe an angle of 360°.

In the reverse case, i.e. when drill holes are converted to circles (360° arc), the radius of the
resulting circles corresponds to the respective tolerance value.

Context menu:

■ Arcs Vector optimizations > Replace > Circles by Drills
■ Drills Vector optimizations > Replace > Drills by Circles

Hierarchy levels: Object, layer, path

Related specifications: Radius for replacing arcs

Example:

Fig. 7.53: RG-ADZ

7.2.6.3.11.
6

Replacing all commands with polylines

This function replaces all graphic commands (if not already a polyline) with polylines as
described in the above sections (see page 223, Circular / Elliptical arcs).

Context menu: Vector optimizations > Replace > All commands by polylines

Hierarchy levels: Object, layer, path

Related tolerance values: Number of points, collinear distance



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 230MN_RAYGUIDE [V2.11]

7.2.6.3.11.
7

Replacing all commands with drill holes

This function replaces all graphic commands with drill holes that are arranged along the
contour lines.

Context menu: Vector optimizations > Replace > All commands by drills

Hierarchy levels: Object, layer

Related specifications: Spacing [mm], Force corners, Drill mode, Pulse / Time

NOTE: You can also directly apply this optimization as a job optimization during job
execution. This means, for example, that dynamically changing text content can also be
converted.

Example a) With "Force corners" option:

Fig. 7.54: RG-AFF

Example b) Without "Force corners" option:

Fig. 7.55: RG-AFG
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7.2.6.3.11.
8

Replacing all commands with paths

If a path contains several graphic commands, each individual or selected graphic command is
subdivided into its own path. The processing direction could then be inverted for each path
created in this way.

Context menu: Vector optimizations > Replace > All commands by paths

Hierarchy levels: All

7.2.6.3.12 Doubling points in polylines
This function inserts an additional point between two existing polyline points.

Context menu: Vector optimizations > Double points in polylines

Hierarchy levels: All

Example:

After doubling
of the points in a
polyline

Fig. 7.56: RG-ACL
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7.2.6.3.13 Related settings
Select

System > Preferences [F3] > User (current user) > Vector optimizations.

Fig. 7.57: RG-AFH

Setting Explanation

Tolerances

Min. point distance [mm] The distance that must exist between two points to be considered the same
point.

Example:

0.5 means that two points at a distance of less than 0.5 mm are interpreted as
the same point.

Contour points You can convert each graphic command into a polyline. This is done in two
steps:

The first step creates a polyline containing the number of points given here.

In the second step, the number of points that are entirely or almost entirely in a
straight line is reduced using the collinearity distance tolerance value.

Min. point distance (for
sorting) [mm]

Same as tolerance described above but for using the Sort function.

Collinearity distance
[mm]

Parameter to decide whether a point lies on the same line defined by its two
predecessor points. If its distance to that line is less than the specified value (e.g.
0.1 mm), the point is considered to lie on the line.
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Setting Explanation

Convert to drills

Drill mode ■ Pulse: The dwell time per drill point is defined on the basis of the number of
pulses and the frequency defined in the pen and the resulting pulse period.

■ Time: The dwell duration per drill point is defined directly as the target
value.

Pulse / Time Number of laser pulses or duration [ms]

Spacing [mm] Distance between drill holes along the contour lines

Force corners If active, a drill hole is placed at each corner point of the contour in order to
illustrate it more accurately.

Radius for replacing arcs
[mm]

Circular arcs with a radius less than/equal to this value would be replaced with
drill holes if optimized accordingly.

If the reverse conversion from drill holes to arcs is selected, the arcs will have
this radius.

Table. 7.37: RG-037

7.2.6.4 Manual Vector Editing
In edit mode, you can edit a vector of an object directly in the layout as displayed in the
viewport.

Edit mode always works per object. The view options (e. g. display of jumps) and fillings are
turned off while in edit mode.

You can start edit mode in the object context menu or select the object layer or path in the
object tree. When entering edit mode, all points (transition points and control points) are
displayed and colored.

When a sub-unit of an object, e.g., a layer, path or graphic command, is selected in the job
tree, its thumbs are highlighted to be able to more easily see its position in the viewport.

Color code Red = Polyline or graphic command transition points

Blue = Starting point of the path.

Orange = Control point

■ Transition points:

These are points between the graphic commands or between the line segments of a
polyline. They are displayed as square dots, which are also called "thumbs".

■ Control points:

These are points to define the arc center or quadratic / cubic curves, to name some
examples. Control points are visible as round dots.
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7.2.6.4.1 Selecting points
■ With the mouse:

– First click in the empty area so that no thumbs are selected. Then select individual
thumbs by clicking the mouse.

– Multiple selection: Press [Ctrl] or [Shift] or drag the mouse cursor around the points.

– To deselect, press the [Ctrl]+[Alt] keys.

■ In the tree directory:

– All points of the selected command become active.

– Polyline: Open the point list to select a partial sequence.

– Keep [Ctrl] pressed to add other items to your selection.

NOTE: The selected thumbs are always filled, while the remaining thumbs of the path are
displayed with a colored frame.

Example:

Fig. 7.58: RG-AEA

7.2.6.4.2 How to move a point / edit its position
■ With the mouse:

Keep the left mouse button pressed and shift the point to the desired position. To move a
complete path, you have to double-click on one of the thumbs of the path (all points are
shown filled) and then apply and move one of the control points with the mouse.

NOTE: The thumbs as well as the control points have "magnetic" properties to be able to
connect 2 points (e.g. start and end point of a path) exactly.

The range of magnetic attraction has a radius of 15 pixels by default and can be set here:
System > Preferences > User (current user) > UI > Magnetic range

NOTE: The cursor icon changing from arrow to hand indicates that the selection can be
moved.

NOTE on circular arcs: During manual editing, the circular arc has 3 points on the inset
(start and end points and a point on the arc). The center point is displayed but cannot be
moved separately. All 3 thumbs must be selected to move the arc as a whole.
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Fig. 7.59: RG-AEK

■ With the arrow keys:

You can use the arrow keys on the keyboard to move points horizontally / vertically. Can
be used for single or multiple selection of points.

■ Apply relative transformations, see page 201, Object transformation.

■ About the context menu:

Using the context menu of the points, you can position individual points as well as the
associated path, layer or the entire graphic object with the Move menu item.

To do this, enter the absolute target position for the selected point, for instance.
Alternatively, you can also offset the selection made by a desired relative distance.

Fig. 7.60: RG-AGO

■ To adapt a graphic element specific to the position, you can also edit its point coordinates
directly in the command settings dialog.
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7.2.6.5 More Object-related Operations in the Context Menu
The context menu is always available when you right-click on an item or on a selection of
items. 
The table below lists all possible functions, however, which context functions are offered
depends on the object selection and whether you open the context menu in the viewport of
the jobtree.

Function Explanation Available in
viewport and / or
tree

Available for ...

Properties Opens the properties dialog of the
respective element.

Tree All

Edit vectors / Finish edit Starts or ends the edit mode of a
free-shaped vector graphic.

Tree / Viewport Free-shaped object

Rename 1. A marking object selected in the
tree:

Opens the name field for editing.

2. Several marking objects selected:

Opens the following dialog field:

■ “Unique” not active:

All selected objects are renamed
with the same name

■ “Unique” active:

A unique suffix is added to all
selected objects in addition to
the new name

Tree Object
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Function Explanation Available in
viewport and / or
tree

Available for ...

Save as template... Saves an object as a template for
this object type. See page 261,
Templates.

Tree / Viewport Object

Export as… Allows the export of the selected
layout object to another file format,
such as DXF.

Tree Object

Change pen... Allows you to assign a different pen
from the job pen set to the
selection.

Pen assignments made in the
hierarchy below the selection are
not overwritten.

Tree Container / Object /
Layer / Path / Path
element(s)

Unify pens... Reduces the pens used by the
selected item(s) to a single pen, so
that all subordinate paths use the
same pen. This pen is selected by the
user.

Tree Container / Object /
Layer / Path

Edit pens... Opens the pen settings dialog.
Useful to edit pen values of items
using different pens. The value field
will display "Multiple" if the
respective pens have different
values. After editing the pen values,
choose a reasonable pen saving
option. For details, see page 263,
Process Parameters (Pens).

Tree Object / Level / Path

Edit laser-on commands… Opens the dialog with the
properties of the "Laser on"
command to edit the properties of
several commands in one operation.
For example, all laser-on commands
in a layer can be set to the same
duration.

Tree Object / Layer / Path
multiple selection
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Function Explanation Available in
viewport and / or
tree

Available for ...

Cut Copies the item to the clipboard and
removes the original [Ctrl-]+[X].

Tree / Viewport Container / Object /
Layer / Path

Copy Copies the item to the clipboard but
keeps the original [Ctrl]+[C].

Tree / Viewport Container / Object /
Layer / Path

Copy segment Copies a section of the path to the
clipboard. The path section is
defined by a start time and end time
relative to the beginning of the
path.

The segment can then be inserted as
a new marking object in the same or
a new job using [Ctrl]+[V].

NOTE: This option is mostly used for
repair welding, where the time
value of the defect can be
determined using coaxial sensors.

Tree Path

Delete Deletes the selected elements. Tree / Viewport Container / Object /
Layer / Path

Paste Pastes the item from the clipboard
to the position in the tree /
viewport.

Tree / Viewport Container / Object /
Layer / Path

Center XY Positions the object in the center of
the workspace of the XY coordinate
plane.

Tree / Viewport Container / Object
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Function Explanation Available in
viewport and / or
tree

Available for ...

Align Option to align a multi-selection of
objects relative to each other. The
alignment refers to the object
bounding box of the selection.

Horizontally you can align the
objects left/center/right; vertically
you can align the objects top/center/
bottom.

Tree / Viewport Object multiple
selection

To vector graphic Converts a pre-formed vector object
into a free-shaped vector object,
built on the hierarchy structure.

Tree / Viewport Pre-formed object

Explode Option to split a container into its
“individual pieces”. Each child is
created as a separate object in the
job tree.

Sub-options (for nested) containers:

■ Recursive:

All containers including
containers in a container are
dismantled.

■ Non-recursive:

Only the container selected in the
job tree is dismantled

Tree Container objects

Group / Ungroup Puts the selected objects into a new
group container / dissolves the
selected group container.

Tree / Viewport Object multiple
selection

Move to combined vector
graphic

Combines two or more selected
elements (free-formed or pre-
formed) to a single vector object.
The resulting object always is a free-
shaped vector graphic. Existing
layers are preserved. A separate
layer is created for each of the
previous pre-formed objects.

NOTE: When you move graphic
elements manually (e. g. by
dragging in the objects list) into
another object which has already
undergone transformations, the
element is transformed in the same
way as the target. In contrast, when
using the Move to combined

Tree Object
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Function Explanation Available in
viewport and / or
tree

Available for ...

vector graphic command, the
element is not transformed but
remains unchanged. In fact, the new
combined object starts as a new
object free of transformations.

NOTES:
■ The resulting object always uses

job pen 1, independent of what
pens have been used before.

■ If the filling is active for one or
more selected objects, the filling
algorithm applies to the
combined layout and the filling
types get stacked.

■ If text objects are in the selection,
their contents are converted into
special text levels so the text
attributes are retained. (For the
text level, see page 156, Vector
Graphic)
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Function Explanation Available in
viewport and / or
tree

Available for ...

Add layer / Add path /
Add command

Adds a subordinate element to the
higher-level item, e. g. a path to a
layer.

Tree Object / Level / Path

Extract layers as new
objects

All layers of the selected object are
copied and created as separate
objects, which in turn are combined
in a group container.

Tree Free-shaped object

Convert to extruded
vector graphic

Converts a vector-based marking
object into an extruded vector
graphic object. For details on the
extruded vector graphic, see page
167, Extruded vector graphic.

Tree Objects

(Only useful if the
object only contains
closed paths)

Convert filling This action “vectorizes” fillings,
meaning each filling is created as a
separate layer in the object. This
allows the associated paths to be
edited individually.

NOTE: The conversion is applied to
all fillings of the object, regardless
of the hierarchy level at which this
filling was created.

Tree Objects of the
vector graphic type
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Function Explanation Available in
viewport and / or
tree

Available for ...

Project on 3D surface This action allows you to project the
mostly two-dimensional graphic
element onto the surface of a 3D
solid, generating a three-
dimensional vector graphic.

NOTES:
■ All graphic elements (e.g.,

text / codes) are converted into
vector graphics and lose their
object-specific properties

■ If you want to fill the object, this
has to be done before projection,
as all fill geometries are also
“vectorized”.

■ The 3D surface must be provided
in STL file format.

This action opens a dialog for
further processing. For details on the
dialog and the actual projection, see
page 246, Projection on 3D surface.

Tree All marking objects
(exception: raster
graphics)

Extract into combined
object

You can select sub-entities, for
example, layers or paths, and extract
them into a single new vector object
which contains the selection.

Multi-selection is possible.

The combined selection of layer /
paths is possible, however, the path
must not be part of an already
selected layer.

Cross-selection over different objects
is possible.

Each selected path element gets its
own layer in the newly created
object.

Tree Layer / Path
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Function Explanation Available in
viewport and / or
tree

Available for ...

Extract into individual
objects

You can select sub-entities for
example, layers or paths and extract
them into new vector objects. A new
graphic object is created for each
selected element.

Multi-selection is possible.

The combined selection of layer /
paths is possible, however, the path
must not be part of an already
selected layer.

Cross-selection over different objects
is possible.

Each selected path element gets its
own layer in the newly created
object.

Tree Layer / Path

Split Splits the corresponding object
above the selected element, creating
a second vector object containing all
elements from the selection and
below. Depending on whether the
selected element is a graphic
command, a path or a layer, the new
vector object is completed with the
usual hierarchy.

Only one command must be
selected.

Tree Layer / Path



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 244MN_RAYGUIDE [V2.11]

Function Explanation Available in
viewport and / or
tree

Available for ...

Reverse order ■ Non-recursively:

Only reverses the order of objects
one hierarchy level below. 
If, for example, you select a level,
the order of all paths in that level
is reversed, but the marking
direction in the paths is not.

■ Recursively:

Reverses all orders through all
hierarchy levels below. 
If, for example, you select a level,
the order of all paths in that level
and their respective marking
directions are reversed.

Tree Object / Level / Path

Delete without closing Deletes a graphic command without
closing / bridging the gap. The
resuming graphic commands after
the deleted graphic command create
a new path.

Tree Graphic command

Define as start of path Defines the selected thumb as the
new location of the path.

NOTE: Can only be used with closed
paths

Viewport in edit
mode

Thumb of a path
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Function Explanation Available in
viewport and / or
tree

Available for ...

Set starting point for
measurement

Defines the selected thumb as the
location of a distance measurement.
Current (displays the coordinate of
the defined measurement location)

Viewport in edit
mode

Thumb of a path

Measure distance to
point

Defines the selected thumb as the
end point of a distance
measurement (coordinate of the
selected measurement end point).

Viewport in edit
mode

Thumb of a path

Show ruler The measuring ruler is displayed
starting with the last defined
"location" (or at 0/0 if none has
been defined yet). After releasing
the ruler again by left-clicking with
the mouse, the measured distance is
written to the Notification panel.

Viewport in edit
mode

Thumb of a path

Table. 7.38: RG-038
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7.2.6.6 Projection on 3D surface
This dialog is used to perform the process of projecting two-dimensional graphic objects onto
a three-dimensional surface. This allows to generate three-dimensional vector graphics in
three steps.

The dialog is opened in the job tree with the Project on 3D surface function of the context
menu of the marking object.

Step 1 Import of surface information (STL file)

Fig. 7.61: RG-AGT
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Setting Explanation

Import settings

File Opens a file browser to navigate to the file of the solid you want to import.
After selecting the file, click [Open] in the browser. The preview displays the
file content.

If files were already imported, these are made available in the drop-down list
for renewed selection.

Supported file formats are: *.STL (stereolithography file)

Scale to size Activate to scale the size of the imported solid to the specified size in [mm]. It is
always the longest edge of the bounding box that is scaled to the value.

Unit Defines the unit of the imported vectors. This is usually the value = 1 and the
unit in which the layout was created. Select from [mm], [µm] and [inch].

A value ≠ 1 would additionally add a scale factor to it. Only applicable if Scale to
size is not used.

Center XY Incorporates the solid object centered in the XY axis view (corresponds to the
view from above) of the workspace.

Align Z [mm] Specification of the Z position in [mm], according to which either the upper side,
center position or underside of the solid aligns itself when importing.

Mirror direction Activate the toggle buttons for the X / Y / Z direction if the solid is to be
mirrored accordingly when imported.

[Save as default] Button to save the created settings as default settings for future imports of body
objects.

NOTE: For solid objects, the standard also contains the settings for the slices.

[Import] Click on this button to align the graphic to the surface in the second step and
then to project.

Table. 7.39: RG-085
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Step 2 Positioning of surface and projection

Setting Explanation

Projection

Positioning

Offset [mm] Offset of the STL surface

■ Relative to vector graphic

■ In the X-, Y-, Z-axis directions

Use the [Reset] button to reset all three values back to zero.

Rotation [°] Rotation of the STL surface

■ Relative to vector graphic

■ Around the X-, Y-, Z-axes

Use the [Reset] button to reset all three values back to zero.

Scale [%] Scaling of the STL surface

■ Relative to the vector graphic

Use the [Reset] button to reset the value back to 100%.

[Refresh]

Auto

Click on the button to specifically update the graphic display.

Select this option if you want the graphic display to be updated automatically
after each position change.

Projection step width
[mm]

Specify the distance at which points will be placed on the surface along the
contour of the vector graphic for projection.

This distance determines how precisely the 3D contour adapts to the shape of
the surface.

NOTE: Please note that a very small distance will result in a large number of
polypoints in the 3D contour.

Default Z [mm] Specify the Z-value for those points in the vector graphic that do not intersect
the surface of the solid when projected.

Top side / Bottom side Select whether the vector graphic should be projected onto the top or bottom
of the 3D solid.
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Setting Explanation

Bounding box solid

Specifications of the position and size of the solid

Min. [mm] / Max. [mm] Extension of the solid

■ Along the X-, Y-, Z-axis

■ From min. to max.

Center [mm] Specification of the center position of the solid

■ Along the X-, Y-, Z-axis

Size [mm] Dimension of the solid in all three dimensions

NOTE: While this dialog is open (with the Positioning tab), you can edit the vector graphic in
the main view window in edit mode (e.g., move individual vector points). These modifications
to the vector graphic are also updated in the projection view by this dialog.
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Example: Projection of text with filling on the surface of a computer mouse shell

Fig. 7.62: RG-AGU

Note on 3D view:

■ Frame (cuboid): Working volume (provided by the 3D correction file).
■ Grid: The zero layer.
■ Gray shading: Solid (STL file; represents the 3D surface).
■ Black: Original 2D contour of the vector graphic.
■ Red: Projection of the vector graphic onto the surface.

The display can be rotated freely in space using the mouse cursor. You can zoom in and out
using the mouse wheel.
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The [Cube] button opens a submenu where you can directly select the room view:

■ Top: View from above ■ Front: View from the front
■ Left: View from the left ■ Right: View from the right
■ Back: View from the rear ■ Bottom: View from below

Step 3 Generating 3D vector graphic

Click [OK] to generate the 3D vector graphic and return from the dialog to the main view.

You can then view the position of the 3D vector graphic in the working volume using the
options in the viewport and continue to transform if necessary (see page 32, Viewport).

Fig. 7.63: RG-AGV
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7.2.7 Automation Objects
Automation objects are primarily used to create interactions - with the operator or with
external control devices.
Automation objects can be added directly by dragging them to the desired flow position in
the job tree. When dragged into the viewport they are added after the current selected
object. 
If you click the icon, the settings dialog opens. The object is added after the earlier active
object, once you click [OK].

Common Settings of Automation Objects

Setting Explanation

Short label A name for this object that is easy to remember

Enable binning To open the detailed port and signal configuration

I/O controller The control card which receives the signal

I/O port Port of the control card which receives the signal

Table. 7.40: RG-039

There are five automation objects:

7.2.7.1 Wait for External Start

Button

This object causes the execution to wait for a trigger signal – for the primary start and for
each execution loop. That means it is often the first object in the job. It can also be used as a
pause within a job.

NOTE: The job has the “active” status even when waiting.

NOTE: The input for the trigger signal on the SP-ICE-3 control card (pin: START_MARK) is
sensitive to edges.

Specific settings are:

Setting Explanation

I/O controller Select the control card that receives the trigger signal. Currently, only SP-ICE-3
control cards can be selected.

Timeout [ms] Select a time other than zero to provoke an error message if the start signal is
not registered on the selected control card within this time period.

Table. 7.41: RG-040
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7.2.7.2 Waiting for port

Button optional, 
see page 130,
Objects Overview

This object ensures that execution stops or only continues if a state defined in the automation
object is present at the selected input (port).

NOTE: The job has the “active” status even when waiting.

Specific settings are:

Setting Explanation

I/O controller Select the control card that provides the port where the I/O signal is expected.
Currently, only SP-ICE-3 control cards can be selected as I/O controllers.

I/O port Configured input port to be used at the selected control card.

See page 49, Scan Controller Configuration

NOTE: In case the IO port bit area has been changed after adding the
automation object to the job, a warning will be shown in the Write port dialog,
and at the same time a dialog will be offered with a direct option to refresh the
port bit area.

Port value Set the bit pattern that must be received for this object to consider the wait
condition fulfilled and continue job execution.

NOTE: The condition may also be fulfilled before it is the object’s turn.

Timeout [ms] Select a time other than zero to provoke an error message if the expected bit
state is not registered on the selected control card port within this time period.

Table. 7.42: RG-089

7.2.7.3 Delay

Button

Inserts a waiting time before the next object is executed.

Specific settings are:

Setting Explanation

Delay Duration of the delay in [ms]

Scan controller Defines the target control card with which the object is executed.

Table. 7.43: RG-041
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7.2.7.4 Dialog

Button

Makes a pop-up dialog in the viewport, for example, to ask if the process should be
continued.
The message box offers two different choices:

■ [OK] button to continue execution

■ [Cancel] button to abort execution

NOTE: The dialog object is executed in the “On PC” execution mode only, which is to say that
the dialog is displayed in the GUI accordingly.

The job execution pauses as long as there is no reply to the message.

Specific settings are:

Setting Explanation

Title Heading of the message box

Message Suitable message text

OK label Suitable text to indicate continuing the execution

Cancel label Suitable text to indicate aborting the execution

Is modal When activated, the dialog blocks the remaining execution of the RAYGUIDE.

Variables

Prompt for value When activated, the content entered in the dialog is transferred to the variables
defined below.

Name Enter a unique name for the variable here.

NOTES: The field can only be used if the request Value option is activated.

The variable can be used to transmit content to text / barcode objects.

Table. 7.44: RG-042
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7.2.7.5 Write Port

Button

Used to define a bit pattern which is set on a specific I/O port of the control card.

Typical use cases:

■ Another control device is polling this information.

■ Triggering a specific device that responds to a trigger edge, e.g., the START_MARK input
of another SP-ICE-3 control card.

IMPORTANT: The I/O settings remain like this until they are reset by another write port
object, unless the “Pulse” option is used.

Setting Explanation

I/O controller Defines the target I/O control card with which the object is executed. Currently,
only SP-ICE-3 control cards can be selected as I/O controller.

I/O port Configured output port to be used at the selected control card.

See page 49, Scan Controller Configuration

NOTE: In case the IO port bit area has been changed after adding the
automation object to the job, a warning will be shown in the Write port dialog,
and at the same time a dialog will be offered with a direct option to refresh the
port bit area.

Port value / mask Define the bits (port pins) to be activated or the bits to be toggled.

Mode Select one of the available modes:

■ Write value

■ Create edge

■ Create pulse

■ Toggle: Changes the polarity of the masked bits.

Setup time [ms] Defines the time in [µs] that the complementary bit value is set in advance to
generate a signal edge or a pulse

Pulse width [µs] Defines the time in [µs] that the value is held before the second signal edge to
create a pulse
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Setting Explanation

Timing Diagram Shows live how the time values affect the signal sequence.

Use expander to view the signal sequence of each bit.

NOTE: The polarity of the logical edge / pulse does not have to be the same as
the electrical polarity of the signal. This depends on the high / low configuration
of the port.

Table. 7.45: RG-043
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7.2.7.6 Arming / Disarming laser

Button

The automation object can be used in any job sequence position to switch the laser status
between "armed" and "disarmed".

In addition, the visible pilot laser can be switched on and off.

NOTE: Most lasers do not permit laser emission while the pilot laser is active. For this reason,
we recommend activating the pilot laser only if the laser is "disarmed".

Application example:

This switch may be necessary, for example, to return a laser that is in the error state to the
operating state.

Application example with pilot laser:

Lets you define a job that runs in stand-alone mode for preview purposes.

Fig. 7.64: RG-AED
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Setting Explanation

Laser Select the corresponding configured laser.

Laser action Select whether, at this point in the job sequence, the laser is to be armed,
disarmed, disarmed and power set to zero, or if no action is to be performed.

Write complement before Define whether an action that is complementary to the defined action (arm,
disarm) is to be performed for the laser to ensure a signal edge.

Setup time [ms] Enter a time in [µs] for which the complement status is set in advance.

Pointer action Select whether, at this laser in the job sequence, the pilot laser is to be
activated, deactivated or if no action is to be performed.

Table. 7.46: RG-078

7.2.7.7 Send Enhanced Command

Button optional, 
see page 130,
Objects Overview

The automation object can be used to send an extended command to the deflection unit in
any sequence position, e.g. to switch the tuning and therefore the dynamic behavior of the
deflection unit.

Setting Explanation

Deflection unit Select the corresponding configured deflection unit.

Axes Select the axes to receive the command.

NOTE: Currently, only the X/Y-axes are available as a bundle to receive enhance
commands.

Command Select the type of command.

NOTE: Currently, the only available command is the command to set an
available tuning of the deflection unit.

Tuning 8 Select an available tuning of the chosen deflection unit.

The selection lists the tunings by name.

Delay 8 Enter the time required for the deflection unit to switch to another tuning set.

Table. 7.47: RG-079

8 NOTE: The appearance of these fields depends on the selection of the command.
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7.2.7.8 Write to Serial Port

Button optional, 
see page 130,
Objects Overview

Send a command line to a preconfigured serial port, see page 49, Scan Controller
Configuration.

Specific settings are:

Setting Explanation

Serial Controller Select the target serial port controller. A possible selection can be the serial port
of the PC or the serial port of a SP-ICE-3 control card.

Serial Port Port name to be used

Add message Opens a field where a command line can be entered. The text can be copied for
multiple messages with individual responses.

Expected response Activate if a response is expected. The expected string must be entered. 
If the response is the expected string, the execution continues. If not, you get a
timeout warning.

See the documentation of the recipient device for available commands and
response.

Delay Set a time delay between a response and sending of the next command line.

Table. 7.48: RG-044
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7.2.7.9 Sending control card command

Button optional, 
see page 130,
Objects Overview

You can use this automation object to send a command to the control card at any position in
the sequence.

Only one command is currently available.

Setting Explanation

Command Only the command for setting a so-called trace label is currently available for
selection.

Trace label A Trace label is a kind of marking in the job list of the control card. Other
programs, for instance the RAYBOARD PROCESS DATA ANALYZER can use Trace
label to trigger recordings.

Enter the number of the label for this position in the job process.

7.2.7.10 Setting the correction file index

Button optional, 
see page 130,
Objects Overview

If configured accordingly (see page 73, General), this automation object can be used to
define, and thus change, the correction file used on the control card. The definition is created
by specifying the index of the correction file.

Setting Explanation

Scan controller Selects the control card on which the index for the correction file is to be set.

Index Defines the index of the correction file that is to be set by the automation
object.

Table. 7.49: RG-084
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7.2.8 Templates
Templates can be stored so that job elements with specific settings can be reused at any time.

Templates can be used for all job elements (1st tab) – this also includes containers and
automation objects – or exclusively on fill patterns (2nd tab).

Job element templates

Select an object (in the viewport or in the job tree) and select Save as template from the
context menu. In the dialog, the following setting are made:

Setting Explanation

Name An appropriate name for this job element

Use as default This sets this template with your specific settings as the default for this object
type and is thus the starting point for all newly added objects of this object
type.

Importable layout objects, for example, bitmaps or vector graphics, do not allow
a default template definition.

There can only be one default template for each object type. If no template is
set as default, the system provides the default.

The default object is indicated by a checkmark in the object menu list as well as
in the template panel.

NOTE: The currently assigned pen is not saved as part of a default object
template.

Include filling Includes the object filling as part of the template.

Include transformation Includes the transformations which have been made for this object so far. This is
useful to always apply the template in a specific position of the workspace.

NOTE: The object pen is only stored as the pen number, not with the pen properties.

Table. 7.50: RG-045
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Fill templates

To store a fill pattern as template, use the [Save] button on the filling tab in the object
properties menu.
Click on the [Load] button for a list of all available fill templates that can be used directly.

Template panel

The template panel contains all saved templates. They are divided into two tabs, so you can
manage / apply them from here.
The [Create] button adds the job element to the active job.

The [Single check] button applies the filling to all selected layout objects. All previous fill
patterns are replaced.

The [Double check] button applies the filling to the selected layout objects in addition to
any existing fill pattern.

The [Delete] button removes the template entry.
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7.3 Process Parameters (Pens)

7.3.1 About Pens
A pen is a collection of process parameters, telling the laser system (laser and deflection unit)
how to process a specific job, a specific object, or even a single graphic element.

The name "pen" reflects a hand-held pen used for writing or drawing. Just like a normal
writing implement (pencil, ballpoint pen, felt-tip pen, marker, etc.) creates a different effect
on the drawing paper, each RAYGUIDE pen also processes your graphic object in a different
way. This means that the pen settings essentially define the result of the application.

Pens are clustered in pen sets. RAYGUIDE administrates pen sets as a kind of library, called
library pen sets. The library pen sets can be seen as templates. Every job is provided with a
pen set that is assigned to the job and called the base pen set.

■ The base pen set is always a duplicate of the default library pen set and can be edited as
part of the job without any impact on the stored template.

■ The base pen set is connected to its job. It is saved within the job file and shows up
wherever and whenever the job is loaded.

Once you load a job, the possible scenarios are:

■ The base pen set of the job has the same name as a library pen set. The pens of both pen
sets may or may not be equal. In any case, only the current settings of the base pen set of
the loaded job apply.

■ The base pen set of the job comes from another RAYGUIDE system, and no library pen set
of the same name exists. In this case, the pen set is shown as "Unlinked".

If a pen of the default library pen set is modified, the change has no direct effects on the base
pen set of the job, unless you refresh the base pen set in the job settings menu. In the job
settings menu, you can also switch from the default pen set to another library pen set.

It has been specified that pens and layout elements are managed separately. However, every
layout element is linked at least to one pen. A newly created graphic object uses the default
pen of the base pen set when created.

The pens of the base pen set are listed and maintained in the Pen panel. See page 266, Pen
Panel.
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7.3.2 Pen Set Configuration
Open the pen sets configuration dialog from the RAYGUIDE menu: System > Library pen
sets > Configure….

You can access all pen sets in the library, add new pen sets to the library, add pens to a pen
set, edit pen parameters, rename pens, etc.

The Configure… option under System > Library pen sets lists all available pen sets. One
pen set is intended to be the default pen set, indicated by a checkmark in front. Right-click on
another pen set in the list if you want to use this pen set as the default. The "owners" of the
respective pen sets are also displayed here.

Click on a listed library pen set to access it directly.

RAYGUIDE distinguishes two types of library pen sets:

■ System pen sets are available to all users listed on the System tab

■ Specific pen sets created by users are available only to their respective owners and are
listed on the User (current user) tab

Available library pen sets are available via a drop-down list.

After installation, RAYGUIDE comes with one sample library pen set, called the system pen
set. The system pen set is the only pen set that cannot be removed.

In a library pen set, all pens starting from pen no. 1 derive their parameter values from master
pen no. 0. The master pen no. 0 cannot be deleted.

Toolbar

All functions of the pen panel toolbar apply to the selected pens. To select a pen in a pen set,
click the pen entry. The pen is now highlighted in gray. Use [Ctrl] to select multiple pens.
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Tool Function

[Copy]

[Cut]

[Paste]

[Special paste]

A pen selection can be copied or cut out and saved in the clipboard and pasted
into another pen set – and thus also in another library pen set or the base pen
set of an open job.

When you paste pens from the clipboard into a pen set, the target pen set
probably already contains pens with the same number. If so, a confirmation
dialog is displayed:

■ Replace: Replaces all pen parameters.

■ Merge: Replace only pen parameters that are not protected (protected
parameters are shown in italics and bold).

■ Copy as new: Add the pens as new pens, while they get subsequent pen
numbers in the target pen set.

Click on [Skip] to do nothing and proceed to the next pen. Mark Repeat for all
conflicts to select the same option for all pens in the clipboard.

If multiple pens are in the clipboard, the confirmation dialog is repeated for
each pen.

When using the “special paste” option, the pen from the clipboard will replace
master pen #0 instead of the respective pen number.

[Lock / Unlock]

[Reset]

Use [Lock / Unlock] to ensure that all parameters are protected against
overwriting if a pen is pasted in.

Use [Reset] to remove all previous parameter changes (reset to master pen
values) and at the same time unlock all pen parameters.

[Edit selected pens] This option allows you to edit parameters of multiple pens at the same time.
The pen form opens and parameter fields where several pens contain different
parameters are indicated by Multiple.

Editing the parameters affects all selected pens and the linked layout objects.
Untouched parameters remain as before.

[Delete] Deletes the selected pen.

[Factory reset of
system pen set]

This option sets all values in all pens to default values and creates the default
number of pens in the set.



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 266MN_RAYGUIDE [V2.11]

Tool Function

[Edit name] Releases the name field of the library pen set for processing.

[Set as default] Defines the current library pen set as the default pen set.

[Add pen] Adds an additional pen with the default parameters to a pen set.

[X] Deletes the respective library pen set.

(located in the right
lower corner of the
dialog)

Add a new library pen set.

Any new library pen set always has eight pens.

Table. 7.51: RG-046

Otherwise, the pen list in the pen configuration menu behaves similar to the pen list in the
Pen panel, which is described in the following chapter.

7.3.3 Pen Panel

Fig. 7.65: RG-ACM

This where you can edit, add and manage the pens used in the current job.

CAUTION: A pen number only is only used once within a pen set. That means you can assign a
name to each pen to better distinguish it from other pens that have the same pen number.

An * (asterisk) indicates that this pen differs from its reference pen. The [Reset] button is
activated so that you can reset the pen to the original parameters if required.
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The list contains:

■ Standard pen – This pen is used for all newly added layout objects. It is displayed in bold.

■ Display columns – There are two columns (O = outline, F = filling) that show whether a pen
is linked to at least one layout object. If you have selected a layout object, you will see a
checkmark next to the pens linked to the object in these columns. If no layout object is
selected, all linked pens are marked with a dash.

■ Parameter columns – In the standard view, only the main values of the pen are displayed.
To edit the columns, see page 270, Customize Pen Panel View.

■ To edit a value directly in the column, double-click on the cell to open it for editing. If you
double-click on cells with predefined content, the selection is switched to the next possible
content in the sequence.

■ Pen color ─ The pen color can be changed. Right-click on the color field to display an
extensive color palette for selecting a new color.

7.3.3.1 Pen Panel Tool Bar
All functions of the pen panel toolbar apply to the selected pens. To select a pen in a pen set,
click the pen entry. The pen is now highlighted in gray. Use [Ctrl] to select multiple pens.

Tool Function

[Copy]

[Cut]],

[Paste]

A pen selection can be copied or cut out and saved in the clipboard and pasted
into another pen set – and thus also in another library pen set or the base pen
set of an open job.

When you paste pens from the clipboard into a pen set, the target pen set
probably already contains pens with the same number. If so, a confirmation
dialog is displayed:

■ Replace: Replaces all pen parameters.

■ Merge: Replace only pen parameters that are not protected (protected
parameters are shown in italics and bold).

■ Copy as new: Add the pens as new pens, while they get subsequent pen
numbers in the target pen set.

Click on [Skip] to do nothing and proceed to the next pen. Mark Repeat for all
conflicts to select the same option for all pens in the clipboard.

If multiple pens are in the clipboard, the confirmation dialog is repeated for
each pen.
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Tool Function

[Lock / Unlock]

[Reset]

Use [Lock / Unlock] to ensure that all parameters are protected against
overwriting if a pen is pasted in.

Use [Reset] to remove all previous parameter changes (reset to master pen
values) and at the same time unlock all pen parameters.

[Edit selected pens] This option allows you to edit parameters of multiple pens at the same time.
The pen form opens and parameter fields where several pens contain different
parameters are indicated by Multiple.

Editing the parameters affects all selected pens and the linked layout objects.
Untouched parameters remain as before.

[Delete] Deletes the selected pen(s), unless one of them is linked to a layout object.

[Highlight pen] Highlights the selected pen in the job tree (in blue). That means you can easily
detect all layout elements linked to this pen – sometimes, the color signature in
the viewport may not be sufficient.

NOTE: Expand the job tree fully to see the highlighting.

[Forward current pen
values]

Sends the current pen values to recalculate the object and job statistics. In the
process, the "expected execution time" is also updated.

[Transfers the pen set] Transfers the pen set of the current job to the pen library. Four different options
are available for selection:

The job pen set:

■ Created as a new system pen set

■ Created as a new user pen set

NOTE: For newly created pen sets, there is also the option of renumbering
the pens, for instance to avoid gaps in numbering.

■ Overwrite the pen set currently defined as the default

■ Overwrite the corresponding base pen set

[Update pen list] This function is used to update the pens of the job with the values of the
corresponding base pen set.

Table. 7.52: RG-047
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Editing pens

Newly generated pens probably do not have the appropriate parameters for your application.
That is why it is necessary to edit the pen parameters.

You can edit pens…

■ In the pen configuration, after selecting the desired library pen set.

■ In the Pen panel, listing the Job / Objects / Container pens used in the current job.

■ Via the Edit pens tab of the object.

■ Via the Settings tab of the individual layout elements, use the pen number assigned to the
object by clicking on the [Edit] button.

■ Via the Filling tab, use the [Edit] button right next to the pen number assigned to the
filling

After editing a pen, select the appropriate saving option. See the pen saving options in the
table in the following chapter.

NOTE: The Save as object pen option is only available if you have selected the “Edit pens” tab
through the Properties dialog of any Container / Object / Geometry element / Filling.

Object pens

The object pen is a special type of pen that is not owned by the job. While a job pen can be
shared with other objects, the object pen is owned by a single object only.

Containers are also treated as objects and therefore also may use object pens.

Another feature of the object pen is that the object pen takes over all parameters from the
respective job pen (= same pen number); only the protected parameters are excluded from
this.

An object pen may be useful if the object shares its most important parameters (for example,
speed, laser power, etc.) with another object, but will also require an individual property, for
example, special wobble settings.

The number of an object pen is marked with an asterisk (*) in the drop-down list of pens. This
list is located on the Pen tab in the associated object settings.

If an object is selected in the job tree or in the viewport, the Pen panel will list only pens (job
pens and object pens) used by that object.

An edited pen typically contains valuable process parameters which may be applied to
upcoming jobs as well. We therefore strongly recommend storing edited pens in an
appropriately named library pen set.

NOTE: The pen panel always indicates if the listed pens are job-related pens or object-related
pens.
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7.3.3.2 Customize Pen Panel View
In order to display all desired values of the pens in the column overview, you can select the
values to be displayed yourself. The related context menu offers you all the necessary options.

Fig. 7.66: RG-ADV

Setting Explanation

Display Under Display you will find all pen values grouped in sub-selections.

Check the ones you want to display or uncheck them if you no longer want to
display them.

Options The Short header option reduces the column header to an acronym to reduce
the column width, while the tool tip continues to display all the information.

The Enum as index option lists the enumeration number instead of the text of
the drop-down list. This also serves to reduce the column width.

[Refresh] You can select one or more cells (keep [Ctrl] pressed) and reset these values to
the default pen values.

Set as default pen
number

Define the default pen to be used for all new graphic objects.

[Export] This option allows you to export selected (referring to the column view) or all
pen values to a CSV table.

Table. 7.53: RG-075
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7.3.4 Pen Properties
Pen parameters are specified in a dialog. The pen settings dialog covers all possible process
parameters, regardless of the actual capabilities of your system.

Fig. 7.67: RG-ACN
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In the pen settings dialog, a red label indicates which parameter fields were edited since the
dialog was opened.

Edited pen parameters are displayed in italics and bold (change indication). These parameters
are protected against overwriting in case the pen itself gets overwritten or "refreshed". To
reset these parameters to the original value, click on [Reset].

The Edit pens dialog can be reached in different ways: Using the [Edit pen] button from a
pen set list (configuration menu of stored pen sets / base pen set in the Pen panel), via the
Edit pens tab of a layout object, or by using the [Edit pen]  button next to the drop-down
list for assigning pens.

Setting Explanation

Pen 9 Select a pen to be edited.

NOTE: Tooltips indicate whether the pen is a job pen or an object pen.

Name Optional name of this pen.

Should mark Check this if objects/elements assigned to this pen should be marked. Deselect
the option to unmark objects that should not be assigned. (The selection is set
to active by default.)

Color Select an on-screen color for a better overview of which graphic element uses
which pen.

Laser

Laser power [%]

Laser power in [%]. The percentage does always refer to a 100% scale. The
range limitation in the laser configuration will not restrict this value entry, but
will report warnings when the respective job validation is activated. See page
336, Running a Job.

Can also be defined in absolute units, i. e. in [watts], with the appropriate
preselection. See System > Preferences > User > UI.

The scale factor for conversion from [%] to [watts] is defined in the laser
configuration, see page 59, Laser Controller Configuration.

Frequency [kHz] Value in [kHz]. Defines the pulse rate of the LM signal.

Laser on delay [µs] Values in [µs] to synchronize the laser activity with the mirror position at the
start and end of a laser path. Can also be set with a negative sign.

Laser off delay [µs]

9 NOTE: This option is only available when the pens tab in the properties dialog of a marked job element is
opened.

10 NOTE: The availability of these pen parameters depends on the configured lasers and on the settings
under System > Preferences > System (all users) > Visibility > Pen.
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Setting Explanation

Optical pulse width
[index]/[ns] 10

Select the index for the APD mode.

Depending on whether you have set up the additional serial connection to the
laser, values for the respective pulse duration are displayed in addition to the
index. See page 69,  IPG laser type YLPN APD .

NOTE: An APD mode change always means that the laser emission must be
switched off briefly. For this reason, avoid making the change within a laser
path.

Optical pulse width [ns] 10 Specification of the optical pulse width for JPT MOPA Laser in [ns].

NOTE: Observe the valid value range according to the specifications of the laser
manufacturer.

Beam profile index 10 Select the index for the beam profile of the nLight AFX laser.

NOTE: A beam profile change always means that the laser emission must be
switched off briefly. For this reason, avoid making the change within a laser
path.

Power correction Select to activate SP-ICE-3 function for speed-based power correction.

Operating mode 10 Choose between the Pulsed or CW (continuous wave line) operating modes.

Waveform 10 Number of the pulse form, which then defines the pulse width.

Simmer power [%] 10 Value in [%] that translates into the 0-10 volt range for the simmer voltage.

Secondary power [%] 11 Laser power in [%] for a possible secondary laser source, such as for ring mode
when using an IPG YLS AMB or Coherent Highlight ARM laser.

Can also be defined in absolute units, for instance in [watts], with the
appropriate preselection. See System> Settings > User > UI.

The scale factor for conversion from [%] to [watts] is defined in the laser
configuration, see page 59, Laser Controller Configuration.

11 NOTE: This parameter is an alternative to the simmer power parameter and is only available if an analog
laser with a second power channel has been configured.
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Setting Explanation

Mark timings

Mark speed Speed in [m/s] of the laser spot on the material.

If desired, it can also be defined in [mm/s] by corresponding preselection. See
System > Preferences > User > UI.

Mark delay [µs] Value in [µs]. The value relates to the dynamics of the deflection unit. Value will
apply after a marking vector, prior to a jump vector.

Poly delay [µs] Value in [µs]. The value relates to the dynamics of the deflection unit. The delay
will apply at the transition point of two consecutive marking vectors.

Variable poly delay Select this option to activate the SP-ICE-3 Variable poly delay function to shorten
the effective value for a polygon delay depending on the change of heading
angle.

Jump timings

Jump speed Relative speed in [m/s] or [mm/s] when the deflection unit changes position
without laser emission.

Jump delay [µs] Value in [µs]. The value relates to the dynamics of the deflection unit. The delay
will apply after a position jump.

Variable jump delay Trim the effective jump delay dependent on the length of the jump vector. This
is useful to adapt the jump delay automatically in cases where jumps are short
and the deflection unit cannot reach full speed.

Min. jump delay [µs] When using a variable jump delay, enter a value for the minimum delay,
independent of the jump length.

Jump lenght limit [µm] When using a variable jump delay, enter a value for a jump length limit. If
exceeded, the main jump delay value is used.
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Setting Explanation

Skywriting

Skywriting mode Select the suitable Skywriting mode:

■ No skywriting

Skywriting is not active

■ Force at start and end

Skywriting at is always performed at each vector start and end independent
of the change of heading angle between the jump-to-mark or mark-to-jump
transition. The change of heading angle (CoH) is only taken into account at
the mark-to-mark transition.

■ Minimum angle

The CoH angle is taken into account for all transitions (jump-to-mark, mark-
to-mark, mark-to-jump).

Min. Angle [°] Enter a change of heading angle which if exceeded determines whether
Skywriting will be applied between two consecutive vectors.

Extension time [µs] Time used to calculate the length of the acceleration/deceleration vectors in
consideration of the marking speed of the related mark vectors.

Deceleration delay [µs] Delay in [µs] which appears after the deceleration vector, prior to the “u-turn”
jump.

Acceleration delay [µs] Delay in [µs] which appears after the “u‑ turn” jump, prior to the acceleration
vector.

Skywriting

Laser off delay [µs]

Delay in [µs] to synchronize the laser emission on transition from mark-to-
deceleration vector.

Skywriting

Laser on delay [µs]

Delay in [µs] to synchronize the laser emission on transition from acceleration-
to-mark vector.
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Setting Explanation

Ramping

Defines a linear laser power ramp that is applied to every path of the layout that is linked to this pen.

RULE: The ramp always applies per path element. That means the ramp needs to be defined in the pen that
is assigned to the path level. Any new power value or other ramps due to a pen change within the path will
be ignored.

NOTES:
■ The overall length of both ramps can be validated to not exceed the length of the affected path. See

page 336, Running a Job.

■ For drill objects, use only time-based ramping.

■ Not applicable for bitmaps.

Ramping Select No ramp if you do not want to create a ramp.

Select Time if the ramp segment X-axis is to be defined by time intervals
(unit = [ms]).

Select Distance if the ramp segment X-axis is to be defined by length
(unit = [mm]).

If you select Time or Distance, the fields for entering the ramp values for start
and end segment ramps are displayed.

Displayed channel Selection of whether to define and display the power ramp for the primary or
secondary power channel.

NOTE: This selection is only available if the laser in use has a second power
channel configured.

Start segments / End
segments

To define the start and end segments of the ramp, use the [Edit table] button.
This opens the editing menu.

By selecting the displayed channel, you determine whether the ramp applies
to the primary or secondary power channel (you define whether the laser has a
secondary power channel in the laser configuration).

NOTE: The ramp graphic displayed in the pen menu is for viewing purposes only
(double-click on the graphic to open the editing menu). The individual values of
the support points are displayed when the mouse pointer is moved over them.

Editing menu:

The support points of the ramp can be added directly to the graph with a mouse
click. As soon as the mouse pointer changes from an arrow to a hand, the
support points can be moved with the mouse.

By default, the first or last support point is inserted 50 ms (or a distance
converted to the marking speed) before or after the point at which the power
has its constant value.

Each support point is also created as a line in the respective table. Here you can
also specify or adjust the values (time/distance and power) discretely.

If you want to assign the power of the pen to a support point, use the
corresponding checkbox.
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Setting Explanation

t(S) is the start point of the start segment and t(E) is the end point of the end
segment. Accordingly, the time/distance values of the end segment have a
negative sign, as they are defined backwards from the end point.

NOTES:
■ If the power at the end of the start segment is not equal to the power at the

beginning of the end segment, this generates a change in power throughout
the entire remaining path length. How steep this power curve is effective
depends on the length of the path, which can always be of different lengths.

■ When switching between time-based and distance-based ramps, the
conversion is carried out automatically using the marking speed specified in
the pen.

[X] deletes the selected line and the associated support point.

[Litter bin] deletes the entire ramp segment.

Example:
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Setting Explanation

Dashed line

Feature to modulate the laser emission (on / off) along a path while the process speed is kept constant
(without any jump / mark delays, similar to a bitmap line)

RULE: At the beginning of a new path, the pattern starts anew. Accordingly, the pattern from the previous
path is not continued.

NOTES:

Not applicable to drill points and bitmaps.

The pattern is displayed in the viewport, but is not visible when in edit mode.

Dashed line Activate this option to use the dashed line feature.

Dashed line pattern [mm] Define the dashed-line pattern by entering length values for laser on / off.

Enter at least two numbers. 
The first value defines the dash length that the pattern starts with. 
Separate values for dash / gap with blanks. 
You can also create a pattern that consists of more than two parameters.

Example:

2 3 2 1 creates repeated patterns of 2 mm line, 3 mm gap, 2 mm line, 1 mm gap.

The preview below displays the pattern according to the values.

Dashed line offset Enter the value in [mm] by which you want to shift the dashed line pattern in
relation to the vector start.
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Setting Explanation

Magnification

Used to increase the diameter of the laser spot.

Magnification is only applied when a deflection unit of the RAYLASE AXIALSCAN, AS FIBER or AM-MODULE
type is used. Either SL2 or RL3 must be selected as the protocol. Also, the correction file must support the
4th dimension (labeled, for example, 3D+M).

The magnification factor is transmitted to the control card as the 4th dimension of a vector coordinate. The
correction file translates this values to the defocusing (AXIALSCAN, AS FIBER) or zoom function (AM-
MODULE) or to even zoom, followed by defocusing.

NOTE: RAYGUIDE visualizes the magnification factor in the viewport by drawing the affected contours n-
times thicker.

Speed Defines a time ramp in [1/s] over which the spot magnification is achieved.

NOTE: This value must never be 0.

Factor / Spot size [mm] Magnification factor.

Default: 1 = No magnification

Alternatively, the absolute spot size in [mm] can be defined. To do so, the global
unit must be set accordingly (see page 110, UI) and the conversion factor
defined (see page 73, General).

Zoom async Deactivate if the magnification is to be achieved immediately without a
designed time ramp.

NOTE: With this option deactivated, the laser is briefly switched off during the
transition from no magnification to magnification.
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Setting Explanation

Wobble

The wobble function imparts additional complex harmonic motion to the laser beam in the XY plane when
the laser is active.

To understand the mathematical correlation of the wobble parameters, please refer to the manual for SP-
ICE-3, chapter 9.2.2.

On the right side of the input fields, a preview of the resulting wobble shape is displayed while making the
entries because the wobble shape is not shown in the viewport.

Wobble mode Select No wobble if you do not want to use the wobble function at all.

Select Circular if you want a circular wobble shape.

Select Eight if you want a figure-of-eight wobble shape.

Select Custom if you want to define a Lissajous-figured wobble shape.

Frequency Set a frequency in [kHz] at which the wobble shape is repeated.

Amplitude [mm] Set an amplitude in [mm] to define the size of the wobble shape.

Resulting amplitude
[mm]

Specification of the amplitude that is achieved as a result of the dynamics of the
deflection unit.

The resulting wobble geometry is marked in the plot:

■ Green: If it is within the "allowed" range of values.

■ Red: If it is outside the "allowed" range of values.

The "allowed" value range roughly defines when the deflection unit is
overstressed, and thus possibly damaged.

NOTES:
■ For the display, the tracking error value of the deflection unit used in the

active job is used. If deflection units with different tracking error values are
used in a job, the largest value is taken. For deflection units with multi-
tuning, the tracking error value from the tuning set as active is used.

■ When moving the mouse over the label, the resulting speed range of the
laser spot along the actual wobble trajectory is also displayed.

Phase [°] Only for Lissajous-figured shapes. Set a phase offset for each of the two sinus
functions.
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Setting Explanation

Pen saving option

Apply to current pen Changes will apply to the current selected job pen.

Apply as new pen A new job pen with the current values is created and added to the pen set.

Apply to object pen The values are stored in a new so-called "object pen" that belongs to a single
object.

This option is only available if the pen settings dialog was opened via an object
dialog (Object settings dialog, Pen tab).

Table. 7.54: RG-048

IMPORTANT: Modifying a pen changes the processing parameters of all objects (and layers,
etc.) to which this pen is assigned. When in doubt, it may be advisable to select the Apply as
new pen or the Apply to object pen options to avoid unwanted effects.
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Related presets

For some pen settings, you can preset the visibility in the dialog. Those presets act “globally”
on all used pens.

CAUTION: Hiding the display of a pen feature does not disable the related functionality. That
is why, before hiding the display of a pen feature, you should make sure that no part of the
feature is used.

Select System > Preferences from the menu to open the Settings dialog. Go to the System
(all users) tab and to the Visibility sub-tab, Pen section.

Fig. 7.68: RG-ACO
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Setting Explanation

Skywriting Select if this option should be available in the pen settings.

Ramping Select if this option should be available in the pen settings.

Dashed line Select if this option should be available in the pen settings.

Wobble Select if this option should be available in the pen settings.

Hardware-dependent

The fields listed under the expander are only displayed in “auto” mode if the laser used has this setting
option.

Pulse width Select if the laser pulse width is to be shown in the pen settings. You can select
from the Show, Hide and Auto options.
If Auto is selected, the parameter is only displayed in the Pen dialog if the pulse
width definition is set to manual in one of the configured lasers.

Simmer / Secondary
power

Select if this laser parameter is to be shown in the pen settings. You can select
from the Show, Hide and Auto options.
If Auto is selected, the parameter is only displayed in the Pen dialog if a
corresponding laser has been configured.

NOTE: If you are using a TruPulse Nano / SPI G4 laser, the parameter for the
simmer voltage would be displayed, while if a laser with two power channels is
used, the parameter for the secondary laser power would be displayed.

Operating mode Select if this laser parameter is to be shown in the pen settings. You can select
from the Show, Hide and Auto options.
If Auto is selected, the parameter is only displayed in the Pen dialog if a
corresponding laser (e.g. TruPulse Nano / SPI G4) has been configured.

Waveform Select if this laser parameter is to be shown in the pen settings. You can select
from the Show, Hide and Auto options.
If Auto is selected, the parameter is only displayed in the Pen dialog if a
corresponding laser (e.g. TruPulse Nano / SPI G4) has been configured.

Optical pulse width Select if this option should be available in the pen settings. You can select from
the Show, Hide and Auto options.

If Auto is selected, the parameter is only displayed in the Pen dialog if a
corresponding laser (e.g. IPG YLP APD) has been configured.
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Setting Explanation

Beam profile index Select if this option should be available in the pen settings. You can select from
the Show, Hide and Auto options.

If Auto is selected, the parameter is only displayed in the Pen dialog if a
corresponding laser (nLightAFX) has been configured.

Spot Magnification Select if this option should be available in the pen settings. You can select from
the Show, Hide and Auto options.

The setting is available / visible if one of the configured deflection units has at
least four axes, according to its correction file.

Table. 7.55: RG-049

7.3.5 Pen Assignment
Assigning a pen set to a job

Each job has a base pen set which corresponds to the stored default pen set (see page 263,
About Pens).

To assign a different pen set than the default pen set, open the job settings dialog (Job >
Settings). In the Base pen set drop-down list, select the desired pen set.

NOTE: If the job already contains layout objects that are linked to pen numbers, the links to
the specific pen numbers are maintained when the pen set is changed. However, after the
change to the pen set, each pen number points to a pen with different pen parameters.

Assigning a pen to an object, a layer, a path, or a command

By default, a newly created object (as well as its layers and paths) in the layout uses the
default pen (e. g. #1) of the base pen set of the job. After this, it is possible to assign another
pen to this object or layout element.

The pen for a graphic object is assigned by one of the following methods:

■ On the "Properties" tab of the layout object, in the "General" area. For layers and paths,
pens are assigned via the respective settings dialogs. Next to the pen selection, there is
always a button for direct navigation to the pen dialog, where the respective pen
parameters can be edited as necessary.

■ You can do this by selecting the graphic element, either in the job tree or in the viewport
(multi-selection possible) and then using the [Assign pen to selection] button in the line
of the desired pen in the pen panel.
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NOTE: If a pen on a lower Hierarchy level was changed, the new pen assignment is protected
from future pen assignments at higher levels.

To change the pen inside a path:

■ Add a "set pen" command between existing graphic commands

■ Select the contour area in the viewport, for example by dragging with the mouse, and
right-click on the highlighted selection in the job tree. In the context menu that opens,
click on the Change pen... option and select the desired pen number in the drop-down
list.

A different pen may be required than for a contour (by default, RAYGUIDE fillings assigns the
same pen as for the contour) for filling graphic elements. That means you can also change the
pen used to process the filling in the Filling tab. A manual change of the filling pen results in
a protection function against pen changes of the contour pen.
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7.4 Pen parameter finder
The pen parameter finder is designed to help you find the appropriate settings for your laser
application. It essentially creates a matrix of layout objects, allowing you to select two
parameters, each of which changes in X-axis and Y-axis tilting directions according to your
specification. These parameters are essentially values from the pens and certain values for
fillings.

After executing the resulting job, you can use the process results to decide which parameters
provide the best process result and save them for further use, for example, in the pen library
or as a fill template.

Start the Parameter finder via the main menu: Tools > Parameter finder > Pen

The dialog of the pen parameter finder offers the following setting options:

Fig. 7.69: RG-AEV
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Setting Explanation

The buttons allow you to save the settings defined in the dialog, load already
saved settings or delete a saved setting.

Base job Select the job that contains the layout object(s) you want to use for the
parameter search.

You can either use an already open job or load an already saved job.

In case you load an already saved job for this, it will be additionally loaded into
the drawing area and displayed.

Panel layout Define how many times you want the layout object arranged along the X- and
Y-axes.

Pitches [mm] Define the distances between the layout objects (or layout object groups) along
the X- and Y-axes in [mm].

Button for interleaving the values (layout, distances) for both axis directions.

Center layout Select the option if you want the layout defined here to be centered in the job
as a whole.

NOTE: This option is active by default.

Parameter in X-axis / Parameter in Y-axis

Vary pen / Vary filling

Select pen

Define whether the parameter you want to vary should be a pen parameter or a
fill parameter.

In addition, if the base object(s) uses / use multiple pens, the pen whose
parameters are varied must be selected. Multiple pen selection per direction is
not recommended.
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Setting Explanation

Parameter Define the parameter that varies per duplication.
The following pen parameters are available for selection:

■ Laser power [%]

■ Laser frequency [kHz]

■ Laser pulse width [µs]

■ Marking speed [m/s]

■ Jump speed [m/s]

■ Marking delay [µs]

■ Jump delay [µs]

■ Polygon delay [µs]

■ Laser-on delay [µs]

■ Laser-off delay [µs]

■ Skywriting: Time for extension vector [µs]

■ Laser: Secondary power [%]

The following fill parameter are available for selection:

■ Distance (...between fill lines)

■ Offset (...of the filling to the contour)

NOTE: If, for example, there are several fillings in the base object, the start
value and the step size will be the same for all fills, regardless of the fact that
the values in the base object may be different.

Start value Define the start value for the respective parameter. The unit of the start value
always corresponds to the unit of the respective parameter.

NOTE: By default, the value corresponds to the value from the previously
defined pen.

Increment Define the step size by which the parameter should change per duplication. The
unit of the step size always corresponds to the unit of the respective parameter.

Export job name Specify the name under which the layout of the parameter finder is to be
created in the drawing area for the further steps.

Table. 7.56: RG-088
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7.4.1 How to use the pen parameter finder
1. Create / Choose a representative job layout for this task.

2. Start the pen parameter finder and define all necessary settings.

3. Click on "OK" or "Apply" to create the corresponding export job.

NOTES:
■ Each object in the export job is named according to the index in the XY layout, whereby

the index is zero-based.

■ The layout with the start values is always found at the bottom left in the XY arrangement.

■ Each duplication uses so-called object pens. The object pens are named according to the
object.

■ If the base job contains several job elements, these are grouped in the export job per
duplication.

4. All other rules and options for job execution apply to the export job.

RECOMMENDATION: Run these jobs statically only (without MOTF) and only per
individual scan field.

5. After job execution, you can evaluate the process results. If necessary, perform the steps
again with new settings in the Parameter finder.

6. Once you have found the appropriate parameters, you can simply “copy-and-paste" the
corresponding pen values to a library pen set or to a job pen set.

For fill parameters, simply save the filling of the corresponding layout as a fill template.

7. You can also save the export job for reuse like any other RAYGUIDE job.

NOTE: Not all parameters relevant for the process result are in the pens or the filling. Other
parameters such as the action time for drill points or the pixel resolution for raster graphics
are part of the object properties. These, in turn, can be defined as required per row or
column of a layout in the compound (multiple selection) using the “edit common properties”
option (see page 187, Edit common object properties).
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7.5 Job Organization

7.5.1 Organizing Process Order and Affiliations

Process order

The sequence of objects and graphic elements in the job tree is also the order of processing.
After layout creation, the sequence of graphic objects often is not optimal. That is why it
could make sense to reorganize the sequence of objects / elements: If, for example, an object,
graphic element or group of objects is to be edited before others for a specific reason, it can
be moved in the sequence. The graphic layout itself is not altered by re-organizing.

To move elements to another place in the job tree, select one or more elements and drag
them to the desired position in the job tree. A horizontal line indicates a possible new
position.

Affiliations

The affiliation of an item to a higher-level element, for example, of a path to a layer, can be
changed. For example, you may group paths to another / new layer for a specific reason. The
graphic layout itself is not altered by re-organizing affiliations.

In the same way, you can pick a layer and shift it into another free-shaped vector object.
Paths can also be shifted from one object into another. Only graphic commands cannot be
transferred this way.

When shifting items from one object to another, the following rules apply.

RULE: If you shift an element (layer, path) from one object to another, the shifted element
assumes the transformation of the new object.

RULE: The pen assignment of the target pen assigned to the target object is used for the
newly affiliated element, unless a pen was explicitly assigned to that element before.
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7.5.2 Containers
Containers build a kind or new job object, in which all inserted objects get treated
collectively.

An example: A transformation applied to a container will transform the entire contents.

The most simple container type is the Group container.

Matrix copy and polar copy containers also multiply their inserted objects as defined by the
container settings. These reproduction objects, called children (subordinate objects), act like
clones of the inserted master objects and cannot be picked or edited by themselves. In the
viewport, subordinate objects are displayed a bit lighter than the master objects.

NOTE: As soon as you pull an object outside a container, it will lose all properties of the
container.

You can add a container the same way as any other job object.

Add / Remove objects to / from a container:

Case A: The objects you want to include in the container are already listed in the job tree.

■ Select the objects with the mouse and drag them to the container object.

■ To remove an object from a container, drag the object out of the container or delete the
object.

Case B: You start with the container object.

■ If you now add a new object and would like to have it in the container, drag it directly to
the container item in the tree.

■ When you drag the new object into the viewport, it will be inserted after the container
object in the job tree.

NOTE: To edit a container as a whole by transformation, it must be selected in the job tree.

There are four types of containers.
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7.5.2.1 Group container

Button

A group of objects / items. The purpose of a group container is to treat all objects / items as a
whole, for example, to define execution conditions or the number of iterations, or to
transform / shift all objects / items together.

That is why you always pick up the group as a whole in the viewport.

To pick single elements, select them in the job tree.

To group the objects, select all objects by cursor selection in the viewport or in the job tree.
Open the context menu and select “Group”.

To ungroup, select the group container and select “ungroup” in the context menu.

The container and thus the groups can also have their own transformation, which transforms
the objects in the container. If the group is ungrouped, this transformation is transferred to
the objects that were in the group.

Setting Explanation

Settings

Iterations How often this group of objects should be processed.

General

Short label A name for this container that is easy to remember.

Description A description of the container useful for you.

Enable binning The settings for conditional execution of the container as a whole correspond to
those of a marking object, see page 181, Common Properties of Marking
Objects.

Single output Processes all container copies as a single, combined vector object.

This can speed up the processing if the container contains a huge number of
subordinate objects (children).

NOTES:
■ This option is especially recommended for MOTF applications in which many

small layout elements (such as drilled holes) occur, since this avoids reset
jumps.

■ If this option is set, automation objects in the container are ignored.

■ For text/code objects with variable content, the content is then no longer
varied per copy.

■ If containers are stacked inside each other, this option should not be used.
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Setting Explanation

Edit Pens (tab)

This tab provides access to pen editing.

After editing, you may save the pen as “object pen”. This allows editing specific pen parameters which only
affect container elements without affecting the actual job pens.

Table. 7.57: RG-050

7.5.2.2 Matrix copy container

Button

A matrix copy can be used to multiply layout elements throughout the workspace in ordered
rows / columns.

Setting Explanation

Settings

Number of copies Number of copies in X, Y, Z directions

Use the [Lock / Unlock] toggle button to define the same values for the X and
Y directions.

Pitches [mm] Distance the copies are spread in X, Y, Z direction.

Use the [Lock / Unlock] toggle button to define the same distances for the X
and Y directions.

Bidirectional Option to alternate the processing direction per row / column.

Centered The original center position of the master object (or the center of gravity in case
of multiple master objects) will become the center of the container.
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Setting Explanation

Alternation offset Offset in [mm] by which the first and each subsequent odd row is shifted.

With the help of this offset, honeycomb-like patterns can also be created, for
example.

Explicit cell order If activated, you can freely specify the sequence in which the copies will be
processed. To do so, enter all copy positions to be processed with their
coordinate index in the Custom list of cells line.

NOTES:
■ The specifications for the starting corner position and processing direction

are hidden.

■ The coordinate index starts in the lower left corner at 0.0.

Starting corner location Corner of the matrix layout at which the execution starts.

Processing direction Sequence of processing directions.

Ignore Specification of the copy indices that should not be executed.

Custom list of cells Specify the copy indices (cells) in the desired order. Only the index positions
listed here are executed and displayed.
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Setting Explanation

General

Short label A name for this container that is easy to remember.

Description A description of the container useful for you.

Enable binning The settings for conditional execution of the container as a whole correspond to
those of a marking object, see page 181, Common Properties of Marking
Objects.

Single output Processes all container copies as a single, combined vector object.

This can speed up the processing if the container contains a huge number of
subordinate objects (children).

NOTES:
■ This option is especially recommended for MOTF applications in which many

small layout elements (such as drilled holes) occur, since this avoids reset
jumps.

■ If this option is set, automation objects in the container are ignored.

■ For text/code objects with variable content, the content is then no longer
varied per copy.

■ If containers are stacked inside each other, this option should not be used.

Edit Pens (tab)

This tab provides access to pen editing.

After editing, you may save the pen as “object pen”. This allows editing specific pen parameters which only
affect container elements without affecting the actual job pens.

Table. 7.58: RG-051
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7.5.2.3 Polar copy container

Button optional, 
see page 130,
Objects Overview

Using a polar copy, you can multiply layout elements in a circular arrangement. The center of
the circular arrangement is the original center of the master object. Basically, the orientation
of the layout copies corresponds to the orientation of the master object.

Setting Explanation

Settings

Number of copies Number of copies that are evenly spread across the defined sector of a circular
arc. The master object is part of this number.

Radius [mm] Radius of the circular arc

Start angle [°] Defines the starting angle of the circular arc sector and thus the position of the
first object.

End angle [°] Defines the end angle of the circular arc sector and thus the position of last
object.

If start angle and end angle define a 360-degree sector, the copies are evenly
distributed along the full circumference.

Direction Processing direction of the copies along the circular arc.

Align children rotation All copies are rotated so that their vertical axes are tangential to the arc.

General

Short label A name for this container that is easy to remember.
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Setting Explanation

Description A description of the container useful for you.

Enable binning The settings for conditional execution of the container as a whole correspond to
those of a marking object, see page 181, Common Properties of Marking
Objects.

Single output Processes all container copies as a single, combined vector object.

This can speed up the processing if the container contains a huge number of
subordinate objects (children).

NOTES:
■ This option is especially recommended for MOTF applications in which many

small layout elements (such as drilled holes) occur, since this avoids reset
jumps.

■ If this option is set, automation objects in the container are ignored.

■ For text/code objects with variable content, the content is then no longer
varied per copy.

■ If containers are stacked inside each other, this option should not be used.

Edit Pens (tab)

This tab provides access to pen editing.

After editing, you may save the pen as “object pen”. This allows editing specific pen parameters which only
affect container elements without affecting the actual job pens.

Table. 7.59: RG-052

Remark for copy container
■ Scaling transforms the contained objects themselves and the distances between the

objects.

■ It is possible to nest containers in other containers.

■ You can also add an automation object to the container, which will be executed per copy.

■ If a text or code object whose contents usually change with each execution (e.g.
incremental number) is located in a container, this change takes place for each child
object.

A possible use case for the matrix container is to place drills in a regular fashion.
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7.5.2.4 Cluster container

Button optional, 
see page 130,
Objects Overview

The cluster container is similar to the matrix copy container, but with some special properties:

■ The arrangement of the copies is not fixed in rows and columns, but is defined per copy
with the offset plus angle. This position is also referred to below as the “nest position”.

■ Each copy can be defined as a template so that changes (such as to the contour) to the
template are transferred to all other copies.

■ If you enable “Binning”, you can define a separate execution condition for each nest
position.

Setting Explanation

Properties

Copies List of all copies.

The area can be expanded and collapsed using an expander.

Activate Select whether the nest position is to be executed or not.

■ The option is selected by default.

■ Nest positions deactivated here are hidden in the workspace.

Set template Select which nest position to use as a template for editing the geometry.

XYZ offset [mm] Offset to nest position relative to the position of the original object in the
processing field.

NOTES:
■ As soon as a marking object is located in the cluster container, it is only

displayed in the workspace at the defined nest positions.

■ No marking object has to be in the container to define the nest positions.

Rotation [°] Specification of the angle in degrees by which the nest is rotated compared to
the original.

Binning The column shows the available bit range that the selected input port of the
control card provides for binning.

[Load] You also have the option of loading the values for offset and rotation from a
CSV table.

NOTE: The table must contain values for all four parameters (four columns).

General

Short label A name for this container that is easy to remember.

Description A description of the container useful for you.
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Setting Explanation

Enable binning Only starts processing of the individual nest positions if a specified condition is
fulfilled.

The dialog has been extended to include other inputs:

■ I/O controller: Select the control card where the I/O signals will arrive.

■ I/O port: Select the preconfigured I/O port of the respective control card (see
page 55, I/O Port Configuration).

■ The condition itself is defined above for each nest position.

■ The “Ahead of time evaluation” option is set by default. It ensures that the
condition (bit pattern) is checked in advance so no time is lost during the
process.

NOTE: Deactivate this option if the condition is not set until it is time to
process the object. This may be the case after a preceding wait condition, for
example.

Single output Processes all container copies as a single, combined vector object.

This can speed up the processing if the container contains a huge number of
subordinate objects (children).

NOTES:
■ This option is especially recommended for MOTF applications in which many

small layout elements (such as drilled holes) occur, since this avoids reset
jumps.

■ If this option is set, automation objects in the container are ignored.

■ For text/code objects with variable content, the content is then no longer
varied per copy.

■ If containers are stacked inside each other, this option should not be used.

Edit Pens (tab)

This tab provides access to pen editing.

After editing, you may save the pen as “object pen”. This allows editing specific pen parameters which only
affect container elements without affecting the actual job pens.

Table. 7.60: RG-092

NOTE: In contrast to the other copy containers, only the defined nest positions are displayed
in the cluster container.
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Example of display of the graphic objects in the cluster container

1

2

Fig. 7.70: RG-AFC

1 Original job object NOT in cluster container 2 Original position is displayed

2

1

3

Fig. 7.71: RG-AFD

1 Original job object IN cluster container 3 Original position is NOT displayed

2 Display of the object in the defined nest
positions
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7.5.2.5 Tiler container

Button optional, 
see page 130,
Objects Overview

Using the tiler container, you can process layout objects that are larger than the available
workspace.

Setting Explanation

Settings

Tile size [mm] Define the size of the segment tiles in X / Y / Z direction in [mm].

Use the [Lock / Unlock]  toggle button to use the same segment size in X and Y
direction.

Number of tiles Define the number of segment tiles in X / Y / Z direction.

Starting corner location Define the starting point of the processing sequence by selecting the corner
coordinate of the object frame.

If the Centered option is not checked, it also defines which of the segment tiles
is in the center of the workspace.

Direction Processing sequence along the axis directions.

Bidirectional Option to alternate the processing direction per row / column.

Centered The tiling grid is centered at the origin of the workspace. Otherwise, the tiling
grid would be positioned so that the first segment is centered at the origin of
the workspace.

Explicit cell order If activated, you can freely specify the sequence in which the segments will be
processed. To do so, enter all segment positions to be processed with their
coordinate index in the Custom list of cells line.

NOTES:
■ The specifications for the starting corner position and processing direction

are hidden.

■ The coordinate index starts in the lower left corner at 0.0.

Starting corner location Corner of the segment layout at which execution starts.

Processing direction Sequence of processing directions.

Ignore Specification of the copy indices that should not be executed.
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Setting Explanation

Skip Enter the X-,Y-,Z-coordinate of the segment tiles to be ignored (skipped), as
they probably do not contain markable vectors.
Use a semicolon to separate the entry of segment tiles coordinates.
The ignored segment tiles are highlighted in yellow by default.

By default, the segment tile coordinates start counting at "0" in the lower left
corner:

Custom list of cells Specify the segment indices (cells) in the desired order. Only the index segments
listed here are executed.

General

Short label A name for this container that is easy to remember.

Description A description of the container useful for you.

Enable binning The settings for conditional execution of the container as a whole correspond to
those of a marking object, see page 181, Common Properties of Marking
Objects.

Table. 7.61: RG-068
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Remarks

The tiler creates a kind of tiling grid to divide the layout objects into pieces that fit into the
available workspace.

The position and size of the tiling grid is defined by the size and the number of segment tiles
and optionally by the Centered option.

The starting corner location also affects the position of the tiling grid if the Centered option
is not used.

Examples:

Fig. 7.72: RG-ADJ
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Fig. 7.73: RG-ADK

The segment tiles themselves are processed one after the other. The sequence of processing is
determined by setting the starting corner location and the tiling direction.

Examples:

Fig. 7.74: RG-ADL
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The segment tiles are processed centered to the workspace.

Recommendations:

■ The layout objects to be tiled should be designed, composed and centered before being
placed in the tiler container.

■ Every transformation of the tiler container applies to its layout content, but not to the tile
pattern.

■ To synchronize processing with an external control unit if necessary (e.g. to control motor
axes), it is recommended to enter a "Wait for start signal“ object at the beginning and a
"Write IO port" object at the end in the tiler container.
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7.5.2.6 z-offset container

Button optional, 
see page 130,
Objects Overview

By using the z-offset container, you can execute the layout objects in multiple focal planes to
generate deep engravings, for example.

To make it possible to mark in different focal planes, an appropriate deflection unit (e.g.
RAYLASE FOCUSSHIFTER, AXIALSCAN, AS FIBER) and a correction file with a z-volume are
required.

Setting Explanation

Count Defines the number of focal planes in which the layout objects located in the
container are executed.

Delta z [mm] The value defines the distance between the focal planes.

Negative algebraic signs indicate the focal plane is offset downward and
positive algebraic signs indicate it is offset upward.

 [Plus sign]
Adds a new line with shifts to define a new number of focal planes with a new
offset value.

Rotation [°] Enter the angle in [°] by which the contents of the container should rotate
around the center of the container for each z offset.

The value is applied equally to all table rows.

General

Short label A name for this container that is easy to remember.

Description A description of the container useful for you.

Enable binning The settings for conditional execution of the container as a whole correspond to
those of a marking object, see page 181, Common Properties of Marking
Objects.

Table. 7.62: RG-081

NOTE: If multiple layout objects are located in the container, all objects are initially executed
once per focal plane before the focal plane is changed and the objects are executed again.

NOTE: When you enter automation objects in the z-offset container, they will also be
executed for each focal plane.



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 307MN_RAYGUIDE [V2.11]

7.6 Job settings dialog
The Job settings dialog provides specific settings per job, and hosts the job statistics overview.

7.6.1 Job Properties
Select Job > Properties from the menu or double-click any of the job information on the Job
panel. The following dialog is displayed:

Fig. 7.75: RG-ACP
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The following settings always apply to the job currently edited and are stored with it.

Setting Explanation

Description Optional label for this setting.

Preset Select one of the previously stored job preferences (see page 119, Job Presets)
displayed in the drop-down list.

If a workspace configuration is marked as "Default", it is automatically
preselected.
If you don’t want to use any of the stored workspace configurations, select
None.

NOTE: If a stored workspace configuration with Mark-On-The-Fly (MOTF)
settings is selected, the MOTF setting fields are filled accordingly.

NOTE: If you change a job preset that is already in use, you can apply these
changes using the [Reload] button for the current job. However, please note
that parameters that you have changed directly in this dialog will be reset to the
default parameters.

See also page 119, Job Presets.

Workspace The workspace size of the loaded configuration or the field size provided by the
correction file.

The expander additionally displays the "Offset" area. The default values come
from the FC3 correction file, which primarily defines the zero position for
correction files with a Z-range.

Enter different workspace dimensions if required.

Correction file index Define the index of the correction file that is to be active when the execution of
the job begins.

NOTE: The option is only usable if at least one deflection unit has been assigned
two correction files in the configuration. See page 73, General.

Number of executions Execute the job a specific number of times.

Repeat Execute the job in an indefinite loop (most likely in combination with a “Wait
for start signal” object).
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Setting Explanation

Background Option for inserting an image as a background picture in the workspace.

Valid formats are: JPG, JPEG, BMP, PNG, GIF, EXIF.

Select:

■ Embed if the image is to be saved as part of the job.

■ Link if you only want to link the image file to the job locally.

NOTE: The image is scaled to the size of the workspace in both dimensions.

NOTE: The opacity of the background image can be set using the opacity slider,
which is part of the toolbar. See page 24, Toolbar.

Enable Mark-On-The-Fly For explanations and settings for Mark-On-the-Fly (MOTF), see page 314, MOTF
Jobs.

Start trigger

Distance

Repeat trigger

Execution pitch [mm]

Base pen set Drop-down list for the base pen set for this job. For details of pens, see page
266, Pen Panel.

Refresh on load Select this option (tick the box) so that the values of the job pen set are
automatically updated with the values of the base pen set when the job is
reloaded.

Use List of used / available control cards for this job.
If no workspace configuration was loaded, you can edit the selection.
If a workspace configuration was loaded, the list is “read only”.

The list also shows the size of the scan fields per control card and, if applicable,
the field offset defined in the job settings as well as a possibly defined end
position.

Table. 7.63: RG-053
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7.6.2 Optimizations
On the following tab, you can define a selection of optimizations that are performed by
RAYGUIDE in the background and before the actual execution on the control card.

The parameters displayed on this tab can also be set via a selected setting.

After you have defined a new job pre-setting or edited an existing one, you will see the pre-
setting and its workspace setup as soon as you start a new job or change the used preset in
the job settings.

Setting Explanation

General

Merge vector graphics For details, see page 126, Optimizations.

Join layers

Workload balance

Mark-On-The-Fly Segmentation

Segmentation mode For details, see page 322, MOTF Optimizations.

Max. Width [mm]

Time [s]

Sort

Minimize jump distance For details, see page 126, Optimizations.

By direction For details, see page 322, MOTF Optimizations.

Replace all commands by drill holes

If this option is activated, contour lines are automatically replaced with drill holes when the job is executed.

The following fields are then available for required specifications.

Spacing [mm] For details, see page 126, Optimizations.

Force corners

Drill mode

Pulse / Time

Table. 7.64: RG-074
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7.6.3 Job Statistics
The job statistics provide an overview of the job contents in regards to the processing time
and accumulate the overall lengths of mark vectors and jump vectors.

If multiple scan controllers are assigned to the job, each scan controller is displayed with its
respective associated contents.

Element Explanation

Total number of
markable objects

Number of all selectable objects in the job.

This also includes objects created by duplication containers.

NOTE: Only available in the job statistics, not in the object statistics.

NOTE: The following specifications are displayed divided into the following Outline and Filling categories.
The Combined column merges the values from Outline and Filling.

Execution time [m:s:ms] Calculated process time considering speed and delay values of all layout objects,
split into contour and filling.

NOTES:
■ The execution time does not include the time consumed by extra Skywriting

vector extensions.

■ The execution time does not take into account if the job execution is split
between several control cards.

■ The time refers to a single job execution, even if the job properties specify
multiple executions.

Mark trajectories [mm]

Jump trajectories [mm]

Display of

■ Total length

■ Shortest

■ Longest

■ Average value

NOTES:

■ If the job contains raster graphics that are processed in Sprint mode, then the
scan lines of the raster graphic are added to the total marking length.

■ The gaps in a dashed line are not subtracted from the mark vector length.

■ Possible wobble geometry is not taken into account.

■ The specifications for Shortest / Longest / Average value are only displayed if
more than one selection or jump trajectory is available.
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Element Explanation

Number of

Paths Accumulated number of paths, split per contour and filling.

Commands Accumulated number of commands, excluding “set pen” commands, split into
contour and filling.

Contour points Accumulated number of graphic command points, split into contour and filling.

NOTES:

■ “Supporting points” are excluded

■ Path start points are excluded

This is useful to get an idea at how many points a polygon delay can take effect.

Scan lines Accumulated number of raster graphic scan lines.

Slices The number of slices always pertains to the total height of the solid. In solids
with a negative form, however, the number of slices to be executed will usually
be far lower.

Table. 7.65: RG-054
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7.6.4 Job variables
Using the job variables, you can specify fixed contents that can then be used by text and / or
code objects as required.

All dynamically created variables of a job are listed here (e.g. via Dialog automation object or
in Text/Code objects).

Use the [Refresh] button to update the dynamically created variable contents.

Compared to the option of the data source to link a file, several but recurring contents can be
defined here.

Fig. 7.76: RG-AEX
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7.7 MOTF Jobs
MOTF stands for Marking-On-The-Fly and means to process objects that are continuously
moving through the workspace, instead of resting still. A conveyor belt typically transports
the material to be processed to and through the workspace of the deflection unit. The
movement has to be linear (in most cases along coordinate axes), i. e. no curvatures are
allowed.

To track the movement of the target material, the control card is fed by an encoder.
The encoder provides a defined number of signal edges (called ticks) per turn. By counting
the edges per time, the control card knows the speed of the target material passing by.

The SP-ICE-3 control card offers a second encoder (compensation encoder) input to
compensate for slight deviations in the movement of the target material perpendicular to the
main movement direction.

Each MOTF job also needs to know when to start the vector execution to meet the right
position on the target material. That is why RAYGUIDE offers different trigger options.

NOTE: For MOTF versions, trigger signals must be connected to the correspondingly
configured pin of the SP-ICE-3 control card named "Part sensor”. This requires a specific port
configuration on the SP-ICE-3. Refer to the SP-ICE-3 control card manual for more detailed
information on the correct port configuration.

To prepare for execution of an MOTF job, some configuration settings are required:

■ Control card configuration – for the basic hardware setup

■ System > Preferences > Workspace > Configuration – for frequently used MOTF
trigger settings.

■ Optional: Job settings – if no workspace configuration has been stored to use MOTF
defaults.
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7.7.1 MOTF Settings in Controller Card Configuration
Configure the technical details of the MOTF setup:

■ Open the control card configuration and go to the MOTF tab.

■ It is also recommended to consult the manual of the control card.

Setting Explanation

Base Mark-On-The-Fly configuration

Part distance [mm] The distance in [mm] between a workpiece and the trigger reference position
(usually the workspace origin) when a part detection sensor transmits a
detection signal. 
Knowing this distance and the speed of movement, the control card can
determine the exact moment when to start processing the vector list in the scan
field.

The SP-ICE-3 control card has a part sensor buffer. That means it is irrelevant
whether consecutive parts pass the trigger position before the first part has
reached the scan field to get processed.

Enable compensation
decoder

When enabled, a settings dialog is displayed which is similar to the one for the
main encoder.

Debounce part sensor Enable this option to debounce the sensor, i.e. to ignore any unwanted signals
(often signal glitches) for a certain time.

Debounce time [µs] Debounce time in [µs]

Suppress part sensor Enable this option to avoid picking up any trigger edges for a certain distance,
i. e. if other fiducials pass the trigger sensor while waiting for the next target
object.

Suppression distance
[mm]

Distance in [mm] over which signals are suppressed

Part sensor response time
[µs]

Time in [µs] between a actual detection of the part at the sensor and the arrival
of the sensor signal at the control card. For more information on the time
required to translate an optical detection into an output signal, for instance,
please refer to the specifications for the part sensor.
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Setting Explanation

Jump speed [m/s] Definition of the relative jump speed of so-called reset jumps. These jumps are
made when MOTF tracking is ended or paused or when the system jumps to the
next assumed layout position.

NOTE: Since in conventional MOTF each path is positioned over a belt distance
to the other paths, there are no longer any normal jumps between paths in a
MOTF marking that use the jump speed(s) of the pens; only the MOTF jump
speed is used. Exception: Jumps between paths that are combined into a
segment via the minimum segment width.

Margin Distance in [mm] to offset the earliest possible marking position from the field
border towards the field origin.

NOTE: Any value greater than zero will lead to a shorter processing time of the
layout within the remaining field distance.

Main encoder ID Assigns input port 0 and port 1 to the main encoder or to the compensation
encoder. By default, the main encoder uses ID=0

Belt offset [mm] Specify if the conveyor belt moves with an offset to the workspace origin.

Endless “Marking-on-the-fly”

For details on Endless-MOTF, see page 329,  Endless MOTF

Minimum [%] Lower limit of the range in percent relative to the target speed of the
belt / material (as displayed in the Notification panel) in which the marking
speed and laser power are readjusted according to the actual belt speed.

NOTE: The lower limit cannot be less than 1 %

Maximum [%] Upper limit of the range in percent relative to the target speed of the
belt / material (as displayed in the Notification panel) in which the marking
speed and laser power are readjusted according to the actual belt speed.

NOTE: The upper limit must not exceed 100%, as otherwise readjustment of the
marking speed and laser power can no longer be guaranteed. This would result
in errors in the dimensional accuracy of the geometry.
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Setting Explanation

Main encoder (also for compensation encoder, if activated)

Distance per count [µs/
tick]

The encoder delivers a certain number of signal edges per turn. By knowing this
number (refer to the encoder specification) and the circumference of the
encoder wheel, you can calculate the distance the conveyor belt is moving per
signal edge = “a count”. Alternatively, read the current [Refresh] encoder
position, move the conveyor belt a certain distance, and read the new encoder
position. Take the difference between the two encoder positions to calculate
the “distance per count impulses”.

To fine-tune the calculated values, we suggest the following: Define a marking
job with four lines of different lengths, orientated vertically to the belt
movement direction, all placed in the field center, one above the other. The
shortest line should be first, the longest line last in the marking order.

Run the job and see if the four lines are marked in the same place (one above
the other) and exactly straight in the vertical plane. If the lines are separated
and tilted, there is over-compensation or under-compensation of the belt
movement. Change the "Distance count impulse" value accordingly and repeat
the test until the results are good.

Invert direction Use if the encoder position value is decreasing instead of increasing although
the conveyor belt moves in the desired direction.

Azimuth [°], Elevation [°]

elevation

azimuth

The two angle specifications indicate how the conveyor runs relative to the
coordinate system of the workspace in your application.

In most applications, the conveyor moves in the working plane so the vertical
angle is 0°, and the horizontal angle is 0°/180°(belt moves along the X axis) 90°/
270°(belt moves along the Y axis).



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 318MN_RAYGUIDE [V2.11]

Setting Explanation

Enable index Some encoder types provide an index signal used to reset the counter. Check
with your encoder manual, if applicable.

Enable simulation Enable to simulate a real encoder setup. Useful to evaluate if the job can be
processed in an available scan field / time. If processing fails, the SP-ICE-3 control
card sends an "out of field" exception.

Simulation speed [m/s]

Assumed belt speed in [m/s].

Simulation acceleration
[µm/µs²]

Assumed acceleration, if required.

Position [tick] If the [Refresh] toggle button is activated, the counter level is constantly
updated. The counter is set to zero with the [Reset] button.

Current speed [m/s] Display of the determined belt speed via the increments per time (averaged over
1 second).

Status

Pending parts

Display the number of pending parts of the part sensor buffer. Use [Refresh] to
update the status information.

NOTE: The part sensor buffer count does not get cleared in case of an abort
event. It is cleared every time you start an execution.

Table. 7.66: RG-055

When using a trigger sensor as part sensor, it is necessary to configure the input port to which
the trigger sensor is wired.
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Open the control card configuration and go to the I/O tab, section: Special functions – In

Fig. 7.77: RG-ADG

Remarks
■ If the deflection unit moves instead of the one conveyor belt in your hardware setup, then

the settings apply in the same way.

■ When running MOTF jobs in a scenario with multiple control cards, the settings must be
made for each control card.

RULE: It is recommended to run MOTF jobs in On card execution mode to ensure immediate
response / processing to trigger signals. See page 336, Running a Job.
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7.7.2 MOTF settings in job settings / presets
In many cases, similar if not the same trigger options are used when creating multiple MOTF
jobs. Therefore, it is advisable to define them via a job preset.

Select Job > Presets to open the job preset dialog. Go to the MOTF tab.

Click on System > Preferences from the menu to open the dialog. Go to the System (all
users) tab and to the Workspace sub-tab.

Setting Explanation

Marking-on-the-fly Mode Select the Marking-on-the-fly variant:

■ Disabled: The job is executed without MOTF.

■ Enabled: The conventional variant is used.

■ Endless: The Endless MOTF variant is used. (For details, see page 329,  Endless
MOTF).

Minimum segment width
[mm]

This value defines how far a layout protrudes into the scan field due to the belt
movement before processing begins.

The value is 5% of the field size by default.

In addition, within the segment, reset jumps are omitted.

NOTES:
■ This value is of particular significance when a group of individual paths (such

as parallel fill lines) or rows of drilled points wander into the scan field due
to the belt movement.

■ This value is also used for MOTF processing of bitmaps.

Otherwise, the smallest unit that would move into the processing field and
after which a reset jump would occur would be a single bitmap line.
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Setting Explanation

Start trigger Start the first marking after the job was set to the “in process" status.

■ Immediately: Processing starts immediately as soon as you start job
execution.

■ Distance: Processing waits until the belt has traveled a certain distance.

■ Part sensor: Processing starts on the “part sensor” trigger signal (and
considers the part distance).

■ Continue This option should be selected if a MOTF job execution with
equidistant repeat interval has been aborted, e.g. via the Abort loop option,
see page 336, Running a Job, and has to be continued. However, the
requirement applies that the repeat interval must also be maintained after
interruption.

NOTE: In this case, belt movement should be stopped after completion of the
job when the loop is aborted and resumed after the job is restarted.

Distance Activated if "Distance” is set for Start trigger.

Enter the distance in [mm]. The first marking must wait until the job execution
has started.

Repeat trigger Define how consecutive parts get triggered:

■ The job is repeated equidistantly. The distance is defined as the execution
pitch.

■ The part sensor detects the parts as they pass by.

NOTE: The SP-ICE-3 control card has a part sensor buffer. That means trigger
events can be buffered while a part moves from the sensor into the workspace,
making it possible to place the part sensor at any distance from the workspace
center.

Execution pitch [mm] Activated when the repeat trigger is set to distance. Defines the distance at
which the repeated job layout is to be executed.

Table. 7.67: RG-056
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7.7.3 MOTF Optimizations
INTRODUCTION: Note that the following optimizations always consider each path, or more
precisely their bounding box, as the smallest unit of a graphic object that can be analyzed.

Setting Explanation

Mark-On-The-Fly Segmentation

This option allows MOTF processing of geometries that are significantly longer than the dimensions of the
scan field.

Select Segmentation
mode

By distance
■ Uses the "Max. Width [mm]" parameter

■ With this option, the width of all paths are checked in the belt direction.
Only paths that are wider than the “maximum width” value will then be
divided into segments of equal width, which are then processed one after
the other.

By time
■ Uses the "Max. Width [mm]" and "Time [s]" parameters

■ With this option, the entire job geometry is divided into segments, which
each have the same time requirements for processing. The segments are then
processed one after the other in the belt direction.

■ In this case, the "Max. Width" value for defining an upper limit to prevent
the geometry from being split into segments that are wider than the field
size, for instance, due to the time specification.

■ The corresponding value for "Time” indicates how much time the segments
may take to process (the segments are divided according to this value).
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Setting Explanation

Sort

Minimize jump distance For details, see page 126, Optimizations.

By direction & Range Activate this option to sort all paths (including filling lines) of a graphic object
taking the belt movement direction into account so as to achieve maximum
possible belt speed.

(For instance if the belt moves the target objects from the right side into the
scan field, the paths for processing are sorted according to their position from
left to right.)

CAUTION: Sorting is done per marking object and layer. That means it may be
necessary to merge several marking objects into one marking object with one
layer with the optimizations under General.

The Range [mm] value defines the width of a virtual segment. Within each
virtual segment, the order of primary path processing is opposite to the belt
direction, while the secondary order is perpendicular to the belt direction and
reverses on alternating segments.

APPLICATION NOTE: Finding the optimal value for the range depends on the
internal path distribution and the overall shape. If the graphic object is rather
narrow but long in belt direction (e.g. single-line text), a rather small range
value is recommended.

If, on the other hand, the graphic object has a more square contour and plenty
of paths that run perpendicular to the belt direction, a larger range value is
recommended in order to avoid too many perpendicular jumps. A reasonable
limit for the value is 25% of the field size.

Table. 7.68: RG-070
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The following images show the jumps to visualize the path process order before and after
splitting (with uniform distance) and sorting.

Fig. 7.78: RG-ADR

Speed optimization

The rule of thumb applies: The maximum belt speed results from the field size divided by the
execution time. If the marks are distributed at equal intervals, the repetition distance is used
for calculation instead of the field size.

When using the optimization options, the maximum possible speed value can be increased.
To determine the optimal values, you can try different optimization values and use the
simulated encoder for evaluation, or if the geometry has to be split, use the MOTF parameter
finder (see page 325, MOTF parameter finder).

NOTE: To visualize how the optimization works, a good option is to import the API log file
and view the jumps, since all the optimizations previously took place at the executor level.
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7.7.4 MOTF parameter finder
You can use the finder to help you find the optimal parameters for splitting the job geometry
for MOTF processing.

NOTES:
■ The values determined here are a mathematically calculated estimate. The real usable

values may differ slightly.

■ The finder only determines values that are needed if the job geometry is split. The
minimum segment width value is not one of them.

■ The MOTF parameter finder accesses the value of the current field size. If the field size is
changed, the parameters need to be recalculated.

■ The MOTF parameter finder can only be applied to jobs that have the “Mark-On-The-Fly”
flag set in the job properties.

■ This circumstance is taken into account for jobs with repeated execution by distance. For
jobs where repeated execution is triggered by the part sensor input, this circumstance
cannot be taken into account in the calculation because the time or distance between job
repetitions is unpredictable.

To start the MOTF parameter finder, go to Tools > Parameter finder > MOTF.

The following dialog appears:

Fig. 7.79: RG-AFB
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Setting Explanation

Constraints

Segmentation mode Specify the desired method for splitting.

You can choose between distance or time. For details, see page 322, MOTF
Optimizations.

Max. Width [mm] In the “by time” splitting method, this value is an upper limit because the
segments may not be infinitely wide.

MOTF field range Define the area or path length in the scan field that is available for MOTF
processing here.

By default, the value is 70% of the field size, but it can also be smaller or larger
if required. 70% is a good starting point according to previous experience.

[Optimize] Starts the calculation of the optimal parameters for splitting.

The process bar shows the progress of the calculation.

Use the [Cancel] button to cancel the calculation if necessary.

Result

Max. Width [mm] / Time
[s]

Specifies the optimal values for the “maximum width” or the “time”, depending
on the splitting method.

Expected max belt speed
[m/s]

Specification of the maximum belt speed calculated during the MOTF parameter
search that can be achieved with the set specifications and splitting.

Tolerances of up to ±2% are to be expected with this value.

Use the  symbol to transfer the calculated max. belt speed to the simulation
encoder of the control card.

[OK] / [Apply] Transfers the set splitting method and the calculated splitting parameter to the
job properties, Optimization tab.

Table. 7.69: 073
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7.7.5 MOTF workspace
It is possible to define a much larger workspace along the axis direction of the belt
movement. See page 119, Job Presets.

Use case: The graphic object(s) can be placed outside the field (in the direction in which the
material to be marked is fed) to have more “space" left inside the scan field for processing.

NOTE: If the job validation for the geometry is active, you must position all markable objects
inside a defined workspace to avoid warnings.

7.7.6 Trigger Reference
This chapter explains considerations to better understand when marking effectively starts.

In general, RAYGUIDE starts processing markable objects as soon as possible, but taking into
account various rules.

GENERAL RULE: Wait until the first path element has been completely "moved" into the
field before you start processing, unless the layout is positioned in such a way that the first
path is already completely located in the available scan field. Each subsequent path is marked
at the latest when its MOTF-corrected position is also completely moved into the available
scan field.

For this, the path, more precisely its bounding box, must lie completely within the scan field.
This prevents the “out-of-field” exception message from being issued in cases where paths
are processed that are marked faster than their vectors move into the scan field.

What does this mean for the three different settings for the start trigger?

7.7.6.1 Immediately
The processing of the first listed markable object is started immediately, under consideration
of the previously mentioned general rule.
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7.7.6.2 Part Sensor
The processing of the first listed markable object starts after the trigger event has been
recognized by the part sensor and the part distance has moved along, but considering the
previously mentioned general rule.

The position of the layout object in the workspace must be the relative position of the layout
object to the trigger reference of the target material / workpiece.

■ A common option is to use the workspace origin as a reference.

■ It is important to enter the “part distance” value in the MOTF configuration of the control
card measured relative to this reference.

Part-Sensor
Trigger Position

MOTF tiling direction

A= Layout position to trigger reference
B= "Part Distance" Value

Trigger-Fiducial

Working Field

Fig. 7.80: RG-ADD

7.7.6.3 Wait Distance
The processing of the first listed markable object starts after the defined wait distance has
elapsed, but considering the previously mentioned general rule.



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 329MN_RAYGUIDE [V2.11]

7.7.7 Endless MOTF

7.7.7.1 Introduction
Endless MOTF is a special way of controlling processing on moving material. Endless MOTF is
suitable for continuous markings or cuts where a contour is repeated periodically. A typical
application example would be cutting of a battery foil with periodically recurring “tabs”.

Due to the infinite execution, in contrast to conventional MOTF, the sometimes extremely
long contour is not split into segments and then joined together.

Instead, the deflection mirrors project a self-contained, “folded” contour, which is then
“unfolded” into your desired contour by the belt movement. This prevents unwanted
“connection points” as well as interruption of laser emission.

The following conditions for the job or job content must be observed:

1. Only one markable job element may be included; its geometry should be repeated
periodically on the material.

2. No automation objects or containers may be included

3. The job geometry starts at 90° to the belt axis at the same coordinate as it ends. This is the
only way to create a closed geometry in the folded state.

4. The geometry consists of only one path and therefore contains no jumps

5. The pen or pens used do not have active SKYWRITING or power ramps.
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7.7.7.2 Execution concept
The main execution of Endless MOTF is performed in a special app on the 
SP-ICE-3 control card.

The app is not available until firmware version 3.3.2 of the SP-ICE-3 control card.

NOTES for using the app:

■ The app has to be activated using the SP-ICE-3 configuration tool.

■ The number of permitted connections to the control card must be set to at least 2 or -1
(corresponds to infinite) using the SP-ICE-3 configuration tool.

For details, see the manual of the SP-ICE-3 control card.

This Endless MOTF app “folds” the geometry and calculates the scanning speeds. For each
Endless MOTF job, there is exactly one resulting belt speed (target speed) at which the laser
power and the marking speed are maintained in line with the specification in the pens.

As it will not be possible to transport the belt / material at exactly this speed in reality, the
app records the actual belt speed and regulates the marking speed and laser power
accordingly.

However, this regulation only takes place in a range that is defined in the MOTF
configuration of the control card. See section page 315, MOTF Settings in Controller Card
Configuration.

If an actual belt speed is detected that is outside the control range, execution is aborted or
not started at all.

NOTES on the process:

1. Create your job geometry according to the specifications.

2. In the job properties, select the "Marking-on-the-fly" "Endless" mode

3. Check that the horizontal angle that the belt direction has relative to the +X axis is
entered in the MOTF configuration of the control card (otherwise the list cannot be loaded
on the card).

4. Select “On card” mode in the “Execution” panel and load the job onto the card. After the
upload, in the Notifications panel, you get information about the target speed of the
belt in [m/s] from the app:

Fig. 7.81: RG-AFQ
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5. Only start execution when the belt speed is at least above the lower limit of the control
range.

Additional NOTES:

■ The execution of Endless MOTF allows for simultaneous use of the compensation encoder.

■ The transfer of the job content to the control card is not recorded in the regular card log
file.

Example Battery tab

a) Original job contour that will be repeated
periodically:

b) ”Folded” contour that the deflection unit moves
along:

c) Result is the “unfolded”, repeating contour:

Table. 7.70: RG-101
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7.8 Job Execution

7.8.1 Preview
When starting a preview, the deflection unit projects the geometry of the selected layout
object(s) with a visible pilot laser onto the target material. Therefore, the laser source itself or
the system must provide a visible pilot laser. The preview option must be set in the respective
laser configuration.

7.8.1.1 Pilot laser calibration
In most cases, the wavelengths of the visible pilot laser and the processing laser are different.
This will result in a slight deviation of the deflection caused by different diffraction.

That is why calibrating the pilot laser is recommended.

To calibrate the pilot laser, go to the device calibration of the respective deflection unit,
"Preview" section. For details, see page 78, Deflection Unit Calibration.

Workflow
■ First, mark a square with a suitable pen on a suitable material.

■ Start the preview of the square. Use the arrow buttons to superimpose (by rotating,
shifting, scaling) the previewed square with the marked square. Below the buttons are
fields where you can define the delta values by which the preview changes with each click
of the button.

■ The arrow button between the two calibration sections can be used to transfer the
calibration values from the working laser as initial values.

■ Save the pilot laser calibration: Click on the [Apply] or [OK] button to open the laser
dialog.

■ If the deflection unit is a 3-axis or 4-axis unit, you can set a separate head bias to focus the
pilot laser beam precisely on the target material.
During previews, a fairly high scanning speed is often required. You can disable the 3rd/
4th axis when a preview is performed to avoid stressing these axes.

For information on field transformations, refer to page 78, Deflection Unit Calibration.
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7.8.1.2 Running a Preview
Go to the Execution panel.

Fig. 7.82: RG-ACQ

You can choose to display only selected graphic objects or graphic elements (e.g. selection
of layers or paths) or all graphic objects via the preview using the pilot laser.

The drop-down list offers you five options to select the previewed content(s) / shape(s):

■ Everything: This also includes fillings and, for bitmaps, each bitmap line

■ Contour: All contour vectors, but no fillings, bitmaps as rectangles

■ Rectangle: A bounding box rectangle around the selected objects

■ Envelope: Only enclosing contours of the single selected objects

Example:

Fig. 7.83: RG-ADO
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■ Thumb: Positions the preview point on the selected thumb position and tracks it live while
the thumb position is being processed (only functions in edit mode with a single selected
thumb).

This option can also be used when “drawing" vector graphics. Here, the preview point
always shows the end point of the graphic command added last.

NOTE: If you change to the object level in the tree while the thumb preview is active, the
preview automatically changes to the rectangle preview variant.
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To start the preview, click on the [Preview] toggle button. A red toggle button indicates
that a preview is running.

Fig. 7.84: RG-ACS

The preview runs continuously until the toggle button is clicked again. The preview continues
to run until the selected contour is complete.

If you click on the [Abort] button instead, the preview is immediately ended.

The scanning speed for the preview can be adjusted with the speed slider. The speed slider
provides the speed values in a logarithmic scale. The speed range for the preview can be
adjusted to meet the specifications of your deflection unit in the System > Preferences >
System (all users) > Process adjustment menu.

When you start a preview, RAYGUIDE “disarms” the laser and turns on the pilot laser. When
the preview is finished, the laser is re-armed.

Live editing during preview

It is possible to select more / less / other objects, edit and transform the objects, even down to
the layers / path / command level, while the preview is running. The changes are always
shown with the next preview cycle.

You can also switch on the pilot laser without doing a preview. This means that only one of
the two toggle buttons, [Arm] and [Pointer], can be active at the same time.

Fig. 7.85: RG-ACR

To activate the pilot laser, click on the [Pointer] toggle button. The button switches to red.

Both buttons turn orange if, for instance, several jobs assigned to different control cards are
open and

■ one of the jobs is shown in the preview,

■ while the laser is armed for another job.

Fig. 7.86: RG-AGW

RULE: The preview always refers to the actively selected job.
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7.8.2 Running a Job
The execution of laser processing jobs is controlled from the Execution panel (on the right
side of the viewport by default):

NOTE: Once you start running a laser processing job, the top and bottom lines of the frame
turn red. This ensures that anyone can immediately see that a laser process is active with just
one glance at the RAYGUIDE user interface.

Fig. 7.87: RG-ACT
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Job validation

Job validation is a tool to help you prevent mistakes, for example, positioning a layout object
partially outside the available workspace. Job validation is performed ahead of the actual job
execution. You can select if and what type of job validation is to be performed. 
Select System > Preferences from the menu, go to the User (current user) tab and to the
General tab, Job validation section.

Setting Explanation

Job validation

Geometry Checks that no layout object is partially or completely outside the defined scan
field or workspace.

Laser pen properties Checks that the defined laser limits (e.g., pulse width, power) are not exceeded
in any of the pens used.

Scanner pen properties Checks that the defined scanning speed limit is not exceeded by any of the pens
used.

Ramping pen properties Useful only if a pen uses the ramping feature. RAYGUIDE checks that the total
ramp length exceeds the length of the respective paths.

The ramp time is relevant for validating drilled points.

Closed paths Checks that the job geometry only contains closed paths.

MOTF Checks that, for example, the minimum segment width (bundles paths) is not
greater than the maximum segmentation width (splits large paths).

Wobble Checks that the expected current consumption does not exceed the maximum
current consumption as defined in the configuration of the deflection unit.

Table. 7.71: RG-059

If any of the active job validation checks finds an issue, a pop-up message indicates the
possible error cause.

Job access during execution

The currently processed job is in read-only status. You can review the statistics or the used
pen parameters, but you cannot edit them. All other open jobs can be edited in the
meantime.
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Stopping a job
■ A job that was started will terminate when all job tasks are performed.

■ If you want to stop the job execution before this time (for example, because the job is
running in an infinite loop), click the [Abort] button. This will immediately terminate all
active processing, and the deflection unit resets to the 0/0 position.

■ If a job is running in a repeat loop (no matter whether it has a defined number of
repetitions or is infinite) and the On card execution type is used, a selection menu appears
next to the [Stop] button:

– Abort immediately

– Abort loop

When you launch the job execution again, the job starts from the beginning.

The Abort loop option causes the currently running loop to be completed before the process
is aborted. This ensures that, for example, in MOTF jobs, the component currently being
processed is completed and not interrupted uncontrollably during processing.

If multiple jobs are executed in parallel, each job has its own entry in the process monitor and
can be stopped individually. See page 345, Process Monitor.
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7.8.2.1 "Arm Laser” status
To execute a job with working laser emission, the laser must be armed. 
This does not necessarily imply that an electric arming signal is sent to the laser. However, the
Arm laser on startup status of the SP-ICE-3 control card must be set to TRUE to provide any
laser control signals at all. If the laser is not armed, no signals are transferred from the control
card to the laser.

In the Execution section of the panel, click on the [Arm / Disarm] toggle button to change
the laser arm status. The red symbol on the button indicates that the laser is armed.

NOTE: If several jobs are open and the jobs are assigned to different control cards, the job
selection must first be set to All so that all affected control cards receive the Laser armed
status.

Fig. 7.88: RG-ACU

Disarming the laser can be useful to prevent accidental laser emission.

In the system settings (Preferences > System >  General tab), you can define that the laser
should always be automatically armed when the RAYGUIDE application is started.

NOTE: The [Arm / Disarm] toggle buttons and [Pointer] are also presented at other
locations in the user interface, such as in the laser diagnosis.

NOTE: The display of the buttons does not respond to the switching of the laser status or
pilot laser by means of the automation object (see page 257, Arming / Disarming laser).
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7.8.2.2 Execution Modes
In the Mark job section of the Execution panel, you can choose between three modes of
execution.

7.8.2.2.1 On host
Execute the complete job with its job settings. After clicking on the [Execute] button,
RAYGUIDE starts sending the data to the control card for execution. To reduce the idle time
during data transmission, RAYGUIDE streams the data.

NOTE: With this execution type, a separate list is generated for the control card for each job
element.

7.8.2.2.2 Quick
Use the [Selected] toggle button to execute only the selected layout objects or, if you have
not clicked on the button, to execute all layout objects. To execute the job, click on the
[Execute] button – a sub-selection is available here: “Execute” (= default setting) or “Repeat
execution”.

Fig. 7.89: RG-ADB

NOTES:

■ Job settings such as job repeat loops are ignored.

■ MOTF correction is not used.

■ The execution conditions defined for objects are ignored.

■ Automation objects are not executed.

■ Text and code are not incremented in a repetition loop.
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7.8.2.2.3 On card
Use this mode to ensure that there is no idle time when a trigger signal is received, i.e., in
MOTF applications. 
First, use the [Upload] button to send the job(s) to the control card RAM memory. Not until
all data is transferred can the [Run] button be used again. 
Click on [Run] to start job execution.

NOTES:

■ If you have a job scenario that permits the use of the “All” job option, one click on the
[Run] button is enough to set all jobs to execution.

■ If you close the RAYGUIDE application after downloading, the job lists are still stored on
the card. If you have already started job execution and close the RAYGUIDE application
afterwards, you can choose if the job execution is to be continued. 
In this case, you must 
a) abort job execution and 
b) re-initialize the control card when you re-open RAYGUIDE in order to get access to the
control card.

■ This execution type does not support varying text / code content and dynamic vector
graphics.

■ With this execution type, all job elements are written to a single list for the control card.
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7.8.2.3 Execution with Enabled Shortcuts
The buttons on the Execution panel are also available as keyboard shortcuts.

Press [F10] to activate the mode of execution by keyboard shortcuts. A small pop-up dialog is
displayed with the known button. 
You can access the functions by clicking the buttons with the mouse, or activate them with
the keys indicated on the buttons.

NOTE: The execution mode can only be selected with the mouse.

Key Function

[A] Arm Laser ON / OFF

[D] Upload (on-card mode only)

[E] Pointer ON / OFF

[M] Mark (all)

[R] Repeat ON / OFF (quick mark only)

[S] Mark selected (quick mark only)

[P] Preview ON / OFF

[X] [Abort]

Table. 7.72: RG-057

7.8.2.4 Considerations and Rules Regarding Multiple Jobs
Two cases are considered for the execution of multiple jobs:

■ Prerequisite: All open jobs are assigned to a specific control card, and all job elements of a
job are assigned to the same card.

This allows the All option to be used in the Execution panel in order to execute all jobs in
parallel on the assigned control card. Available execution modes: On PC or On card

■ Prerequisite: All open jobs are assigned to the same control card.

This allows the second job to be sent for "Execution" while the first job is still running, and
so on. RAYGUIDE then queues the jobs and processes them one after the other.
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7.8.2.5 Considerations and Rules Regarding Multiple Card
Scenarios
In general, RAYGUIDE handles the described multiple control card scenarios in the same way,
regardless of whether the multi field mode setup is defined for unified, intersected, or
individual fields, even though these setups support different purposes in the system design.

Execution Explanation

On host

Using an automation
object

The automation object is only executed on the assigned control card.

■ Example 1: Wait for start signal

All control cards wait to continue execution until the trigger signal is
received on the assigned control card.

■ Example 2: Writing IO port

Only the assigned control card sets the I/O port. All other control cards wait
until the port is set before continuing with their objects.

If you want all involved control cards to write something to the I/O port, you
have to duplicate the automation object per control card and assign it
accordingly.

In any case, further execution is synchronized by the automation object: This
means that the automation object is not executed until each control card has
completed the previous process tasks.

Incrementing content This case requires special attention when multi-field mode is applied to
individual fields:

RULE: RAYGUIDE increments the content per involved control card.

■ Example: You have three control cards assigned and are processing a text
object with incrementing serial number:

At the first job iteration, control card 1 will mark 1, control card 2 will mark
2, control card 3 will mark 3.

At the second job iteration, control card 1 will mark 4, control card 2 will
mark 5, control card 3 will mark 6.

If you want to have all control cards process the same iteration content, set the
value of the “batch parameter” according to the number of assigned control
cards.

Job Loop The following job repetition starts synchronized: The executing device waits
until each control card has finished its task in the previous job repetition.

Abort execution If an abort occurs on any of the involved control cards, all control cards stop
processing.



7 LASER PROCESS JOBS

© 2025 RAYLASE GmbH 344MN_RAYGUIDE [V2.11]

Execution Explanation

On card

Using an automation
object

Automation objects that use hardware interfaces or “local” functions of a
control card must be available on every control card on which they have to be
executed.

Exception: “Time delay” automation object.

RAYGUIDE automatically clones this automation objects on all control cards
used in the job.

Job Loop As there is no crosslink between the control cards, the loop execution of the
control cards involved is not synchronized.

Abort execution An abort, even if it only occurs on one of the control cards, stops execution on
all control cards involved.

It does not matter whether the abort was triggered by a button or a hardware
signal.

Table. 7.73: RG-058
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7.8.3 Process Monitor
The process monitor is a panel under the viewport. It provides useful information after job
execution has been started.

Example:

Fig. 7.90: RG-ACV

The process monitor lists all jobs that are executed while RAYGUIDE is open unless you delete
a single entry or all entries manually.

If the same job is executed several times in succession, the existing entry is updated and the
counter in the cycle column moves up. The last job started always appears at the top of the
list.

The process monitor list provides the following information:

Info Explanation

Job Name of the job

Progress A dynamic status bar to view the current state of progress.

If the job is interrupted for some reason (intentional or after an error), the
progress bar stops, too.

If the job is to be repeated for a number of times, the progress bar reflects the
overall progress.

If the job is to be executed in an endless loop:
The progress bar restarts with each loop if the time span for job execution is
more than five seconds.
The progress bar stops when the first cycle is completed if the job execution
time is shorter than five seconds.

However, the timer will continue counting.

Color coding:

■ Gray bar: The job is executed again

■ Green bar: The job has been completely executed

■ Red bar: The job was aborted by the user or due to an error message.

If a job is processed by multiple control cards, the progress still refers to the
entire job status as such.
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Info Explanation

Expected Calculated process time for the complete job in one iteration. Even if the job is
processed by multiple control cards which share the work, the cumulated
process time is shown here.

NOTE: When the job is repeated a defined number of times, the total time is
displayed. However, when the job is executed in a repetition loop, the duration
of the individual repetition is displayed.

Actual Actual process time

NOTE: The timer for the current time also runs when waiting for an event (for
example, “Waiting for signal start”) and stops when the process is completed or
aborted.

Cycle Counter for displaying the performed job executions / the number of specified
job executions.

The pound sign is followed by the number of started job executions.

NOTE: Both counters only work in execution types “On PC” and “Test run".

NOTE: The "Start execution counter" is only reset when the entry is deleted in
the process monitor.

Target Display all control cards linked to the current job itemized according to their
labels.

Current object Display the current or last processed object per involved control card.

NOTE: The object name is only displayed if the execution is in the On PC or Test
run mode.

NOTE: When a tiler container is used, the segment tile coordinate is shown.
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Info Explanation

Iterations Display of object executions.

NOTE: The display of object pass counter only works for objects with a sequence
using an infinite number of passes.

The display can be activated during execution using the [Refresh]  button, or
this happens at the latest when the infinite execution is aborted.

NOTE: The terminated pass is not counted.

[Abort] Button to abort a specific job, in case several jobs are executed in parallel.

[Clear] 12 / [Clear all] Clear individual / all entry(ies) from the process monitor list.

Table. 7.74: RG-060

The columns displayed in the Process monitor panel can be adjusted.

Fig. 7.91: RG-AGM

Right-click in the column header area and the following menu appears. Select or deselect the
columns to be displayed in the list.

12 NOTE: Per target
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7.8.4 Automated Error Handling
This function is intended for the more detailed communication to an external control unit of
possible malfunctions registered on the control card. Possible error sources can be the control
card itself, as well as connected devices such as the laser or the deflection unit. To use this
function, the job must be executed by the RAYGUIDE application, i.e., this function cannot be
used when executed in stand-alone mode without an additional connection between the
RAYGUIDE GUI and the control card.

NOTE: An error reaction only takes place if a job is being actively executed. This also includes
an active preview.

Click on System > Error handling from the menu to open the Error handling dialog.

Fig. 7.92: RG-ADW

Setting Explanation

Device Type Select which of the available communication interfaces is to be used.

Currently, the I/O interface or a serial interface is available.

Controller Specify the control card on which the interface is physically located.

Use affected control card If several control cards are used, the error information can only be output on
one control card. If this option is set, the error information is output on the
control card on which the error was registered.

Port Select the desired and preconfigured port on the selected control card.

NOTE: When using the Use affected control card option, the IO ports of the
affected control cards must all have the same name (same ID).

Pulse width [µs] If the I/O interface was selected as the device type, enter the pulse width for a
signal pulse for event-based errors here.

Error Action Define a different signal pattern or a command line for each individual error
reason (prerequisite: There is an error status for the laser and the deflection
unit). This means that the corresponding signal is set to active and is not
canceled until the error status has been rectified or cleared.
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Setting Explanation

NOTE on the laser: The error status must be cleared manually by opening the
device dialog of the laser once.

NOTE on the deflection unit: Here, the error condition is cleared
automatically if the deflection unit monitoring no longer evaluates an error
condition from the deflection unit.

All other errors are event-based, meaning they only result in a signal pulse.

NOTE: All non-selected bits are set to non-active by default.

■ Laser: Reacts when the connected laser source reports a malfunction.

NOTE: Some lasers may report various error conditions, but they are combined
into one error condition on the SP-ICE-3 control card.

■ Deflection unit: Reacts when the scan head monitoring is set active and the
number of consecutive errors is exceeded. For details, see page 53, General.

■ Control card: Reacts when the control card outputs an exception, apart from
the special exceptions mentioned below.

■ Outside the field: Reacts when the card notifies vectors for processing that
exceed the field size. (Separated control error condition) Can usually occur
during an MOTF job execution.

■ Execution aborted: Reacts when either the user presses an abort button or
when an external stop signal is detected on the control card (separated
control card error condition).

Table. 7.75: RG-077
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7.8.5 Setting up the stand-alone card operation
You can transfer one or more jobs from the RAYGUIDE application to the control card
memory. All job information is stored in a list on the control card and remains stored even if
the control card is powered down.

When the control card has all the necessary job information and is in Stand-Alone mode, the
card independently executes the jobs without being connected to the RAYGUIDE software or
being monitored by it.

External signals are sent to the control card via the input I/Os – for start / stop processing as
well as for job selection. Typically, these signals are generated by a PLC.

NOTE: To define the stand-alone configuration and transfer jobs, the control card must have
the “Connected" status.
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Defining a list with jobs for stand-alone mode

Select System > Stand-Alone from the menu or press [Ctrl+F12].

The following dialog is displayed:

Fig. 7.93: RG-ACW
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The stand-alone mode dialog offers all options to prepare the control card for stand-alone
operation. All functions are explained in the table below, followed by generic workflow
instructions.

Also, the Stand-alone mode dialog provides an option to save / load all settings for stand-
alone operation in a so-called “stand-alone configuration”. A stand-alone configuration can
be useful to back up the work or to apply the settings to other control cards.

Settings

Setting Explanation

Card Select the control card for the stand-alone configuration.

Enable Stand-Alone
mode / Disable Stand-
Alone mode

Select "Enable Stand-Alone mode to release the stand-alone configuration
section in the dialog and define your stand-alone configuration.

Press [Apply] or [OK] to transmit the stand-alone configuration to the selected
control card.

Select "Disable Stand-Alone mode" and press [Apply] or [OK] to leave stand-
Alone mode. The control card is enabled for operation via the RAYGUIDE user
interface or the API application.

General

Name The name of the stand-alone configuration.

I/O port Select the corresponding I/O port at which the bit information defining the job
selection is expected. This technique is called "binning".

An input port may also have to be defined in the control card configuration. Use
the [+] shortcut button to open the respective control card configuration dialog
directly and add an I/O port. For details on control card I/O port definitions, see
page 49, Scan Controller Configuration, I/O tab.

Arm Laser In principle, it makes sense for the laser to be armed automatically (in the
master list) in stand-alone control card mode. That is why the selection is
Enabled by default.

Alternatively, this option can be deactivated in order to arm the laser only from
the job list, for instance.

Another alternative is the double edge. This is required, for instance, when
using a TruPulse nano laser to ensure that possible error statuses have been
cleared.
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Setting Explanation

Wait for external start This option determines that the processing of the jobs can only start after a start
signal was detected on the respective control card.

NOTE: Without a wait condition, the jobs run in an infinite loop as soon as
stand-alone mode is activated.

Flow Choose Sequential if the jobs are to be executed as arranged in the list.
Individual binning conditions are optional.

Choose Switch if the jobs have individual binning conditions. The job sequence is
then determined by the conditions.

To set individual binning conditions, activate the Binning option in the Jobs
section (see below) and set the available bit range to the specific signal pattern.

The main difference between the Sequential and Switch options is:

■ Sequential:

More lists can be executed per loop.

■ Switch:

The list that matches the binning conditions is executed. Each binning
condition must be unique (i.e. it occurs only once).

Jobs

List ID ID of the job in the job list. IDs can be edited if required.

The list ID number is allocated by RAYGUIDE.

If you want to change the list ID number, note that only numbers above 100 are
allowed.

Binning Enable Binning to define the binning conditions per job.

The top binning tab enables / disables the binning per job.

If Flow is set to Single job, each job must have a binning condition, and the
binning condition must be unique.

If Flow is set to Sequential, each job can, but does not have to, have a binning
condition.

The binning condition can be set by toggling individual bits (0/1), or by entering
the corresponding numerical value.

Alternatively, you can import the binning conditions from a *.csv table.
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Setting Explanation

Individual job icons ■ Upload a single job.

■ Press the arrow pointing up or down to change the order of the jobs in the
list.

■ Click on [Delete] to immediately remove a single job entry from the stand-
alone mode dialog.

Timestamps ■ The lower entry shows the timestamp from when the job file was saved
(shown as soon as the job is added to the dialog).

■ The upper entry shows the timestamp from when the job was uploaded to
the control card (shown shortly after uploading).

■ As soon as the save timestamp of the job file is more recent than the upload
timestamp, it is highlighted in orange, indicating that a more recent version
of the job file is available. Download the job file again to work with the
latest version of the job file. 
NOTE: This can only work if you always save the job to the same folder
location.

Export CSV

Create a csv table listing the jobs you have added for stand-alone mode: 
Job (including path and file name) / List ID / Binning checkbox / Condition /
Upload timestamp / Save timestamp / Last change timestamp.

Import CSV

Import the job list in CSV format, mainly to load the data entered in the CSV
table for binning.

NOTE: It is recommended to generate the table using the export function
before importing, to enter the values for the binning conditions, and only then
to import. This ensures that the format will be correct.

[Add jobs...] Open a browser window to select one or multiple jobs to be added to the stand-
alone mode list.

[Upload all] Transmit all listed jobs to the control card.

Immediately clear all listed jobs of the current stand-alone configuration from
the dialog and also delete the job lists from corresponding control card after
pressing [Apply].

[Delete card`s jobs] Delete all jobs/lists out of the control card memory that were previously
uploaded to the control card.
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Setting Explanation

Error handling

In case a list execution aborts, a specific behavior can be defined.

An error event can be caused by a laser or deflection unit error, by a control card exception, or by an
intended stop signal from the control card that is received by the control card.

Write on port Select a specific output port and define a bit pattern to be communicated.

The output port must be defined in advance in the control card configuration.
See page 49, Scan Controller Configuration for details on control card I/O port
definitions.

Mode & Timing Same options as for the write port object. See page 255, Write Port.

Enable delay & Delay [ms] Define the delay time to wait before the next trigger is accepted after an error
event.

NOTE: The delay timer starts after the I/O port pulse if this has been defined.

Restart process After an error, the entire stand-alone mode returns to the initial wait condition.

This is important so that operation can continue after an abort without the
need to reboot the control card.

NOTE: This option is active by default.

Disarm laser Select this option if you want to ensure that the laser is disarmed in the event of
an error (including termination).

Stand-Alone execution

Logging If activated, the RAYGUIDE_StandAlone.log log file is written as soon as
execution is started.

For details on the log file, see page 397, Log Files.

Start execution of stand-alone mode.

The status display changes from Idle to In progress.

NOTE: When execution is started, the so-called “master list” is automatically
active, even if the actual job execution is still waiting for a trigger signal.

This “master list” also automatically arms the laser so that it can emit power
immediately after receiving a trigger signal.

Stop the execution of stand-alone mode.

The status display changes from In progress to Idle.

Table. 7.76: RG-061
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Workflow recommendation for job execution in stand-alone mode

To prepare a stand-alone execution, follow these steps in the Stand-alone mode dialog:

1. Select the control card.

2. Enable “Stand-alone mode”.

3. Add all job files to the dialog that you may want to execute during stand-alone mode
(multiple selection of job files is possible).

4. Re-order the job sequence if necessary.

5. Upload all jobs.

6. Verify the timestamps to ensure that all jobs are up-to-date.

7. Define workflow control, binning conditions, error handling. 
It is highly recommended to enable “Wait for signal start” and "Restart process”.

8. Press [Apply] > Now the control card is ready to operate in stand-alone mode. 
NOTE: Indicated by an orange icon in front of the control card entry in the job overview.
Also, the execution panel is blocked.
This action will also save the complete stand-alone configuration under its entered name.

9. Press [Run] to initialize execution on the control card, for example, for testing.

The execution status changes from Idle to In progress.

Alternatively, close the RAYGUIDE application. As soon as you reboot the control card, the
stand-alone configuration is automatically activated.

To use an already existing stand-alone configuration, for example, to prepare another control
card, proceed with the following workflow:

1. Select the control card.

2. Enable “Stand-alone mode”.

3. Load the stand-alone configuration.

4. Add/remove jobs or change the configuration, if desired.

5. Upload all jobs.

6. Click on [Apply].
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Editing the configuration while stand-alone mode is active

You can only edit the currently displayed stand-alone configuration while Stand-alone mode
is active and execution has the Idle status: We therefore recommend [stopping] processing.
To apply the changes, do not forget to click on the [Apply] button.

If you edit a stand-alone configuration while the stand-alone mode has already been started
(status = in progress) and you press [Apply] or [OK], a dialog appears offering you three
different options:

Fig. 7.94: RG-ADE

If you click on [Apply] to confirm the stand-alone configuration, but there are jobs which are
out-of-date or not even uploaded to the control card, the following dialog reminds you and
prompts you to upload these jobs before running the stand-alone configuration.

Fig. 7.95: RG-ADF
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Terminating stand-alone mode

A control card operating in stand-alone mode is inaccessible by any other application
(indicated by the orange control card button in the job overview). That means you must first
deactivate stand-alone mode to release the control card for RAYGUIDE.

1. Open the stand-alone mode dialog.

2. Press the [Stop] button to abort execution of the stand-alone "master list".

3. Enable “Stand-alone mode”.

4. Click on [Apply] or [OK].

Job execution is stopped even if the current job execution status was In progress, and the
stand-alone mode is disabled in the same step.

Now the control card is “released” and can be operated again via the RAYGUIDE application
(indicated in the job overview by the button of a green card).
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7.8.6 Process adjustment
Process adjustment allows global and timely adjustments of process parameters and / or a
layout transformation without the need to edit the job itself.

Process adjustment is available via a separate GUI panel. By default, the Process adjustment
panel is located on the right side of the user interface, behind the Transformation tab.

Fig. 7.96: RG-ACX

The process adjustment settings apply to the active job and its control card(s). If a job has
several control cards integrated, an additional selection option appears in the panel:

Fig. 7.97: RG-AEW
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Via Scope you define whether all control cards involved in the job get the parameters for the
process adjustment or only one explicitly selected control card.

NOTE: If you select Job, the process transformation is automatically converted for the
individual control cards according to the job preset used in the job and its scan field
arrangement.

CAUTION: In this case, the boundary overlap should be non-zero in the job settings so that
layouts are not cut exactly at the field edge and there is still room for a resulting offset.

NOTES:
■ The process adjustment takes effect immediately (even for jobs that are in process) and is

only reset according to the specifications as described in page 94, General.

■ The process adjustment is also effective if the job is executed in On card mode or in stand-
alone mode.

Process adjustment can be useful if the layout positioning, the laser power, or the process
speed need to be corrected while the job is looping or between job iterations.
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The following settings are available:

Setting Explanation

Process adjustment

Value ranges can be limited, see below.

Power scale [%] By default, you can decrease the laser power to 0% or increase it up to 200%.

NOTE: The power scale is relative to laser power defined for the respective pen.
Logically, the total laser power can never exceed 100%.

Speed scale [%] By default, you can decrease the process speed to 0% or increase it up to 200%.

NOTE: The speed scale is relative to mark / jump speed defined for the
respective pen.

Transformation

The behavior of the transformation buttons can be preset:

 Rotate entire job layout: clockwise / anticlockwise.

 

 

Move the entire job layout in axis direction: up / down / left / right.

 Enlarge (scale) the entire job layout in X- or Y-axis direction in [%].

 Shrink (scale) the entire job layout in X- or Y-axis direction in [%].

Reset all transformations.

Update all displayed process transformation values with the values currently
stored on the control card.

Input fields for the
process transformation
(Offset [mm], Scale [%],
Rotation [°])

The values can either result from the above buttons or you can enter the value
directly.

If the value is entered directly, then press the [Check] button to apply the
value(s).

NOTE: Compared to the buttons, an offset in the z-direction can also be
defined.

Table. 7.77: RG-062
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Related preset: Power and speed limits

It is possible to limit the range in which adjustments to the laser power and speed can be
made in advance.

Select System > Preferences from the menu to open the Settings dialog. Go to the System
(all users) tab and to the Process adjustment sub-tab.

Fig. 7.98: RG-ACY

Setting Explanation

Power scale [%] Min/Max Restricts the range in which the adjustment of the laser power in [%] can be set.

Check the laser power settings for the used pens and the capacity of the laser
source to define suitable limitations.

Speed scale [%] Min/Max Restricts the range in which the adjustment of the process speed in [%] can be
set.

Check the mark / jump speed settings for the used pens and the threshold of the
deflection unit to define suitable limitations.

Any settings shall take the laser capabilities into account.

Table. 7.78: RG-063
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Related preset: Transformation deltas

It is possible to define the delta of the respective transformation per button click as a
preference.

Select System > Preferences from the menu to open the Settings dialog. Go to the Current
user tab and to the Process adjustment sub-tab.

Fig. 7.99: RG-ACZ

Setting Explanation

Offset delta [mm] Defines how many [mm] an object is offset when clicking a [Move] button on
the Process adjustment panel.

Rotation delta [°] Defines how many degrees an object is rotated when clicking the [Rotation]
button on the Process adjustment panel.

Scale factor Scale factor in [%] when clicking the [Size] buttons on the Process adjustment
panel.

Table. 7.79: RG-064

Reset options

IMPORTANT: There is no automatic reset of the values set here as they are stored in the
control card! Make sure to reset the changes when they are no longer needed, for example
when a new job starts.

It is possible to force a reset at each start of the software:

■ Click System > Preferences in the menu to open the Settings dialog. Go to the System
(all users) and to the General sub-tab, Initialization section.

■ Select event for the transformation and scaling settings an define when they will be
automatically reset:

– At software startup

– At start of processing (execution)

– Never
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8 RAYLASE PLUG-INS
RAYLASE offers specially developed plug-ins for various purposes.

During the installation process of RAYGUIDE, you will also be offered a chance to install these
plug-ins.

The associated library files are stored in the subfolder \ RAYGUIDE\Bin\PlugIns\.

NOTE: All plug-ins are optional. In the installation routine, they must be selected for
installation so they will then be available in the GUI.

8.1 SP-ICE-3 Log Import

Button

The SP-ICE-3 log object inserts all the graphic content of a SP-ICE-3 log file as a layout object.
A log file can be created for each SP-ICE-3 control card. It contains all the communication to
the control card, including all vectors contained in the jobs that were downloaded to the
control card for laser processing.

Re-importing the graphic content in that way can be helpful to find the reason for unwanted
process results (error analysis).

In order to have a log file, logging has to be enabled. See page 396, Error Handling and Log
Files for more information on log files.

To create a log file that contains only data of the current job, it is recommended to reset the
log file before executing the job. See page 49, Setup.

To display the vector content of a log file in the viewport, click the button of the log importer
on the object panel. The dialog with the log file import settings opens. Alternatively, you can
drag the log file directly from the folder to the RAYGUIDE viewport or to the job tree. In this
case, the default import settings are used.

Note that the log file content is displayed in the viewport as one graphic object, similar to a
DXF or PLT file object, providing the same layout hierarchy.
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Essential settings

Setting Description

Path Path and file name of the log file. Use the file selection button to load a file.
The default path is C:\ProgramData\RAYLASE\RAYGUIDE\Logs\.

Start path,
Count

If you want only a specific part of the layout to be imported, enter the number
of the first desired path of the layout, and then the quantity of subsequent
paths.

Start time / End time These fields can be used to limit the time span of the log file, which is displayed
graphically after import.

The entry is made in the same format as the entry in the log file. However, the
year is left out:

MM-DD HH:MM:SS:FFF

Only executed lists This option allows you to limit the displayed content to only what the deflection
unit really executed compared to all content that has been sent to the control
card.

Offset wait distance When loading a log file from a MOTF execution, this option is recommended to
display the paths as they were placed in the original job layout. Even split paths
appear stitched together.

Center Check to place the layout in the center of the workspace.

Overwrite pens Will use the pen attribute of the log source. In case of SP-ICE-3 log, however,
only the pen attribute dashed line is taken into account.

Table. 8.1: RG-065

Additional settings
■ For general settings for all marking objects, see page 181, Common Properties of Marking

Objects.

■ For transformations, see page 201, Object Transformation.
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8.2 weldMARK job importer plug-in
This paid plug-in allows loading of certain version 3.6 weldMARK jobs in RAYGUIDE. Please
contact your RAYLASE sales representative if you would like to use this plug-in.

8.3 Solar wafer
The aim of this plug-in is to import and optimize vector graphics used specially for wafer
processing.

Above all, it is possible to save process time by converting lines consisting of many individual
short vector strokes into a single line with a stroke-pattern property.

8.3.1 Solar wafer importer

Button

Vector optimization

This job element imports the vector graphic and replaces multiple vectors arranged in a
dashed line fashion with a single dashed line. Only horizontal or vertical dashed lines are
recognized. Any remaining vectors are appended after the dashed line vectors. The lines are
processed bidirectionally.

Fig. 8.1: RG-AEZ
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Setting Explanation

File Opens a file browser to navigate to the graphic file you want to import.

After selecting the file, click [Open] in the browser and the preview displays the
file content.

Supported file formats are: DXF, PLT, SVG, DWG, CGM, HPGL, GBR, CSV, TXT.

Scale to size Activate to scale the size of the imported graphic to the specified size in [mm].

Unit Defines the unit of the imported vectors. Select from [mm], [µm] and [inch].

■ Value = 1: Normal case (without scaling).

■ Value ≠ 1: also applies a scale factor.

NOTE: Only applicable if Scale to size scaling is not used.

Center XY Incorporates the vector graphic centered on the XY axes of the workspace.

Flip horizontally Flips the vector graphic horizontally during import.

Flip vertically Flips the vector graphic vertically during import.

Join layers Merges multiple layers to one layer.

Import hidden elements Some file formats (e.g. DXF files) can contain layers marked as hidden. These
layers are ignored during import by default. Use this option if you want to
import them anyway.

Fractional digits Defines the accuracy of checks as to whether individual vector strokes are in the
same horizontal or vertical line or not.

The fewer decimal places related to [µm] are considered, the more tolerant the
algorithm is to positional inaccuracies of the vector coordinates.

Entire line as single
pattern

When active, a completely horizontal or vertical arrangement of lines is
evaluated as a stroke-line pattern during import and therefore converted into a
single straight line with a stroke-pattern property (in the pen).

This means that patterns with strokes or gaps of unequal length can also be
converted.

NOTE: Using this option may result in a larger required number of pens to
illustrate all horizontal lines of the wafer.

Table. 8.2: RG-102
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NOTE on pen use

Pen 1 is used for solid lines and starting with pen 2, as many pens are created as dashed line
patterns exist.

All marking parameters except for the dash line related ones are copied from the default pen
(default 1) to the other pens. That is why only pen 1 should be modified when the process
parameters for the wafer are adjusted. Please note that the values are applied automatically
during execution, but are not visible in the pen dialogs.

Skywriting is not automatically activated, which is why it must be actively defined by the user
in pen 1.
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8.3.2 Solar wafer designer

Button

This job element can be used to create the wafer array directly in RAYGUIDE. The major
benefit compared to import is that the design pattern can be defined directly by entering just
a few parameters. This avoids the prior DXF generation and rounding issues during import
and allows easy adaptation of design changes.

CAUTION: Please note that, for the solar wafer, the marking and jump speeds must be set to
the same value in the assigned pen.

Fig. 8.2: RG-ADP
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Setting Explanation

Wafer

Size Size of the wafer square in [mm].

IMPORTANT NOTE: Do not perform any object transformations (e.g. scaling) of
the object after its creation, as this can lead to incorrect positioning of the
dashes in the dashed lines.

Total Lines Number of horizontal dashed lines evenly spread over the wafer size.

“Bus bar” pattern

Size X and Y dimensions of “the bus “bars in [mm].

Margin Distance between the bounding box of the "bus bar" pattern and the wafer
contour in [mm].

Columns / Rows Number of columns and rows of the "Bus bars".

Dashed line

Pattern The dashed line pattern is defined by entering length values for laser on / off.

Enter at least two numbers.

The first value defines a dash to start the pattern.

Separate values for dash / gap with blanks.

IMPORTANT NOTE: You can edit the dashed pattern any time after creating the
object. However, it must be edited in the Object settings dialog and not in the
associated pen settings.

Forward shift Distance in [mm].

Shifts the dashed pattern for all lines that are marked from left to right.

Backward shift Distance in [mm].

Shifts the dashed pattern for all lines that are marked from right to left.
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Setting Explanation

Deflection unit settings

Jerk limited control The jerk-limited control enables optimal acceleration and takes into account a
maximum jerk value, leading to smooth command signals.

In particular, this improves the behavior at the reversal points between the lines
while reducing the load on the galvanometer scanner. The reduced jerk in the
command improves the accuracy in the process. (When the jerk-limited control is
used, a reduced tracking error is activated for the deflection unit to ensure that
there are only advantages compared to the standard operation.)

NOTE: When the jerk-limited control is used, the (red) bounding box around the
acceleration paths is enlarged, even if they themselves are not displayed
graphically.

Max. current [A] Input of the maximum permissible current for the galvanometer scanners,
between 3 A and 9 A. In this optimization, the specification of the current value
sets the focus between the increase in accuracy and the increase in dynamics.

RULE: The lower the current value, the higher the accuracy, with extension of
the acceleration time. The inverse applies for a high current.

Table. 8.3: RG-071
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Fig. 8.3: RG-ADQ
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8.4 Remote Interface

8.4.1 General
The remote interface is an interface for remote control of the RAYGUIDE user interface based
on API events. It makes it possible to define a TCP/IP socket through which command lines can
be received to open / modify / execute a RAYGUIDE job e.g. from a PLC.

If required, the range of functions can be extended by the user via the RAYGUIDE API. In this
case, it must be compiled and updated by the user. Instructions on how to do this can be
found in the RAYGUIDE SDK manual chapter 3.5.

In addition to the plug-in integrated in the RAYGUIDE GUI and the corresponding panel,
there is also the option of sending remote command to the RAYGUIDE Remote Interface
Server App and having them executed by this application.

For details, see page 376, RAYGUIDE Remote Interface Server App.

Fig. 8.4: RG-AEB

NOTE: All areas can be expanded and collapsed via the expander button.
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Setting Explanation

 / 

Button for manually starting the remote server

■ (is then ready to respond to remote commands)

■ or stopping it.

Button for opening the remote interface settings:
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Setting Explanation

■ Server

– IP address:

The IP address at which the socket server receives commands is set to "Any" by default. A specific IP
address does not need to be defined here. If you wish to specify a discrete IP address, all relevant IP
addresses are available to you for selection.

– Auto start:

If this option is set, when the RAYGUIDE application is restarted, the remote server is also always
started immediately so that there is an immediate reaction to the commands from the remote client.

– Auto update viewport:

If this setting is activated, the entire view area is re-rendered each time a marking object is changed.
Depending on the scope of the job, this can take a lot of time.

If this function is deactivated, you can use the “refreshViewport” command to re-render all changes
once.

– Logging:

If activated, a log file is created that logs all incoming commands and responses. This file can also be
found under:

C:\ProgramData\RAYLASE\RAYGUIDE\Logs\RAYGUIDE_RemoteInterface.log

■ Timeouts

List of all times that, depending on the command, produce a timeout error message when the time is
exceeded.

Button to open a list of all available commands. See page 378, List of
available commands.

NOTE: Each command is terminated with "eol" (end of line).

Host information

List of all network adapters in the UP status and all associated IP addresses of the host PC.

Active job

Shows the job name of the currently active job.

Socket messages

Shows all incoming commands either as confirmed or with an error message.

Table. 8.4: RG-080
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TIP: To test the remote connection commands, a client tool (RemoteClient.exe) is also
provided, which can be found in the folder \ RAYGUIDE\tools.

NOTES on the sequence: First enter the appropriate IP address on the server side (RAYGUIDE
GUI). Click on "Start Listening" to prepare the server to begin receiving commands. Then
establish the connection on the client side using the "connect" command. The connection is
now ready for using the commands described above.

NOTE: If the client application is closed while the server is still “listening”, “listening” must be
stopped and restarted on the server side when the client application is restarted before a
connection can be re-established there using the “connect” command.

8.4.2 RAYGUIDE Remote Interface Server App
The RAYGUIDE Remote Interface Server App is a stand-alone application that can be
executed as an alternative to the RAYGUIDE GUI to load, modify and execute common
RAYGUIDE jobs using remote commands.

The main advantage over the RAYGUIDE GUI variant is the much faster execution time of the
commands, especially since no vector graphics or similar job elements are graphically re-
rendered here, and there is significantly less overhead.

The app can also be minimized to the task bar so that it is almost invisible:

Fig. 8.5: RG-AFW

The GUI of the RAYGUIDE Remote Interface Server App is divided into three tabs.

Tab Explanation

Client List of all incoming commands and the response from the server.

System Information on the RAYGUIDE system configuration that also has to be
initialized.

Help List of all available remote commands with indication of which commands are
not available in the app in contrast to the GUI plug-in.

Table. 8.5: RG-100
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List of all available remote commands with indication of which commands are not available in
the app in contrast to the GUI plug-in.

Fig. 8.6: RG-AFX

NOTES:
■ After opening the app, it may take a few seconds until the app is ready for connection to

the client because the app also loads the entire system configuration, including the
correction file, onto the control card.

■ Before executing a job, the laser must be armed with the “Arm” command.

■ To shut down the app, click on the icon in the task bar and select the “Quit” menu item:

Fig. 8.7: RG-AFY
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8.4.3 List of available commands

8.4.3.1 List
NOTE on marking (*): These commands have a specific timeout value. It can, if necessary, be
adapted in the RemoteInterface.json file. For all other commands, the timeout is set to
500 ms.

NOTE on marking (**): The labels are case-sensitive.

List of available commands

abort, eol Command for aborting an active job execution.

Arm, eol * Command for arming the laser.

assignScanHeads; 
<scanControllerShortLabel>,
<scanHead1ShortLabel>,
<scanHead2ShortLabel>, eol */**

Command for assigning the deflection unit to the control card.

NOTE: By assigning the deflection unit to the control card, a deflection
unit can be specifically selected, however with different correction files
and different calibrations.

blockGui, eol Command to lock the RAYGUIDE GUI so that no operations can take place
simultaneously via the GUI during remote control.

close, eol * Command for closing an active job.

NOTE: The closing command automatically implies that the job will first be
saved in order to prevent changes from being lost.

closeAll, eol * Command to close all currently open jobs at the same time.

NOTE: The closing command automatically implies that all open jobs will
first be saved in order to prevent changes from being lost.

disablePointer, eol Deactivates the pilot laser.

disableEvent,
<eventName>, eol

Command to deactivate the event feedback activated by enableEvent.

disarm, eol Command for disarming the laser.

enablePointer, eol Activates the pilot laser.
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List of available commands

enableEvent,
<eventName>, eol

Command to respond to events in the form of messages to the remote
client.

Available events (names):

■ JobStartedEvent

Message is sent as soon as the execution is finished:
EVT,JobStartedEvent,<jobname>,<scancontroller (for OnCard otherwise
empty)>

■ JobValidationEvent

Message is sent as soon as job validation fails, e.g. because geometries
are not in the processing field:
EVT,JobValidation,<jobname>,<Validation type>

■ BarcodeContentEvent

Message contains the content of the first barcode object of the job;
sent at the start of job execution:
EVT,BarcodeContentEvent,<jobname>,<data>

■ ExecutionErrorEvent

Message about a failed execution; sent immediately upon error event:
EVT,ExecutionErrorEvent,<jobname>,<type>

Possible error types are: Aborted, Executor, Laser, OutOfField,
ScanController, ScanHead

■ JobFinishedEvent

Message is sent as soon as the execution is finished:
EVT,JobFinishedEvent,<jobname>,<scancontroller (for OnCard
otherwise empty)>

■ MonitoringErrorEvent

A message is sent as soon as a status is received from the extended
monitoring function of the deflection unit (see page 85, Extended
monitoring of the deflection unit and page 94, General) that is outside
the defined limits, e.g. the temperature at the Aux temperature sensor
is too high:

EVT,MonitoringErrorEvent,ScanHead,SS-IV-HL,AuxTemp,Aux temp (38°)
bigger than max value (37°).

■ MessageEvent

This event ensures that a message is sent to the client in the event of a
timeout, for example.

upload, eol * Command for uploading the active job onto the control card.

executor, <type>, eol Command for selecting the execution type: host (On PC) / quick (test run) /
card (on card)

executorMode,
<executionMode>, eol

Command to select the execution mode: all (all jobs) / active (active job)
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List of available commands

getActiveJob, eol Command for retrieving the name of the active job.

getDeviceStatus, eol Command to receive information about the status of all devices currently
in use, such as control card, deflection unit, laser, etc.

If only the status of a single device is required, enter the Short label of the
device after the command, e.g.

getDeviceStatus,SP-ICE-3,eol

Devices that do not offer status information return “NA” (not available) as
the response.

getExecutionstatistic, eol Command to read out the execution statistics according to the Process
monitor panel

An example of a response:

{"job":"Job
1","scancontroller":"SN_693","singlecontroller":true,"expected":157.2796,
"actual":11979.0,"finished":false,"aborted":true,"cycle":1,"starts":1,"pass
es":"96"}

getJobElements, eol Generates a character string with a list of short labels of all job elements of
the active job. The character string is generated in the JSON format. For
more details, see the API Handbook, class RequestJobElementsEvent.

getJobPens, eol Generates a character string with a list of all data of all pens used in the
active job. The character string is generated in the JSON format. For more
details, see the API Handbook, class RequestJobPensEvent.

getPenNumbers,
<jobElementLabel>, eol **

Generates a character string with a list of the pen numbers of all pens that
are used in the job element with the transferred short label. The short
label is case-sensitive. The character string is generated in the JSON format.
For more details, see the API Handbook, class RequestPenNumbersEvent.

getPens,
<jobElementLabel>, eol **

Generates a character string with a list of all data of all pens that are used
in the job element with the transferred short label. The short label is case-
sensitive. The character string is generated in the JSON format. For more
details, see the API Handbook, class RequestPensEvent.

getJobUploadHash, eol Returns a unique hash code for the job loaded onto the control card. The
command can be used to check whether the job has changed in any way.

modifyJobVariable,
<variableName>,
<newValue>, eol **

Command for changing the content of an job variable that is already
defined. See also page 313, Job variables.
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List of available commands

modifyText,
<jobElementLabel>,
<nexttext>, eol **

Command for changing the content of a text or code element.

<job element label> corresponds to the name of the job element in the
tree directory.

<next text> Definition of the new text content.

modifyTransformation,
<job element label>,
<rotation>, <scaleX>,
<scaleY>. <scaleZ>,
<offsetX>, <offsetY>,
<offsetZ>, <mode>, eol **

NOTE: This command is essentially the same as the setTransformation
command, which is why it is no longer developed.

open, <path>, eol ** Command to open a job in a certain folder.

renderAsBitmap, 
<Path>, <imageSize>, eol

Command to save the workspace of the current job locally as an image.
The following parameters must be specified:

■ Storage location (path) with file name and file format

■ Image size in number of pixels (referring to the longer side)

run, eol Command for starting the job execution task.

NOTE: Returns ACK as soon as the job execution has actually started.

refreshViewport Command for re-rendering all job elements displayed in the viewport.
Changes to position or text content become visible.

Only useful if automatic rendering has been deactivated.

resetIncrement,
<jobelementname>, eol

Command to reset the increment counter of a text or code object.

The command can also transfer a list of job elements in order to handle
several elements at one time.

rdmtriggerspectrumcalibration
, eol

Command for triggering spectrum calibration for the RAYDIME METER.

rdmturnonsld,
<boolean>

Command for switching the measuring laser (SLD) on or off.

The Boolean argument “true” switches the measuring laser on, and the
argument “false” switches the measuring laser off.

Save, <path>, eol ** Command to save the job after a change (e.g. new text content or object
transformation), as otherwise a prompt will appear when the job is closed.

<path> defines the file path for the storage procedure.
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List of available commands

selectjobelements,
<job element name>
[<job element name 2>…..],
eol

Command to select one or more job elements for subsequent commands.

setActiveJob, 
<job label>, eol

Command to define the current job or to change it. If you loaded multiple
job one after the other, the job loaded last is the active job.

setGlobalScale,
<power scale>,
<speed scale>, eol

Command to globally scale the laser power and process speeds (marking
like jumps).

Both scalings must be defined here as a factor. See page 100, Process
Adjustment for the valid range of values.

CAUTION: These scalings are executed by the SP-ICE-3 control card and
saved there, but not reset.

RAYGUIDE offers you settings for resetting these values for certain events,
see page 94, General.

SetjobElement,
<label>,
sequences,
<passes(row 1)>,
<outline-pen(row 1)>,
<filling-pen(row 1)>,
<passes(row 2)>,
<outline-pen(row 2)>,
<filling-pen(row 2)>,…,eol

This command can be used to define the sequences of a marking object.

■ <passes>:

Number of runs, can either be an integer or “-1” for infinity.

■ <outline-pen>

Number of pen for the contour

■ <filling-pen>

The number of the pen for the filling as an option.

If there is no filling, this parameter must remain empty.

NOTE: A maximum of 5 lines can be defined for sequences using the
remote command. Previously existing sequences are completely replaced.

Example of two sequences without filling:

setJobelement,Rectangle,sequences,-1,2,,3,4,,eol

Result:
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List of available commands

SetJobParameter,
<parameter>, 
<value<, eol

This command can be used to define job properties. Essentially, there are
currently commands to enable / disable a so-called Process transformation
queue.

■ Parameter = PTQ (ProcessTransformationQueue)

■ Values = enable, disable

For details on Process transformation queue, see page 387,  "Process
transformation queue” application example.

setParameter,
<ParameterName>,
<Value>, eol

This command can be used to set remote interface settings (e.g. auto-
refresh of the active / inactive viewport ).

All timeout parameters can also be adjusted.

setPen, 
<PenNumber>,
<Property1>,
<Property1Value>,
<Property2>,
<Property2Value>, eol

Command to change pen parameters.

With Property1 to PropertyN the pen parameter to be changed is specified.
The following parameters are available for selection:

■ BeamProfileID

■ JumpDelay [µs]

■ JumpSpeed [m/s]

■ LaserFrequency [kHz]

■ LaserPower [%/100] e.g. 50% > 0.5 regardless of the GUI unit

■ LmWidth [µs]

■ MarkDelay [µs]

■ OpticalPulseWidthIndex (only for IPG YLP APD lasers)

■ OpticalPulseWidth [µs] (only for lasers that are configured accordingly)

■ MarkSpeed [m/s]

■ SecondaryPower [%/100]

■ Magnification factor (can only be used if a suitable correction file is
used)

■ Magnification speed

■ Zoom Async

With Property1Value to PropertyNValue the values belonging to the
respective parameter are transferred. The values must be in the units
noted above.

setLaseronProperties,
<job lement>, 
<mode>, <value>

Command to define the parameters of drills:

■ You can use the mode variable to define whether to specify a number
of pulses (pulse) or a dwell time (time).

■ Value: integer value

SetPreviewParameters
<previewAll>,
<previewMode>,
<previewSpeed>, eol

Command to make the various settings for a preview.

PreviewAll = True: All objects are shown in the preview.

PreviewAll = False: Only selected objects are shown in the preview.
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List of available commands

PreviewMode = Mode Index 0 to 4

0 = All; 1 = Inset; 2 = Rectangle; 3 = Envelope; 4 = Point

Unit for the variable previewSpeed = [m/s] Permissible value range =
0.05 m/s to 10 m/s

setquickexecutionparameters,
<selected job elements only
(true|false)>,eol

With this command, you decide in Quick execution mode whether only
selected (= true) or all objects (= false) are executed.

SetScancontrollerParameter,
<devicename>, <parameter>, 
<command>, [<property1>,
<value1>,
<property2>, <value2>,…], eol

With this command, add the transformations to the Process transformation
queue or delete the active process transformation.

■ Devicename = Label of control card

■ Parameter = PTQ (ProcessTransformationQueue)

■ Commands = add, clear

■ Properties = offsetX, offsetY, offsetZ, scaleX, scaleY, scaleZ, rotationX,
rotationY, rotationZ

■ Values = Offset in [µm], Scale in [factor], rotation in [rad]

For details on Process transformation queue, see page 387,  "Process
transformation queue” application example.

SetScanheadBias, 
<Scanhead name>, 
<axis index>,
<axis offset>, 
[<calibration file index>,
<mode>]

Command to primarily provide the optical axes for laser focus, zoom,
sensor, RDM with an offset.

CAUTION: This offset is managed by the control card and is not
automatically reset.

Observe the notes on offsetting on the page 78, Deflection Unit
Calibration.

■ Scanhead name: Abbreviation of deflection unit

■ Axis index: 2 = z , 3 = zoom, 4 = sensor, 5 = AUX

■ Axis offset: Offset in [µm]

■ Optional:

– Calibration file index (0 … 3, 0 = standard)

– Mode: laser / pointer (laser = standard)
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List of available commands

setTransformation, jobelemet, 
<job element name1>,
<Property1>,
<Property1Value>,
<Property2>,
<Property2Value>,
jobelement, 
<job element name2>,
<Property1>,
<Property1Value>,
<Property2>,
<Property2Value>, eol

Command for transforming several objects with a single command.

With job element name1 to job element nameN the job elements that are
to be transformed are named.

With Property1 to PropertyN the transformation parameters to be changed
per object are specified. The following parameters are available for
selection:

■ rotationX [rad]

■ rotationY [rad]

■ rotationZ [rad]: Rotation around the Z-axis in the XY plane/top view

■ scaleX [factor]

■ scaleY [factor]

■ scaleZ [factor]

■ offsetX [µm]

■ offsetY [µm]

■ offsetZ [µm]

■ mode

– Possible values: abs (absolute) / rel (relative)

– Standard, is absolute if not specified

With Property1Value to PropertyNValue the values belonging to the
respective transformation parameter are transferred. The values must be in
the units noted above.

Example:

settransformation,jobelement,Rectangle,scalex,1.5,mode,rel,jobelement,
Circle,offsetx,3000,mode,rel

StartPreview, eol Starts the preview with the pilot laser (for details on the preview, see page
333, Running a Preview).

StopPreview, eol Ends the preview with the pilot laser.

transform, 
<rotation>, <scaleX>,
<scaleY>, scaleZ>,
<offsetX> <offsetY>,
<offsetZ>, <scope>,
<mode>, eol

Command for setting the process transformation.

NOTE: The rotation must be specified in [rad], the scaling in [absolute
factor] and the offset in [µm].

NOTES:
■ The scope of the process transformation can be optionally be

transferred with the scope variables: (Only makes sense for jobs that use
a multifield):

Job (for the job as a whole) / CardLabel (short name of the control card)

■ The transformation mode can be optionally be transferred with the
mode variables:

abs (absolute) / rel (relative)

Details on process transformation, see page 359, Process adjustment.
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List of available commands

unblockGui, eol Command to unlock the GUI.

NOTE: This command should always be used at the end of a program run.

wait, 
<eventName>,
<timeoutTime>, eol

Command to define a waiting time in [ms] an event can take.

These events can be:

■ JobFinishEvent; (= job is finished)

■ WorkspaceRefreshEvent (= the display of the job in the GUI is
completed after e.g. job changes)

NOTE: NOTES: The command returns an ACK when the event is received. If
the event is not received in the specified time, a "Wait_Error" is returned.

Table. 8.6: RG-097
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8.4.3.2 "Process transformation queue” application example
The Process transformation queue can be used for processes in which each job execution has
to undergo a new transformation.

It is important that the transformation is applied specifically at the start (or trigger event) of
job execution. This would not be the case with MOTF job executions without the Process
transformation queue method, as the control card always calculates in advance, meaning the
transformation would only take effect after a delay.

Typical command sequence

SetJobParameter, PTQ, enable, eol

SetScancontrollerParameter, SP-ICE-3, PTQ, add, offsetX, 0.3, rotationZ,
0.4, eol

SetScancontrollerParameter, SP-ICE-3, PTQ, add, offsetX, 0, rotationZ, 0,
offsetY, 0.2, eol

SetScancontrollerParameter, SP-ICE-3, add, …

…

(List of transformations)

…

SetScancontrollerParameter, SP-ICE-3, clear, eol

SetJobParameter, PTQ, disable, eol

NOTES:
■ Note that the process transformation is an absolute transformation.

■ Also, keep in mind that the values you set will be maintained. 
This means that any transformation values you set might need to be reset to zero for the
next job execution.
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8.4.4 Overview of feedback

Return messages

ACK

EVT

DISCONNECTED

ABORT_ERROR

ARM_LASER_ERROR

ASSIGNING_SCANHEADS_ERROR

BLOCK_GUI_ERROR

CLOSE_JOB_ERROR

CLOSE_JOBS_ERROR

DISABLE_POINTER_ERROR

DISARM_LASER_ERROR

ENABLE_POINTER_ERROR

FILE_NOT_EXISTS_ERROR

FILE_OPEN_ERROR

INVALID_FILEPATH_ERROR

MODIFY_TRANSFORMATION_ERROR

MODIFY_TRANSFORMATION_ERROR_NO_ELEMENT_FOUND

OBSOLETE_COMMAND

PARAMETER_COUNT_ERROR

PARSE_ERROR

RENDER_AS_BITMAP_ERROR

RUN_ERROR
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Return messages

SAVE_ACTIVE_JOB_ERROR

SET_ACTIVE_JOB_ERROR

SET_EXECUTOR_TYPE_ERROR

SET_PREVIEW_PARAMETERS_ERROR

SET_PROCESS_TRANSFORMATION_ERROR

SET_TEXT_ERROR

START_PREVIEW_ERROR

STOP_PREVIEW_ERROR

UNBLOCK_GUI_ERROR

UNKNOWN_COMMAND_ERROR

UPLOAD_JOB_ERROR

WAIT_ERROR

SET_EXECUTOR_MODE_ERROR

SETPENSEVENT_ERROR

SETPENSEVENT_JOBELEMENT_NOT_FOUND_ERROR

SETPENSEVENT_NO_DATA_ERROR

SETPENSEVENT_WRONG_PEN_ERROR

EXECUTION_STATISTIC_NO_DATA_ERROR

GET_TRANSFORMATION_ERROR

GET_TRANSFORMATION_ERROR_NO_JOB

GET_TRANSFORMATION_ERROR_NO_ELEMENT_FOUND

SET_TRANSFORMATION_ERROR

SET_TRANSFORMATION_ERROR_INVALID_DATA

SET_TRANSFORMATION_ELEMENT_NOT_FOUND_ERROR

Table. 8.7: RG-096
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8.5 Electrode tab designer

Button

This plug-in makes a special job element available. The job element can be used to create a
geometry for cutting electrode tabs from battery foils. Especially when the size or spacing of
the tabs changes incrementally. In addition, the height can be defined where the geometry is
split between two pens, which is cut partly on bare foil material and partly on coated foil
material.

The panel allows the following parameters to be entered in order to design the geometry
accordingly.

Two different design variants are available:

■ Continuous cut for discrete tabs.

■ Only the short, “vertical” cuts are set (primarily used for battery foils of round cells).

8.5.1 Variant 1: Discrete tabs

Fig. 8.8: RG-AEY

Setting Explanation

Tab size [mm] Dimension of the tab in width (X) and height (Y) in [mm].

Tab size incremental Value in [mm] by which the size changes with each additional tab in width (X)
or height (Y).

Tab gap [mm] Distance between two tabs in [mm].

Tab gap incremental Value in [mm] by which the gap between two tabs increases with each
additional tab.
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Setting Explanation

Radius top [mm] Indication of the radius of curvature in [mm] at the upper edge of the tab.

Radius bottom [mm] Indication of the rounding radius in [mm] at the transition from tab to
connecting line.

Head length [mm] Length of the connecting line in [mm] before the first tab.

Tail length [mm] Length of the connecting line in [mm] after the last tab.

Number of tabs Specification of how many tabs are drawn.

Pen segment height [mm] Specification from which height in [mm] the geometry is divided between two
pens.

Cutting direction Select how the geometry is to be cut:

■ From left to right or

■ From right to left.

Chamfer [mm] Specification of the X-and Y-dimensions of an angular chamfer.

NOTES:
■ A downward sloping chamfer requires a negative value for the Y-dimension.

■ The X-dimension of the chamfer is added to the start and end length.

■ Only one chamfer is created at the start and end of all tabs.

Table. 8.8: RG-090
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8.5.2 Variant 2: “Tabless” design

Head length Tail length
Pitch
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Pen segment height

Top offset

Bottom offset

Transition radius

U-Cut
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Fig. 8.9: RG-AGN

Setting Explanation

Height [mm] Height of the cutting flank, regardless of its angle.

Vertical direction Specify whether the vertical cuts should all be upwards, downwards or bi-
directional.

Number of cuts Specification of how many cuts are to be made.

Pitch [mm] Distance between repetitive cuts in [mm].

Bottom offset [mm] Specification indicating by how many [mm] the actual short cuts are offset from
the horizontal cutting line at the bottom.

Top offset [mm] Specification indicating by how many [mm] the actual short cuts extend beyond
the height specification.

Angle [°] Angle of the cutting flank relative to the vertical line.

Pen segment height [mm] Specification from which height in [mm] the geometry is divided between two
pens.

Head length [mm] Length of the connecting line in [mm] before the first cutting flank.

Tail length [mm] Length of the connecting line in [mm] after the first cutting flank.

Cutting direction Specify whether the cut should go

■ From left to right or

■ From right to left

Transition radius [mm] Enter the radius at the transition between the horizontal start line and the
vertical cutting line or the last vertical cutting line and the horizontal end line.
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Setting Explanation

Offcut

These value fields can be expanded or collapsed using an expander.

NOTE: The first or last U-cut then transitions directly into the respective vertical cut. At this point, the
Transition radius and not the U-cut radius is used.

Enabled Select here whether additional U-cuts should be added along the start and end
lengths.

These U-cuts are used to cut the film into small pieces so that it can be suctioned
off more easily.

U-cut hight [mm] Height of the U-cuts measured from the horizontal start or end line

U-cut radius [mm] Radius of the U-shape on both sides

U-cut overlap [mm] Enter the distance between the end of one U-shape and the start of the next U-
shape, which is the amount by which two consecutive U-shapes overlap.

Number of start U-cuts This number and the start length determine the width of the U-shape along the
start line

Number of end U-cuts This number and the end length determine the width of the U-shape along the
end line

Table. 8.9: RG-116
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9 CUSTOMER PLUG-INS
The RAYGUIDE software and its UI can be extended by plug-ins defined by the customer.

There are two types of custom plug-ins:

■ API plug-ins: Allows you to add custom developed / programmed job elements or devices
to the RAYGUIDE application.

■ Embed the control elements for actuating external / third-party components into the
"Custom UI panel".

API plug-ins

Examples: ■ Job elements: Use the RAYGUIDE API to create the job elements you want, such as
graphics, containers, and automation objects.

■ Devices: You can implement another device – such as a laser, a deflection unit, an I/O
controller, or even a control card – to configure and use it through the RAYGUIDE user
interface.

Customized panel

The customized panel is activated from the menu: View > Panels > Custom UI. This panel is
empty by default.

Any external control element based on WPF (Windows Presentation Foundation) can be
embedded.

Examples For use of the user-defined panel:

■ Viewing a camera stream of the actual marking process

■ Controlling the movement of a conveyor belt

The RAYGUIDE software development kit (SDK) provides sample codes and the RAYGUIDE
SDK manual contains a detailed description on how to apply a customer plug-in.
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10 EMBEDDING THE RAYGUIDE UI
This feature allows you to embed either the complete user interface or selected user interface
elements, for example, the panels, into your machine HMI.

This saves you from having to program your own controls to access the RAYGUIDE
functionality (as opposed to working with customer plug-ins).

NOTE: Dialogs cannot be embedded without calling their event.

How to embed the user interface with the Microsoft WPF tool is described in detail in the
RAYGUIDE SDK manual.
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11 ERROR HANDLING AND LOG FILES

11.1 Error Messages
RAYGUIDE can generate error messages. These messages are displayed in window spanning
bars in the RAYGUIDE user interface. They have to be acknowledged before continuing.

An error message contains an expandable stack trace with detailed information. The entire
text can be copied and pasted, for example, into an email message to support@raylase.de.

Other error messages are generated by the control card and sent to the RAYGUIDE user
interface.

For example, an "Out of Field" exception is generated when the conveyor moves the target
material too fast in the MOTF process.

Contact support

Each RAYGUIDE exception window also provides a shortcut to send an email to support. All
required log files (including the batch error message), the system configuration and the
currently opened RAYGUIDE job file are automatically attached to this email. If you do not
want the current job to be transferred, please delete the corresponding email attachment.

By default, the mail recipient is empty. You can define a default recipient by editing the
corresponding entry in the branding.json file. You can find this file in the folder:

C:\Programdata\RAYLASE\RAYGUIDE\Configuration
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11.2 Log Files
There are three types of log files. The log files are saved under the following default path: C:
\ProgramData\RAYLASE\RAYGUIDE\Logs.

Log file Explanation

RAYGUIDE.log Contains information about the environment (hardware, licenses, plug-
ins, authorizations) and the program procedure (job, exceptions)

RAYGUIDE_Notifications.log This file logs all messages in the Notifications Notifications panel such as
status messages, measurement results, user logins, monitoring messages,
etc.

RAYGUIDE_RemoteInterface.log This file logs all remote commands received and the corresponding
responses.

RAYGUIDE_StandAlone.log This file logs which user loads which jobs with which content (marking
objects and pens used) onto the control card.

SP-ICE-3.log All commands transferred to the control card are recorded here (vector
positions, process parameters).

The log file can be read back into the application with the "SP-ICE-3 Log
Importer" plug-in and the content displayed with respect to the vectors,
see page 364, SP-ICE-3 Log Import.

If more than one control card is used, each has its own log file. The
name of the log file of each card is the same as the respective control
card label.

NOTE: If several control cards are used, it is recommended to use a label
that makes it easier for you to assign them in the system (e.g. serial
number).

SP-ICE-3_Extra.log In addition to the normal API commands, information is written here
that is used for queries to the deflection unit, for instance transfer of
the correction file and all “Enhanced” commands.

The objective of the separate log file is to avoid overloading the actual
log file with periodic status queries, for example.

Table. 11.1: 097

It is recommended to have logging enabled.

1. Open the configuration of the control card via System > Devices > Scan controller.

2. Tick the box next to Generate log file.

With [Reset] button, all entries can be reset and the file emptied.
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The path to the log files can also be seen (default location or other) and opened here. Log files
can be read in a text editor.

NOTES:
■ The log files are always created new when the software is started or when the maximum

size of 10 MB is reached. The 10 latest files are kept as ZIP files in an archive sub-folder.

■ The log files of a multi-point calibration are included in the RAYGUIDE log file.

■ In case of an error, the log files can also be sent to RAYLASE support. Always include the
software version in your bug reports (can be accessed via Help > About).

11.3 Notification Panel
In the list displayed on the Notification panel, RAYGUIDE tracks status information that can
also be useful for debugging, such as when a control card has failed to connect. In general, all
SP-ICE-3 error messages are listed here.

This list will also trace all measured values generated with the measurement tool.

To delete the display in the panel, click the right mouse button. The context menu then offers
you the function to copy and delete.

It is recommended to sort the list by descending date to always have the latest notification at
the top.

The notification history is recorded in a separate log file, see page 397, Log Files.

Fig. 11.1: RG-AEC



12 TROUBLESHOOTING

© 2025 RAYLASE GmbH 399MN_RAYGUIDE [V2.11]

12 TROUBLESHOOTING
There is no laser radiation, but the deflection unit is "working".

a) Check if the laser is armed.

b) Check laser configuration, especially the hot power target setting.

c) Check the cabling.

d) Check whether the laser has output an error.

Bitmap or vector object in job tree but no graphic in viewport

An object was just added by dragging it into the tree, but no source file was selected.

An individual object is not processed.

a) The Mark tab in the object settings is disabled.

b) The Should mark tab is disabled in associated pen.

c) The object has a binning condition set which has not been met.

Job does not get processed.

Check that RAYGUIDE is currently connected to the control card. A first indication can be
given by the color index of the symbol in front of the SP-ICE-3 entry in the job overview.

If the control card has been disabled or if there has been a power loss while using RAYGUIDE,
we recommend restoring the connection. Then, re-toggle the [Arm / Disarm] button in the
execution panel.

The layout of the panels is so jumbled as to be unusable or not present at
all.

Navigate to View > Panel layout and use [Reset] to return to the standard panel
configuration.

Layout objects cannot be edited in the drawing area.

a) Check your RAYGUIDE permission role and your allowed operations.

b) Check whether the working area, the job tree or the individual object was proactively
"locked" to prevent editing.
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The laser emits power but the deflection unit does not move the laser
beam.

a) Check whether the deflection unit is supplied with power and correctly connected to the
control card.

b) Check whether a deflection unit has been configured and assigned to the control card.

c) Check the operating status of the deflection unit on the status tab of the deflection unit
dialog.

Directly after starting an execution, an "Rpc" error message indicating that
marking was aborted is output.

Use the SP-ICE-3 configuration. Tool, "SFR" tab (special function register) to check if the
"Abort Mark State" is permanent = 1. This would mean that the control card is set
permanently to “Abort”, for example because an I/O pin was wrongly configured for abort,
or the signal is short circuited.

The buttons or panels for a RAYGUIDE plug-in (solar wafer SP-ICE-3 log
importer, remote interface) are not available in the GUI.

The corresponding plug-in was not selected during initial installation of the RAYGUIDE
software or during the last software update.

A single marking object in the container is not selected in the drawing area.

The bounding box of individual objects does not appear in the drawing area after one or
more marking objects are dragged into a group or copy container and then selected in the
object tree. The reason for this is that the Execute as single vector graphic option is enabled
in the container.
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13 FREQUENTLY ASKED QUESTIONS
Q: Can I load a job that was created on another installation?

A: Yes. All job-relevant information, including workspace configuration and pen set
configuration, is delivered with the job file. You only need to link the job to your local
control card and any other connected hardware devices.

Bitmap elements must be stored in the job before they can be transferred to another
RAYGUIDE installation.

Q: What if I need to replace my control card?

A: You open the control card dialog and start the search for the IP address. As soon as the IP
address of the control card is found, the connection to the control card is established. The
previous configuration data for the deflection unit including its correction file, field
calibration, and laser configuration, is transferred to the newly installed control card when
you press [Apply].

Q: What do I need to consider when updating RAYGUIDE?

A: All configurations of your hardware devices, the RAYGUIDE settings, pens, etc. remain
unchanged when you update RAYGUIDE.

Q: Can I use the RAYGUIDE user interface when working with a RAYGUIDE SDK license?

A: Yes, but only in demo mode. However, in this mode you can still configure and calibrate
the system using the GUI dialogs. You can also load and check jobs generated by API
commands.

Q: Can a job created with the RAYGUIDE user interface be edited by another RAYGUIDE API
application?

A: Yes, you can load and modify this job and process this job through your custom API
application, as the job is not bound to a specific license.

Q: I use an activation license, but I need to replace my PC or change the operating system.
What do I need to consider?

A: The activation license is bound to certain attributes of your computer. Changing the
operating system may unbind it. We therefore strongly recommend that you contact our
support before changing your PC or operating system.
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14 GLOSSARY
Acceleration time [µs]

Time required by the optical axes (e.g. deflection mirrors) to accelerate / decelerate to the
desired speed. This parameter is required for processing bitmaps in "sprint mode", where an
acceleration / deceleration vector is added to each bitmap line.

Binning

Binning is an option to execute a job or job element, depending on the pattern of an I/O port
that is most likely set by a PLC.

BoundingBox

The bounding box is a rectangle that encloses the layout object and is always vertically
oriented. It is only used internally by the RAYGUIDE application and therefore, unlike the
"Enclosing Rectangle", it is not displayed in the viewport.

Center of Transformation (CoT)

The point around which an object or container is scaled and / or rotated during an object
transformation.

Change of Heading (CoH) angle

The angle between two consecutive vectors that describes the change in direction:

Fig. 14.1: RG-ADX
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Graphic command

A graphic command is a graphical element that supports the control card library as per the
graphic command definition. The SP-ICE-3 control card supports vector, arc, ellipse and Bezier
curve commands.

Container

A container is a special type of object plug-in with the goal of assigning certain behaviors to
the objects inserted there. In the simplest case, all objects should have the same number of
executions, for example. Or the aim may be to multiply the objects contained therein in a
defined manner.

Containers can contain both layout and automation objects, or other containers (nested
structure). Each container has its own transformation matrix that transforms all layout objects
contained in the container.

Deflection unit / scan head

An opto-mechanical unit that uses so-called optical axes (mirrors and lenses) to deflect and
focus the laser beam.

Device

The term “device” refers to a physical component within the laser cell, such as a deflection
unit, laser, or serial port. Other types of “devices” may be added in the future.

Enclosing rectangle

Compared to the bounding box, the enclosing rectangle always rotates together with its
layout object. Its dimensions determine the size specified for the layout object.

Field domain

Positions defined in the field domain refer to the scan field coordinate system. The
coordinates are translated into the scanner domain on the SP-ICE-3 control card using a field
transformation and correction file. RAYGUIDE manages the coordination of layouts
exclusively in the field domain.

Free-shaped vector object (as compared to pre-shaped vector object)

A “free-shaped” vector object is generally created by importing graphic files and always has
the hierarchy structure Object > Layer > Path > Path element. It is "free-shaped" because it
can contain very complex polylines and its individual thumbs can be freely edited.
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Gate pre-run / hold time

Gate pre-run and gate hold time specify how long the gate signal is activated before marking
starts and is kept active after marking ends.

Gate signal

Signal that generally modulates the laser emission. When using the SP-ICE-3 control card, you
can configure the polarity of the signal (high-active vs. low-active) according to the
requirements of the connected laser source. This setting is part of the RAYGUIDE laser
configuration.

Job

A collection of editable objects that the RAYGUIDE application can load / save with the RG
file extension. These objects can be layout objects and automation objects. Each job content is
translated by the user application into one or more command lists that the control card can
continue to process.

Laser-on delay / Laser-off delay

This delay defines the time by which the laser trigger pulse is delayed in relation to the mirror
position at the beginning / end of a marking vector.

Laser trigger delay

This value defines the time by which the optical pulse is delayed compared to the trigger
pulse of the LM signal.

Level

Defines a group of paths. Subunit of a free-shaped vector object.

Panel layout

Sum of all graphical job elements.

License

A permission distributed by the owner of the software to use the software. It can be
distributed as activation file or as hardware dongle.

LM signal

Signal used to trigger laser pulses. Its pulse rate is defined via the laser frequency pen value.
The pulse width of the signal is defined either in the laser configuration or also in the pen.
When using the SP-ICE-3 control card, you can configure the polarity of the LM signal (high-
active vs. low-active) according to the requirements of the connected laser source.



14 GLOSSARY

© 2025 RAYLASE GmbH 405MN_RAYGUIDE [V2.11]

Log file

Files that track all graphic and action commands sent, for example, by the application to the
control card. In this way, all actions performed by the RAYGUIDE application can be tracked.

Spot magnification

Option to increase the laser spot size by using either the zoom feature or the defocus feature
of a 4- or 3-axis deflection unit. Requires a special FC3 correction file.

Mark / Jump delay

The delay applies after a mark / jump vector. It is needed to stabilize the optical axes (mirrors)
after deceleration to avoid deflections. The optimal value is established by means of process
tests. As an initial value, we recommend setting it to 120% of the acceleration time.

MOTF

"Mark-On-The-Fly" application in which the parts or the material(s) to be processed move
through the scan field.

Motor axis

A motor axis refers to the axes of a stepper or servo motor device.

Object

Basic elements of a laser processing job.

Path

Single or a chain of graphic commands that define a continuous line. The line can be opened
or closed (start and end points are equal). Subunit of a layer.

Pen

A series of parameters used to define the behavior of the laser and deflection unit during
layout processing.

PLC

Programmable Logic Controller.
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Position dependent power correction file

A correction file containing a table of power gain values in relation to the field position. It is
managed by the SP-ICE-3 control card. The file is created using the Multi Point Editor
application. The file extension is PC3.

Polygon delay

Delay applied for each vector connection so that the deflection unit can follow sharp corners.
When using a variable polygon delay, the delay time is adjusted according to the change of
heading angle.

Power calibration file

A file that can be created using the SPICE3PowerCalibrator.exe software tool to linearize the
emitted laser power with respect to the power control value.

Power ramp

Feature for linear modulation of the laser power at the beginning / end of a path by a
defined length or time. It is implemented by the SP-ICE-3 control card.

Pre-formed vector object (compared to free-shaped vector object)

A vector object defined by its geometric properties, for example Line, Rectangle, Polygon,
Circle, Ellipse, Spiral.

Protocol (electric decoding vs. language)

The protocol defines how the control card communicates with the deflection unit. 
One aspect is the electronic decoding of the signal. This determines how many axes can be
controlled per cable. 
Another aspect is the data format, so that both sides can interpret the command language.

Jolt

"Jolt" is the change in acceleration over time. If, for example, a directional change of almost
180° occurs in a geometry, the scan movement must be fully inverted, which leads to abrupt
deceleration with subsequent maximum acceleration. This could cause the deflection mirrors
to oscillate, which in turn would result in marking inaccuracies. This jolt-limiting control
would counteract this.



14 GLOSSARY

© 2025 RAYLASE GmbH 407MN_RAYGUIDE [V2.11]

RAYBOARD PRODUCT INSTALLER

Central and free software tool for easy installation, update or modification of RAYLASE
software products.

Available for download from the RAYLASE website.

Scan controller / card

Special printed circuit board for actuating the laser and deflection unit by hardware signals.
Can provide additional Inputs / Outputs. The RAYLASE product is the SP-ICE-3 control card.

Scan field

Area in which the deflection unit can image the laser beam. Defined by the loaded correction
file.

Scanner domain

The coordinates from the field domain translated into units that can "implement" the
respective received optical axis. This conversion is also done in the SP-ICE-3 control card with
the help of the correction file.

An example: A three-dimensional coordinate in the field domain is translated into deflection
angles for X- and Y-mirrors and a position in bits for the Z-lens.

Skywriting

Feature that adds an additional acceleration / deceleration vector at the beginning / end of a
marking vector to improve marking precision and power input at vector transitions. Is
implemented by the SP-ICE-3 control card and applied depending on the change of heading
angle.

System

Means the entire RAYGUIDE software application.

Tracking error [µs]

Time the respective optical axes need to respond to a new position command. The value is
used, for example, for compensating for the different tracking error values or for speed-
dependent power correction.

Sequence

In the RAYGUIDE software, repeated sequences of a geometry with the same set of
parameters (pens) are called sequences.
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Tracking error compensation

Functionality of the SP-ICE-3 control card to account for the different dynamic behavior of the
X and Y mirrors compared to the Z lens(es).

Tuning

A property of a deflection unit that defines the dynamic behavior of the unit. Digital
deflection units may have more than one tuning and the ability to switch between them. The
equipment of the deflection unit in terms of tuning is defined in the deflection unit ordering
process.

Velocity based power control

Feature for automatic adaptation of the laser power to the actual speed of the deflection
mirrors during acceleration / deceleration. Is done by the SP-ICE-3 control card. To do this, the
SP-ICE-3 control card resorts to the tracking error values, therefore it is important that the
value is correct.

Wobble

A defined oscillation of the X and Y mirrors to create a circle or Lissajous shape along a
vector. Mainly used in welding applications or to create wider line thicknesses in the marking
result.

Working distance [mm]

Vertical distance between the lower edge of the base plate of the deflection unit and the
focal plane.

Workspace

The workspace defined by the user.

■ It can be limited to a smaller area than the scan field.

■ It can represent an intersection area or a combined area of several scan fields.

■ It can represent the virtual field introduced by MOTF or an XY-motor table.
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